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PeerSync Help

Welcome to Peer Software's powerful file mirroring, backup and distribution solution, Peer-
Sync v9.4. With this product you will be able to conveniently synchronize folders for back-up
purposes or portability requirements. Never again will you overwrite newer data by attempt-
ing to manually update an individual file or the contents of a folder.

History

PeerSync has been available for download/purchase since early 1995. Since then hundreds
of downloads have been logged from various international forums where PeerSync was
made available and thousands of copies have been sold. PeerSync is an MS Windows-
based product. Originally written in Visual Basic, the current productis written in Delphi Object
Pascal. PeerSync originated as a solution to a problem frequently encountered by our own
developers, that of keeping files in sync between multiple hard drives. Developers working
on-site at customers' locations or at home during crunch schedules would then have to syn-
chronize their data back to the office server. This was mostoften done manually, with each in-
dividual file being dragged to the appropriate server folder. Invariably, data would be lost
when one or several of the server files contained new information which was subsequently
overwritten. In addition to loss of work and resulting frustration, the process was also time con-
suming. Anywhere from 20 minutes to 2 hours would be spent during each synchronization.
After reviewing several commercially available products, it became apparent that an effect-
ive and user-friendly solution to this common problem did not exist, hence the development of
PeerSync.

Description

Configured through the Profiler, an intuitive and easy-to-use application, PeerSync automatic-
ally synchronizes multiple directories and sub-directories from user-defined Source to Target
Folders. While removing the frustration and loss of time associated with manual synchroniza-
tion, PeerSync prevents loss of data by checking file dates and times to ensure that newer in-
formation is not overwritten. Synchronization can occur between any mapped or UNCconnec-
ted drives located on local computers or computer networks. While processing and perform-
ing any number of simultaneous tasks, PeerSync retains and expands upon the selectivity
and precision of manual synchronization by offering a suite of automated file inclusion and ex-
clusion features. Files can be included within synchronization according to standard DOS-
type wild cards and excluded using sub-string comparisons or file attribute settings. Files can
be also be excluded according to their date and size. In addition, PeerSync can be con-
figured to update or add files which are out-dated or non-existent in the current Target Folder.
Precision and scope are further enhanced through PeerSync Jobs and Command Line
Modes. A virtually unlimited number of folder combinations (Jobs) can be created and stored
in Profiles which can be run manually or automatically using command line arguments. While
synchronizing large numbers of folder combinations at once, each combination can have a
unique setof exceptions. In this way PeerSync combines the benefits of precise folder match-
ing with that of an automated environment. Real-Time Source Folder monitoring and repetit-
ive operations on the host PC are also available with PeerSync's options. PeerSync can also
be used for network file management purposes. Reports run during synchronization can dis-
play added, updated, and opened files as well as directories created, and can display un-
matched files found in Targetdirectories.

Embedded Open File Manager (EOFM)

Copyright © 1993-2016 Peer Software Inc. All Rights Reserved



PeerSync Help 2

PeerSync's Embedded Open File Manager (EOFM) option was created and bundled into
PeerSync through a third party partner named EVault. EVault has announced that EOFM is
now "End-of-Life" and no further development or support will be provided. Thus, Peer Soft-
ware will no longer be including EOFM as part of PeerSync beginning in PeerSync version
9.0. In addition, we are no longer able to provide technical support on EOFM effective imme-
diately.

For Peer Software customers currently using EOFM and who are on a valid maintenance sup-
port contract, we offer a FREE upgrade from EOFM to the Volume Shadow Copy Service
(VSS) option. We urge all customers to take advantage of this FREE upgrade offer. Peer
Software is continuing developmentand supportfor VSS.

File Transfer Protocol (FTP)

As of version 9.4, PeerSync's File Transfer Protocol (FTP) is "End-of-Life" and no further de-
velopmentor support will be provided. Please contact support@ peersoftware.com for more
information.

File and Folder Compression

As of version 9.4, PeerSync's File and Folder Compression feature is "End-of-Life" and no
further developmentor supportwill be provided. Please contact support@ peersoftware.com
for more information.

PeerLock Configuration Support

Starting with PeerSync v7.4, customers who are running PeerlLock 2.0.1 or higher on the same
machine as PeerSync are able to configure PeerLock directly from the PeerSync Profiler.
Configuration options include the ability to link specific PeerSync Profile Jobs to PeerLock,
ability to access/view/editthe PeerLock Global Settings from the PeerSync Profiler, ability to
install/uninstall the PeerLock Service, as well as launch and view PeerLock directly from the
PeerSync Profiler.

TCP WAN Connector

Version 7.4 and higher of PeerSync also supports real-time or scheduled bi-directional rep-
lication using our TCP replication mode. In this version, PeerSync now supports bi-direc-
tional replication with target directories thatreside outside the LAN, WAN, or VPN.

EMC VNX and Isilon
Version 9.4 and higher of PeerSync supports real-time and share migration for both EMC
VNXand Isilon when using CIFS/SMB.

The manufacturer of PeerSync makes no warranties, implied or otherwise, for use of this product. User assumes all re-
sponsibility for any data loss or damage.
Copyright © 1993-2016 Peer Software Inc. All Rights Reserved Privacy Policy

PeerSync is a registered trademarks of Peer Software, Inc.
Reproduction in whole or in part without permission is strictly prohibited.

The PeerSync Help Manual was built on Thursday, May 26, 2016
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Product Information

License

YOU SHOULD READ CAREFULLY THE FOLLOWING TERMS AND
CONDITIONS BEFORE INSTALLING, USING OR DISTRIBUTING THIS
SOFTWARE. INSTALLING, USING OR DISTRIBUTING THIS SOFTWARE
INDICATES ACCEPTANCE OF THESE TERMS AND CONDITIONS. IN THIS
AGREEMENT, "YOU" MEANS YOU AS AN INDIVIDUAL IF YOU ARE USING
THIS SOFTWARE FOR PERSONAL USE. IF YOU ARE USING THE SOFTWARE
ON EQUIPMENT OWNED OR OPERATED BY A COMPANY OR
ORGANIZATION (COLLECTIVELY "COMPANY'"), BY ACCEPTING THIS
AGREEMENT, YOU REPRESENT THAT YOU ARE DULY AUTHORIZED TO
ACCEPT THIS AGREEMENT ON BEHALF OF YOUR COMPANY.

COPYRIGHT

The software programs (hereafter the "Software") and documentation (hereafter the "Docu-
mentation") is copyrighted and remains the property of Peer Software, Inc. All rights are re-
served.

LICENSE

Peer Software, Inc. hereby grants you (hereafter the "User") a limited, non-exclusive, non-
transferable license to install and use the Software and accompanying Documentation con-
tained in the trialware distribution package (hereafter called the "Trialware Package") you re-
ceived (THE "Original Distribution") for your internal business purposes only. The Trialware
Package consists of copies of the Software and Documentation received via an electronic
transfer mechanism or an electronic storage medium including, but not limited to, diskette,
hard disk, removable disk, tape oroptical devices suchas CD-ROM or WORM. This license
to install and use the Software and Documentation is conditioned upon Users compliance
with the terms of this Agreement.

You may install and use the Trialware Package on one or more computers provided there is
no chance thatitwill be used simultaneously on more than one computer. If you need to use
the Software on more than one computer simultaneously or on a network, please contact
Peer Software, Inc. forinformation about network licenses.

The Software is protected by trade secret and copyright laws and international treaty provi-
sions. You are notobtaining title to the Software or Documentation or any copyright or otherin-
tellectual property rights. You further acknowledge that tite and full ownership rights to the
Software and Documentation will remain the exclusive property of Peer Software, Inc. or its
suppliers, and You will not acquire any ownership rights to the Software. You may not subli-
cense, lease, rent, sell, convey, translate, modify, decompile, incorporate into another
product, convert to another programming language, reverse engineer or disassemble the
Software or Documentation for any purpose. You may not modify, or create derivative works
based in whole orin partupon, the Software. You agree to notremove, obscure, or alter Peer
Software, Inc.’s or any third party's copyright notice, trademarks, or other proprietary rights no-
tices affixed to or contained within oraccessed in conjunction with or through the Software and
Documentation. Peer Software, Inc. reserves the rightto periodically conduct audits upon ad-
vance written notice to verify compliance with the terms of this Agreement.

Once a license is purchased from Peer Software, Inc., the Trialware Package will be author-
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ized to function as the full working version of the Software with access to all licensed features.
NETWORK LICENSE

Multiple users on a network (e.g. a LAN) requiring access to the Software and Documentation
must purchase a Network License. Two forms of Network Licenses are offered, a Site Li-
cense and Enterprise or Concurrent User License. With a Site License, any user who ac-
cesses the Software or Documentation requires a user license, regardless of the frequency
of use. Once a Site License is purchased Software and Documentation may be copied to all
users who have beenlicensed. Site Licenses are customized for each purchase. The license
is based on a quantity of simultaneous users and or CPU installations.

The Concurrent User License allows the licensed number of users to simultaneously access
the Software and Documentation. The User agrees to operate metering software, which re-
stricts the simultaneous number of users to the quantity purchased. The Software and Docu-
mentation mustbe installed on network servers under the control of metering software.

Both Site and Concurrent User Licenses allow installation of the Software and Documentation
to any number of servers on any number of geographic sites, limited only by the quantity of li-
censes purchased.

TERM AND TRIAL PERIOD

You are permitted to use the Trialware Package for a trial period (hereafter the "Trial Period")
of thirty (30) days or 30 uses (which ever comes first) after receipt of the Trialware Package.
After such time, if you continue to use the Trialware Package, you mustregister your copy with
Peer Software, Inc. Failure to register after the Trial Period constitutes termination of this li-
cense. Upon registration, a password (hereafter called the "Password") will be provided to
eliminate the registration reminder screen.

This license is effective until terminated. You may terminate it by destroying the Software,
Documentation, and all copies thereof. This license will also terminate if you fail to comply
with any of the terms or conditions herein. You agree, upon such termination, to destroy all
Software, Documentation, and copies thereof. Upon request, You agree to certify in writing
thatall copies of the Software and Documentation have been destroyed.

LIMITED WARRANTY

THE SOFTWARE AND DOCUMENTATION IS PROVIDED "AS IS" WITHOUT WARRANTY
OF ANY KIND. PEER SOFTWARE, INC. DISCLAIMS ALL WARRANTIES RELATING TO
THIS SOFTWARE, WHETHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED
TOANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE, AND INFRINGEMENT AND ALL SUCH WARRANTIES ARE EXPRESSLY AND
SPECIFICALLY DISCLAIMED.

EXCLUSIVE REMEDY

YOUR EXCLUSIVE REMEDY AND PEER SOFTWARE, INC. ENTIRE LIABILITY ARISING
FROM OR IN CONNECTIONS WITH THE SOFTWARE, DOCUMENTATION, AND/OR THIS
LICENSE (INCLUDING WITHOUT LIMITATION FOR BREACH OF WARRANTY OR
INFRINGEMENT) SHALL BE, AT PEER SOFTWARE, INC.'S OPTION, THE REPAIR OR
REPLACEMENT OF THE SOFTWARE OR REFUND OF REGISTRATION FEES (IF
NOTIFICATION OF PROBLEM IS WITHIN 30 DAYS OF PURCHASE).
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LIMITATIONS OF LIABILITY

UNDER NO CIRCUMSTANCES OR LEGAL THEORY, WHETHER IN TORT, CONTRACT,
OR OTHERWISE, SHALL PEER SOFTWARE, INC. OR ANYONE ELSE WHO HAS BEEN
INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS SOFTWARE BE
LIABLE TO YOU OR TO ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL,
INCIDENTAL, OR CONSEQUENTIAL DAMAGES (EVEN IF PEER SOFTWARE, INC. SHALL
HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES), INCLUDING,
WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE,
COMPUTER FAILURE OR MALFUNCTION, OR, FOR ANY OTHER DAMAGES OR
LOSSES OF ANY NATURE.IN NO EVENT WILL PEER SOFTWARE, INC. BE LIABLE FOR
ANY DAMAGES IN EXCESS OF THE LIST PRICE PEER SOFTWARE, INC. CHARGES FOR
A LICENSE TO THE SOFTWARE.

Some states do not allow the exclusion of the limit of liability for consequential or incidental
damages, so the above limitation may notapply to you.

BACK-UP
You may make one copy ofthe Trialware Package forbackup purposes only.

DISTRIBUTION

You may distribute the Trialware Package to others via an electronic transfer mechanism or
electronic storage media provided that no files are deleted from the Original Distribution Tri-
alware Package or are modified in any way. Files may be added to the Trialware Package
expressly for the purpose of identifying the party distributing the Trialware Package. You may
also place the Trialware Package into any archive orcompressed formatfor ease of distribu-
tion.

You may notdistribute the product Registration Key to others under any circumstances.
GENERAL

Export of the Software may be subject to compliance with the rules and regulations promul-
gated from time to time by the Bureau of Export Administration, United States Department of
Commerce, which restrict the exportand re-exportof certain products and technical data. If the
exportofthe Software is controlled under such rules and regulations, then the Software shall
notbe exported orre-exported, directly or indirectly, (a) withoutall export or re-export licenses
and United States or other governmental approvals required by any applicable laws, or (b) in
violation of any applicable prohibition against the export or re-export of any part of the Soft-
ware. Some countries have restrictions on the use of encryption within their borders, or the im-
portorexportofencryption even if for only temporary personal or business use. You acknow-
ledge that the implementation and enforcement of these laws is not always consistent as to
specific countries. Although the following countries are not an exhaustive list there may exist
restrictions on the exportation to, or importation of, encryption by: Belgium, China (including
Hong Kong), France, India, Indonesia, Israel, Russia, Saudi Arabia, Singapore, and South
Korea. You acknowledge it is your ultimate responsibility to comply with any and all govern-
mentexportand other applicable laws and that Peer Software, Inc. has no further responsibil-
ity after the initial license to you within the original country of sale.

In addition, neither the Software nor the Documentation and underlying information or techno-
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logy may be downloaded or otherwise exported or re-exported (i) into (orto a national or res-
ident of) any country to which the United States has embargoed goods; or (ii) to anyone on
the United States Treasury Deparment's list of Specially Designated Nations or the United
States Commerce Department's Table of Denial Orders. By using the Software you are
agreeing to the foregoing and you are certifying that you are notlocated in, under the control
of, or a national or resident of any such country or on any such list.

This agreementshall be governed by the laws of the state of New York and shall inure to the
benefitof Peer Software, Inc. and any successors, administrators, heirs, and assigns. Any ac-
tion arising under this Agreement shall be filed in any state or federal court located in Suffolk
county in the State of New York, and You hereby agree, acknowledge and submit to the ex-
clusive jurisdiction and venue of such courts for the purposes of such action, waive any right
You may have to objectto such jurisdiction or venue.

This Agreement sets forth all rights for the user of the Software and is the entire agreement
between You and Peer Software, Inc. and supersedes any other prior or contemporaneous
agreements or communications with respectto the Software and Documentation. This Agree-
mentmay notbe modified exceptby a written addendum issued by a duly authorized repres-
entative of Peer Software, Inc. No provision hereof shall be deemed waived unless such
waiver shall be in writing and signed by Peer Software, Inc. or a duly authorized representat-
ive of Peer Software, Inc. If any provision of this Agreement is held invalid, the remainder of
this Agreement shall continue in full force and effect. The parties confirm thatitis their wish that
this Agreement has been written in the English language only.

PeerSync Installation

PeerSync is shipped (downloaded) in a full installation program. To run, simply double-click
on the executable in the Explorer window, or choose "Run" from the Start Menu and then se-
lect the application. For networked installations, PeerSync supports silent installation by
adding "/S" to the installation application's command line.

Example: %PATH%/ peersync93.exe/ S

See Additional Configuration Entries for more Information on silentinstallation configuration.

Additionally, PeerSync can use the PeerSync93.lic file for larger networked sales and site li-
censing. This file will be placed in the "PeerSync" folder. If PeerSync detects this file at star-
tup then it will use this data and bypass all other registration security checks. If the Peer-
Sync93.lic file is located in the same folder as the PeerSync installation application, this file
will then be automatically placed in the PeerSync installation folder during installation. To ob-
tain a PeerSync93.lic file, please specify your requirements during purchase/registration.

Note: Adding /S /A INSTALL.LOG to the Uninstall.exe command line will perform an automatic silent uninstall of
PeerSync.

Additional Configuration Entries

PeerSync and the PeerSync installation (peersync93.exe) use a configuration file (PSDef.cfg)
to read and setoptions during and after installation. If a PSDef.cfg file is located in the same
folder as peersync93.exe before installation, this file will be automatically copied to the Peer-
Sync installation folder during installation.
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. PSDEF.CFG.txt - Notepad [= [

File Edit Format View Help

[Application Options]
Installation Folder=C:%Program Files‘PeerSync
Disable Install Reboot=Yes
Install PSProfiler=Yes
Install PSWizard=No

Install SHNMP=No

Create S5tart Menu Shortcut=No
User MName=

Company Name=

Options=

Password=

[Misc Options]
TempFolder=C:\Temp

Pre-Installation Configuration Options

The following options are available before installation and are used during manual
and silentinstalls:

Installation Folder This option can be set to any directory path and designates
whatdirectory to install PeerSync into.

Disable Install Re- This option can be setto 'Yes' or 'No' and allows you to sup-

boot press the rebooting (if needed) of your computer after installa-
tion.

Install PSProfiler This option can be setto 'Yes' or'No' and allows you to decide

if the PSProfiler interface is to be installed.

Install PSWizard This option can be setto 'Yes' or'No' and allows you to decide
if the PSWizard interface is to be installed.

Install SNMP This option can be setto 'Yes' or'No' and allows you to decide
if files needed for SNMP are to be installed (SNMP is only

available in the Enhanced Package).

Create Start Menu This option can be setto 'Yes' or'No' and allows you to decide
Shortcut if shortcuts related to the PeerSync installation will be added to
the Start menu.

Post Installation Configuration Options

The following options are used by PeerSync and other installed applications after in-
stall:
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User Name

This is used to setthe Registration or Evaluation information to
be read in by PeerSync.

Company Name

This is used to setthe Registration or Evaluation information to
be read in by PeerSync.

Options This is used to setthe Registration or Evaluation information to
be read in by PeerSync.

Password This is used to setthe Registration or Evaluation information to
be read in by PeerSync.

TempFolder This option can be setto any directory path and will be used for

a temporary folder PeerSync to use. If the path does not exist,
an attemptwill be made to create it. If it cannot be created, the
default will be used which is the logon users system Temp
path.

Registration and Passwords

If this is an unregistered or Evaluation Copy of PeerSync, you can register it with Peer Soft-
ware, Inc. as a fully licensed copy by providing credit card information via phone or secure In-
ternetregistration, or by sending a check or money order to the address below (see included
"readme.txt" file for pricing information). As an integral component of PeerSync 9.4 and all
subsequentversions, the Profiler application is included as part of registration.

Register online via secure Internet credit card registration at:
http://www.peersoftware.com

Register by phone via credit card by calling:
703.763.7700 between the hours of 9:00 AM to 5:00 PM EST

Register by FAX via Purchase Order:
Send Purchase orders to 703.763.7705

Register by mail, send check or money order to:
Peer Software, Inc.

5900 Fort Drive , Suite 415

Centrevile, VA 20121

Information Required:

Full name (as itappears on the credit card)

End User Name (userto be licensed for the product)
Company Name (if applicable)

Address (City, State / Province, Country, and Postal Code)
Phone Number

Entire Card Number

Card Expiration Date

Card Security Code

Email Address

(Peer Software, Inc. will send the Authorization Key required to unlock PeerSync's Evaluation

Counter to this).

Quantity Discounts
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Visit hitp://www.peersoftware.com or contact us for more information.

Upon registering PeerSync, user information will be generated according to the name and
company name (if any) you specified during registration, as well as a password specific to
the product version you have licensed. This information will be emailed to you and will be
used to activate your current copy. Additional license fees mustbe paid for multi-user use.

PeerSync may not be commercially distributed or distributed by government agencies in-
cluding their contractors UNLESS registration fees are paid for by the distributing party.

See License agreementfor product redistribution.

Please visit hitp://www.peersoftware.com for different versions of PeerSync and types of li-
censing we offer.

Note Regarding Updates: As new updates/ changes become available, updated versions of the software will
be posted at http:// www.peersoftware.com. Check this page periodically to download the latest executables. Your
Authorization Key will continue to work with updated versions unless a major release is issued, or PeerSync is in-
stalled in a different folder than the previously installed/ authorized version.

Entering Your User Information and Password
Through an Evaluation Copy of PeerSync:

After registration with Peer Software, Inc., you will receive Registration Information generated
which is from the information you provided during registration. The password you receive will
be specific to the PeerSync product you have licensed and registered with Peer Software.
Upon entering valid password and user information into your Evaluation Copy, that copy will
be immediately converted to a fully licensed version of the appropriate PeerSync product.
The instructions below apply to a "Registered Evaluation Copy" of PeerSync, that being one
whose evaluation period is still active.

To activate your registered and licensed PeerSync product, first run your Evaluation Copy of
PeerSync. Then choose "About" from the Help Menu located on the far right of the Profiler
Menu Bar. To activate your registered and licensed PeerSync product, first run your Evalu-
ation Copy of PeerSync. Then choose "About" from the Help Menu.

Located on the far right of the Profiler Menu Bar. This opens the About PeerSync screen,
which contains "User Name," "Company", "Options" and "Password" fields.

Be sure to enter this information exactly as you received it, with the same spacing, hyphena-
tion, punctuation, and cases (i.e. if a comma or period contained within a company name is
omitted, registration will notbe accepted). Itis advisable to cut-and-paste passwords directly
from the Email registration information. If passwords are typed using lower case letters where
upper cases have been indicated, or if other information is typed incorrectly, the message
shown below will be displayed. This message indicates that registration was unsuccessful;
shows the number of attempts made to register, and contains' a link to Peer Software's web-
site. You will only be allowed a limited number of attempts before the application closes en-
tirely and will need to be opened againin order to retry.

If registration is successful, your will receive a success dialog. Your Evaluation Copy will
have beenimmediately activated as a registered version of the PeerSync product you have
licensed, with this change indicated on the interface title bar. Click "OK" on the success dialog
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to begin usage of your newly activated PeerSync product. You will nothave to exit and restart
the application to do so.

Through an Unregistered Copy of PeerSync:

Unregistered copies of PeerSync are Evaluation Copies whose evaluation period has ex-
pired, or copies into which a valid password and user information has not yet been entered.
These copies can still be activated as fully licensed versions of whichever PeerSync product
whose usage you have purchased from Peer Software, Inc.

After registration with Peer Software, you will receive Registration Information which is gener-
ated from the information you provided during registration. The password you receive will be
specific to the PeerSync productyou have licensed.

To activate your copy of PeerSync as a fully licensed version, first run the copy. Because
your copy is unregistered, the application will not open in its entirety, instead an About Peer-
Sync screen will open. This screen contains "User Name," "Company", "Options" and "Pass-
word" fields.

Be sure to enter this information exactly as you received it, with the same spacing, hyphena-
tion, punctuation, and cases (i.e. if a comma or period contained within a company name is
omitted, registration will notbe accepted). Itis advisable to cut-and-paste passwords directly
from the Email registration information. If passwords are typed using lower case letters where
upper cases have been indicated, or if other information is typed incorrectly, the message
shown below will be displayed. This message indicates that registration was unsuccessful;
shows the number of attempts made to register, and contains' a link to Peer Software's web-
site. You will only be allowed a limited number of attempts before the application closes en-
tirely and will need to be opened againin orderto retry.

If registration is successful, your will receive a success dialog. Your copy will now have been
immediately activated as a registered version of the PeerSync product you have licensed.
Click "OK" on the success dialog to begin using your registered copy: the About PeerSync
screen will close and the full application interface will be displayed. You will not have to exit
and restartthe application to begin usage.

TERMS AND CONDITIONS

READ THE LICENSE AGREEMENT BEFORE USING THIS PROGRAM.

Please send any suggestions, comments or requests for support to the proprietor of Peer-
Sync:

Peer Software, Inc.
5900 Fort Drive , Suite 415
Centrevile, VA 20121

Phone: 703.763.7700
Fax: 703.763.7705
Web: http:// www.peersoftware.com
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Upgrade Information
Visit http://www.peersoftware.com/support/request-product-update.html to get the latest ver-

sion of PeerSync.

Check this page periodically to download the latest executables. Your Authorization Key will
continue to work with updated versions unless a major release is posted.

To Upgrade PeerSync and PSListener

Major product upgrades such as v9.3 to v9.4 will require a new product key. Users currently
on annual maintenance must fill out the request for upgrade form to receive the upgrade Ili-
cense key before downloading v9.4.x. Users not on annual maintenance must contact sales

for upgrade pricing.

The following document outlines the steps to upgrade PeerSync and PeerSync Listener
(ByteReplicator- TCP WAN Connector/PSListener Agent) from one version to the next: http://

www.peersoftware.com/support/knowledgebase/item/peersync-upgrade-instructions.html

Interface Features

o PeerSync Profiler Server v9.4 - HQ_PROFILE.SNC
File Edit View Options Run Job Help
D& - @R @ E-F X oo @8- e 8
Profile Description: |HQ_PrcﬁIe
|Basic W Run/View PeerSync - Advanced Display for HQ_Profile.snc (Application is Running)
Peersync # Job Mame Target Last Scan (Status: Duration) In Sync Trending
- PeerSync Job Settings & 1 DataMigration \\galsblwinD8xs4a\...  5/23/2016 11:03:44 AM (Sca... Mo (Scan Running; Items ... N/A
- Folder Selection @ 2 DOTBackup  C:VProgram Files (x8...  5/23/2016 11:03:44 AM (Sca... Mo (Scan Running) N/A
- Automation — Al Jobs NfA No NfA
F_ile Options
- NFS Settings < m | ¥
ermissions | Terminate Active Profile | View Active Profile |
Open Files
i~ Managed Files Status |Updabed | Added | Deletions I Excluded | Messages | Job Scans | Failed Events | Historical Data | Job Control
i ByteReplicator
- Exceptions Profile: HQ_Profile
. Reporting Job: Nf& - Multiple Job Threads Enabled
- Advanced Options Mode: Automatic and Real-Time (Persistent)
~PeerSync Global Settings Scanned Folders: 234 of 1085 [ ]
- Options/Commands
Stortup/Senie Somedries: o6 of v |
-peesyncstarupfsence || samedytes 979G of 10036 I |
R_un,.'\l"lew
../ RunView PeerSync Chedked: 5206 Updated: 200 Current Job Status: Normal
Exduded: 13 Added: 0 Pending Event Status: Mo Pending Items
Messages: 0 Deleted: 0 Current Event Status: Running Items (Job Scans: 2) (Expanded Scans: 9) (Scan

Synchronizing folder: IMAGES

| Total Transferred: 23.43MB - 00:00:13|

Show Basic Display Refresh ‘

The manufacturer of PeerSync makes no warranties, implied or otherwise, for use of this product. User assumes all re-
sponsibility for any data loss or damage.
Copyright © 1993-2016 Peer Software Inc. All Rights Reserved Privacy Policy
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Getting Started

The Profiler is used to create PeerSync Profiles. A Profile can contain as many as 255 indi-
vidual synchronization tasks, or Jobs. A Job is defined by identifying a Source Folder, a Tar-
getFolder (to which the contents of the Source will be synchronized), and then choosing from
more than 80 easily specified Job Settings. These settings determine which contents will be
synchronized, in what manner, and when they will be synchronized -- according to your choice
of Real-Time, Scheduled, or manually initiated operations.

The process of building a Profile is made quick and simple by allowing you to easily create
Jobs and then follow the sequentially arranged list of Settings screens accessed through the
Selection Tree, which is located on the left side of the application interface. The user begins
by first selecting a single Job or Multiple Jobs from the Profile Job List. Then specific syn-
chronization criteria is applied to the selected items using Job Settings. Once synchronization
criteria has been configured for each Job, Run/View Current Profile window is used to launch
the entire Profile. By offering a Tool button Toolbar as well as separate Selection Tree and
Profile Job Listwindows, Profiler's browser-based interface allows you to easily view, create,
copy, rename, move, or delete Jobs regardless of which Settings screen is currently being
displayed.

Product Definitions

Synchronization Updating any existing files or adding new files in the Target
Folder using the Source Folder as the guide. When completed,
the Target Folder should contain all of the files in the Source
Folder with matching contentand time stamps.

Replication Same as synchronization, except files that are in the Target
Folderthatdo nothave a matching Source File will be deleted.

Profiles A Profile is a description of a complete synchronization scen-
ario. Profiles can contain many Source-Targetcombinations al-
lowing the end-user to define very detailed file synchroniza-
tions and run them all within a single request. For example, you
could build a Profile that contains Multiple Source and Target
Folders such as:

Source =C:\\My Documents Target = \\SERVERT\USERS
\TEST\My Documents

Source =D:\LocalData Target = \\SERVER2\USERS
\TEST\LocalData

Source = C)\WINDOWSTarget = \\SERVER3\USERS

\Profiles \TEST\Profiles

Each of these Source-Target entries can then be further de-
tailed with more than 65 options each making each entry a
completely self-contained process while still allowing it to be
run as partofa bigger setor Profile.
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Jobs A Job is a single entry in a Profile. A Profile can contain from
one to 255 Jobs and each Job contains more than 80 individual
option settings.

Real-time Mode In this mode of operation, PeerSync will automatically detect
changes made to the Source Folder(s) and execute the syn-
chronization options selected for the matching Job. Typically,
the Target Folder is updated with the Source Folder change
within moments of the change. Note that PeerSync may have
completed the operation before Windows actually displays the
change inthe Target Folder Explorer window.

Scheduled Mode In this mode of operation, PeerSync will execute the desig-
nated Job at the selected time. Each Job in the Profile can
have the same or differenttime interval.

Product Support All supportof PeerSync will be handled on our web site support

page located at hitp://www.peersoftware.com/support/submit-
a-case.html.

PeerSync is fully supported under all NT based platforms of
Windows but should first be evaluated on each machine in
which you wish to register the product on. PeerSync is no
longer fully supported under Windows 9x platforms.

Notes:

1. The Profiler is not meant to be running persistently on the Desktop. Rather it should be accessed to create/
modify Profiles and to view the status of running Jobs.

2. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:/ / www.peersoftware.conv support/ submit-a-case.html.

Tool Buttons

Profiler offers simple buttons allowing you to easily modify the current Profile and its Jobs, re-
gardless of which screen has been chosen from the Selection Tree. These buttons can be
hidden by unchecking the "Tool Buttons" option, accessed through the "Toolbars" item on
the View Menu. Even if this Toolbar has been hidden you will still be able to access its op-
tions by using the File, Edit,and Job Menus. You can also change the placement of these but-
tons by clicking on the left side ofthe Toolbarand dragging itto rest above or below the Pro-
file Description Toolbar.

Tool Buttons Toolbar

The following descriptions are listed in the order in which they appear left to right on the
Tool Buttons Toolbarand are all accessible via the application Menus.

New Profile Located on the far left of the Toolbar, this button creates a new
Profile. If another Profile containing unsaved changes is cur-
rently open when this button is pressed, a dialog box will open
asking you if you want to save changes to the current Profile
before opening a new one (See Save Profile Button Below). If
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you choose "No," the new Profile will replace the current one
and no changes will be saved.

Note: If the cument Profile has not been previously saved and "No" is
chosen, the entire Profile will be lost.

Open Profile

This button displays a "Select Profile File" dialog box allowing
you to open an existing Profile. By default, it will open in the
path in which PeerSync has been installed (i.e. C:\\Program
Files\PeerSync). Links to previously opened Profiles can be
accessible through a drop-down list opened by clicking on the
arrow key attached to this button.

Save Profile

This button allows you to save new Profiles, or save changes
made to existing Profiles. If you are saving a new Profile, a
"Save As" dialog box will open allowing you to name and store
itas an .SNC file in your choice of folders, with "NewProfile" as
the default name and the path in which PeerSync has been in-
stalled as the default directory. Profiles and Profile modifica-
tions mustbe saved in orderto be subsequently accessible.

Launch Current Profile

This feature will launch the current Profile (Job/Global settings).
During this process, an instance of PeerSync will be started
with the current Profile as the first parameter and the arguments
selected from the Options/Commands screen as the sub-
sequent parameters. You can automate this process via a
shortcut, through the startup folder, in the registry or as a ser-
vice by selecting one of these features from the StartUp Ser-
vices screen.

Terminate/Stop Act-
ive Profile

This option, when available, will allow a user to terminate an in-
stance of PeerSync that contains an active Profile that is con-
nected to the Profiler.

Restart Active Profile

This option, when available, provides intelligent restart func-
tionality that eliminates/improves scanning upon PeerSync ser-
vice/application restart. This greatly improves performance
during a restart (most commonly due to profile changes, but
also for any otherreason).

Connect: Enable Job
Control Mode

This tool button becomes \sible when the Profiler has been
started and is in a running state. The option connects the con-
figuration Profile to the running PeerSync. When selected, this
option changes the Job List Display into Job Control Mode.

Disconnect: Enable
Configuration Mode

This tool button becomes \isible when the Profiler is running as
a senice and Job Control Mode has been enabled. When se-
lected, this option changes the Job List Display into the default
Configuration Mode.

Add Job

file Job List). Jobs are named "New Job ltem" and assigned a

This button adds a Job to the bottom of the current list (See Pro-

number by default. If you have selected "Use Wizard to Add
New Jobs" from the Options Menu, the Wizard application will
open when this button is pressed. The Wizard provides a
guided, step-by-step method for creating and configuring new
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Jobs. A drop-down list attached to this button also allows you to
choose between "Add Job With Wizard" or "Add Job With De-
faults" options. If the former is chosen, Wizard will open every
time this button is pressed. If the latter is chosen, new Jobs ad-
ded to the list through this button will be configured manually us-
ing Selection Tree screens. These Jobs will use whichever de-
fault settings are currently applied (See Job Menu, "Save De-
faults").

Note: The first time "Add Job With Wizard" is chosen from the drop-down list,
the Wizard application will open. After that point Wizard will be launched by
pressing the Add Job button.

Copy Job

Creates a copy of the currently selected Job and places it at
the bottom of the Profile Job List. Copies will be numbered by
defaultand named after the original (i.e. "Copy 1 of My Syncs").

Rename Job

Allows you to rename the currently selected Job. Jobs can
also be renamed manually by clicking on them after they have
been highlighted.

Delete Job Deletes the currently selected Job(s). When this button is
pressed, a dialog box will open asking you to confirm deletion.
Jobs can also be deleted by selecting them and then pressing
the DELETE key on your keyboard.

Move Job Up Moves the currently selected Job up one place within the Pro-

file Job List.

Move Job Down

Moves the currently selected Job down one place within the

Profile Job List.

Show Selection Tree

Shows or hides the Selection Tree. If the Tree has been hid-
den, its space will be filled within the interface by the currently
selected Settings screen. When the tree is hidden, screens can
still be selected using the drop-down list attached to the Back
button.

Job View

Click the down arrow button next to this option to see the entire
listof settings thatcan be used to alter the view of the Job list.

Select This option is available only when the Details

Columns view mode is set. It is used to define the exact
columns to display in the Job list. Options in-
clude Source, Target, Group, Modified, and
State.

Large Icons Select this option to represent each Job as a
large icon in the Job list panel.

Small Icons Select this option to represent each Job as a
small icon in the Job list panel

List Select this option to represent each Job as a
list in the Job list panel.
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Details Select this option to represent each Job as a
detailed list in the Job list panel. Use the
Select Columns option to customize the view
to show only the desired columns.

Group by This option is only available when the Large
Icons, Small Icons, or Details view modes are
selected. Use this option to group the Jobs
based on the following categories: Source, Tar-
get, Job Group, Job State, and Modified.

Options This option is only available when the Details
view mode is selected. Use this option to cus-
tomize the look of the Job list panel by select-
ing: Show Columns, Show Grid Lines, or Row
Select.

Back

Opens the screen located immediately above that, which is
currently being displayed. Settings screens can also be ac-
cessed using the drop-down listlocated on the right side of the
Back button; list items follow the same order as that shown on
the Selection Tree.

Next

Opens the Profile Options screen located immediately below
the screen currently being displayed.

Help Manual

Opens the application help file. You may also access specific
parts of the help file for features you are currently observing by
pressing 'F1' on your keyboard.

Profile Description

This field is located bellow the Tool Buttons Toolbar by default and displays a textual de-
scription of the current Profile. By default the description for an unsaved Profile will read "Pro-
file Job List" Unless you enter a unique description into this field, a default description will be
assigned upon saving the Profile; this default description will match the new Profile name.

Descriptions can be changed atany time; like all Profiler configurations, they must be saved
prior to closing the Profile or application in order to be stored. The Profile Description can
also be hidden by unchecking the "Profile Description" option, accessed through the "Tool-

bars" item on the View Menu.

Menus

1. File Menu

File

This menu includes items allowing you to create and save new Profiles, open existing Pro-
files, create Profile desktop shortcuts, and exitthe application.

New

Create a new Profile. This feature is accessible from the Tool
Buttons Toolbar.
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Open Open an existing Profile. This feature is also accessible from
the Tool Buttons Toolbar.

Reopen Reopen a recently used Profile.

Save Save the current Profile. This feature is also accessible from
the Tool Butions Toolbar.

Save as Rename and Save the current Profile.

Profile - Revert to
Saved

Revertto the lastsaved settings of the current Profile.

Profile - Merge Exist-
ing

Merge an existing Profile into the current Profile.

Profile - Create Short-
cuton Desktop

Create and add a shortcut to PeerSync of the current Profile
and settings/command line arguments to the desktop.

Profile - Save De-
faults

Save the current settings of the Profile as the default settings.

Exit

Close/exitthe application.

2. Edit Menu

Edit

Allows you to move one step up or down between Selection Tree options screens while
providing a shortcut to the Run/View Current Profile Activity screen.

Back Move back to the previous screen. This feature is accessible
from the Tool Buttons Toolbar.
Next Move on to the next screen. This feature is also accessible

from the Tool Buttons Toolbar.

Run/View Current Pro-
file

Go to the Run/View Current Profile Activity screen.

3. View Menu

View

Allows you to change the appearance of the application interface. "Hint" items enable or
disable pop-up hints activated by passing the mouse pointer over interface features, as
well as those displayed in the Status Bar located at the bottom of the application interface.
In addition to a description of Profiler features, hints will identify command line arguments
associated with those features (if any).

Toolbars - Tool But-
tons

Show/hide the Tool Buttons Toolbar.

Toolbars - Profile De-
scription

Showr/hide the Profile Description Toolbar.
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Toolbars - with Hot
Tracks

Show/hide the hottracks features for the Toolbars.

Toolbars - with Text
Labels

Show/hide description textlabels for the Toolbars.

Selection Tree

Show/hide the Selection Tree left side panel. This feature is
also accessible from the Tool Butions Toolbar.1

Refresh Current Pro-
file Activity

Refresh Profile activity.

Status Bar

Show/hide the Status Bar atthe bottom of the application.

Hints - on Application

Show/hide pop-up hints displayed on the application.

Hints - on Status Bar

Show/hide hints displayed on the Status Bar.

Folders

Allows for the ability to launch and display Source and Target
Folder selections in organized Explorer windows in a set view-
ing area. This helps the userto view and/or validate the Source
and TargetFolder contentbefore, after, and during synchroniz-
ation. These features may be helpful during evaluation and
when running and testing a newly modified Profile.

Job Groups

Similar to Microsoft's Multiple Document Interface (MDI), Peer-
Sync now contains a multi-pane interface thatallows the user to
organize groups of Jobs (Source and Target pairs) by any
convention necessary. User-specified tab controls allow quick
transition from one group to another. The traditional Job list in-
terface is still available for those who do not need the group
panes.

Profile Messages

Open the Profile Message Log file if it exists. The naming con-
vention of the Message Log files is as follows: Profile.snc.log,
where Profile represents the name of the current Profile.

4. Options Menu

Options

Allows you to select options pertaining to the way PeerSync, the Profiler and the Wizard in-
teract with each other and Windows Explorer.

Set Compatibility

Option to run the Profiler, PeerSync, or PSWizard using re-
duced color mode.

Use Wizard to Add
Jobs

Available only ifthe Wizard is installed during the PeerSync in-
stallation. If selected, directs Profilerto open the Wizard applic-
ation as an easier and simpler way to add new Jobs to a Pro-
file. If not selected, the Add Job option will use the saved Job
defaults. This feature is toggled on or off depending on which
option was used the last time that a Job was added (with De-
faults or with Wizard).
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Create SNC extension
association

If selected, creates an association of any file that has an SNC
extension with the Profilerto be used as the default application
to open these files. If not selected, the association of SNC files
with the Profiler will be removed. This feature is also access-
ible from the Startup Services screen.

Add Quick-Sync
Folder option to Ex-
plorer menu

If selected, will add our Quick-Sync feature to Windows Ex-
plorer. To access this feature, simply right-click on any folder in
Explorer, or on your Desktop, and you will be able to sync the
folder to selected Target Folder(s), add the Job to a Quick-
Sync Profile that is stored out in memory, and administer the
ability to modify/add to the Jobs using the Profiler. This feature
is also accessible from the Startup Services screen.

Check For Modified
Profile

If checked, this option will activate a timer to check if a change
occurred to the Profile every 3 seconds and will promptfor a re-
load.

On Profile Exit

This option allows for the ability to do one of the following when
exiting the Profiler while itis connected to an Active Profile: Dis-
play Terminate Active Profile Dialog, Leave Active Profile Run-
ning, or Terminate Active Profile.

Global Settings

Displays various settings including Recovery/Offline Options,
Performance Options, Reporting Options, Display Options,
ACL Options, Bi-directional Options, Managed Files Options,
and Current Command Line Arguments.

5. Run Menu

Run

rent Profile.

Allows you to Launch the Current Profile, Terminate the Active Profile and Update the Cur-

Launch Current Profile

This feature will launch the current Profile (Job/Global settings)
in PeerSync. During this process, an instance of PeerSync will
be started with the current Profile as the first parameter and the
arguments selected from the Options/Commands screen as
the subsequent parameters. You can automate this process
via a shortcut, through the startup folder, in the registry or as a
service by selecting one of these features from the Startup Ser-
vices screen. This feature is also accessible from the Tool But-
tons Toolbar.

Terminate Active Pro-
file

This option, when available, will allow a user to terminate an in-
stance of PeerSync that contains an active Profile which is con-
nected to the Profiler. This feature is also accessible from the
Tool Butions Toolbar.

Update Current Profile

This option, when available, will allow a user to update an in-
stance of PeerSync with the current Profile opened in the Pro-
filer.
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Restart Active Profile

This option, when available, provides intelligent restart func-
tionality that eliminates/improves scanning upon PeerSync ser-
vice/application restart. This greatly improves performance
during a restart (most commonly due to profile changes, but
also for any otherreason).

Pre-Sync Report

This executes a pre-sync report of the currently selected Jobs.
During this process, files and folders will not be modified and
persistent arguments set for the current Profile will be ignored.
A reportwill be created and displayed with the work that would
be performed ifa synchronization was actually run. This feature
may be quite helpful during evaluation and when running and
testing a newly modified Profile. Pre-Sync Report options are
as follows:

Run a Pre-Sync Report (do not sync files/folders)
Starts PeerSync to analyze the work that would be performed if
synchronization was actually run. During this process files and
folders will notbe modified. The reportfile, PreSync.Log, will be
displayed atthe end ofthe run.

Overwrite existing Pre-Sync report files
Enabled by default, this setting overwrites the PreSync.Log file
when the Pre-Sync process completes.

Show Pre-Sync report file at end of run
Enabled by default, this setting will open and display the
PreSync.Log reportfile after the Pre-Sync process completes.

Reprocess Failed
Events

This option, when available, will allow for Failed Files to be pro-
cessed. Failed Files are files that have failed to be replicated/
synchronized possibly due to Retries being turned off or ex-
ceeded.

Reprocess Failed
Scans

This option, when available, will allow for Failed Scans to be
processed. Failed Scans will only occur if a scan is interrupted
or cannot run and the Retry failed connection every x
minutes optionis disabled.

Note: Because it is separate from the core software engine, the Profiler allows you to create and configure new
Profiles while PeerSync runs Synchronization Operations at optimum efficiency. In both this Help file and on Profiler
screens, "Current" refers to the Profile cumently being configured but not yet launched, while "Active" most often
refers to the Profile presently being run by the PeerSync engine.

6. Job Menu

Job

Allows you to manipulate Jobs within the current Profile. If "Allow Multiple Selection" has
been checked on this menu, you will be able to selectand apply settings to Multiple Jobs.

Add - Job with De-
faults

Creates and adds a Job to the current Profile using the saved
Job defaults. This feature is also accessible from the Tool But-
tons Toolbar and the Profile Job List Pop-Up Menu.
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Add - Job with Wizard

Creates and adds a Job to the current Profile suing a Wizard
which guides in the creation of a Profile. This feature is also ac-
cessible from the Tool Buttons Toolbarand the Profile Job List
Pop-Up Menu.

Copy

Creates a duplicate copy of the currently selected Job and all
of its settings. This feature is also accessible from the Tool But-
tons Toolbarand the Profile Job List Pop-Up Menu.

Rename

Allows for the renaming of the selected Job. This feature is also
accessible from the Tool Buttons Toolbar and the Profile Job
List Pop-Up Menu.

Delete

Allows for the deletion of the currently selected Job(s). This fea-
ture is also accessible from the Tool Buttons Toolbar and the
Profile Job List Pop-Up Menu.

Clear All

This will close the current Profile allowing for the user to create
a new Profile.

Move Up

Moves the currently selected Job up one in the list. This feature
is also accessible from the Tool Butions Toolbar and the Pro-
file Job List Pop-Up Menu.

Move Down

Moves the currently selected Job down one in the list. This fea-
ture is also accessible from the Tool Buttons Toolbar and the
Profile Job List Pop-Up Menu.

Select All

This will selectall ofthe Jobs.

Invert Selection

This will change the selected state ofall the Jobs.

Allow Multiple Selec-
tion

Gives the ability to selectand apply settings to Multiple Jobs.

Create Auto Job

This feature allows a simple way to generate meaningful Job

Name names. When selecting this item, Job names are automatically
generated based on their Source and Target paths which
make ita simple task to organize the Job list.

Log File - View Display the log file for the selected Job.

Log File - Clear

Clearthe log file for the selected Job.

Message Log File -
View

Display the message log file for the selected Job or profile.

Message Log File -
Clear

Clear the message log file for the selected Job or Profile.

Save Defaults

Stores the currently selected Job Settings as the default for all
subsequentnewly added Jobs.

7. Help Menu

Help

Copyright © 1993-2016 Peer Software Inc. All Rights Reserved




PeerSync Help 22

While allowing you to access Help files and the About screen, this menu also provides
demonstrations of PeerSync's Real-Time Monitoring and Scheduled Operation modes.

Demos This option allows the user to instantly run either a Real-Time
or Scheduled test Profile to demonstrate PeerSync's synchron-
ization capabilities.

Web Site This menu item will have many links back to our web site for

productinformation, downloads, updates and support.

Online Resources

Provides links to online demos/tutorials/documents and for-
ums.

Check for Updates...

Checks whether you are using the latest version of PeerSync.
This process requires an Internet connection in order to trans-
mityour registration information to our web serverfor validation.
This feature also has the ability to check updates for all Peer-
Sync related products (if they are installed) directly from the
Profiler. This includes the PSListener, PeerLock, and the Peer
Administrator. A menu option to check for updates will be dis-
played for all products thathave been installed.

PeerSync Help

Will open the application help file to the contents section. You
may also access specific parts of the help file for features you
are currently observing by pressing 'F1' on your keyboard.

Include Unchecked
Jobs in Support Info
File

If enabled, the Create Support Info File on the Desktop... log
and configuration gathering process will collect Job information
from un-checked Jobs.

Create Support Info

File on the Desktop...

This option will compile all Profile related files into a zip folder
on the Desktop. This information can be submitted to our sup-
portteam for analysis. The following is a list of files that are in-
cluded ifthey exists:

PeerSync Files:

[ProfileName].snc - Profile

PSDEF.CFG - Configuration File

[ProfileName] totxml - Total SupportFile

[ProfileName]_np totxml - Total Support File (Non Per-
sistent)

[ProfileName] .curxml - Current SupportFile

[ProfileName]_np curxml - Current Support File (Non Per-
sistent)

[ProfileName].las.xml - LastSupportFile

[ProfleName]_np.las.xml - Last Support File (Non Persist-
ent)

[ProfileName].snc[.bak*].log - Profile Error Log Files

PSError.Log - Application Error Log File

[JobName].[bak*].log -Job Level Log Files

[JobName]fitf.bak*].log -Job Level Error Log Files

[JobName].del[.bak*].log - Deletion Cleanup Log Files

[ProfileName].tr - Time LastRun Log File

[%eVariableNames%].txt - Also included are Variable
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ADDCache.cur.txt

ADDCache las.txt
UPDCache.cur.txt

UPDCache las.txt
DELCache.cur.txt
DELCache.las.txt
JSCCache.cur.txt

JSCCache las.txt
EXCCache.cur.txt

EXCCache las.txt
FFLCache.cur.txt
FFLCache las.txt
JSHCache.cur.txt
JSHCache las.txt
MSGCache .cur.txt

MSGCache las.txt
CTPCache.cur.txt

CTPCache.las.txt
SNCCache.cur.txt

SNCCache.las.ixt
MFLCache.cur.txt

MFLCache.las txt

Supportinfo.txt

PeerlLock Files:
PLDef.CFG

PeerLock[.bak*].log

Data Import and Job Data Im-
portfiles

- Current cache file of Add
events

- Last cache file of Add events

- Current cache file of Update
events

- Last cache file of Update
events

- Current cache file of Deleted
events

- Last cache file of Deleted
events

- Current cache file of Job
Scans

- Lastcache file of Jobs Scans

- Current cache file of Excluded
items

- Last cache file of Excluded
items

- Current cache file of Failed
Events

- Last cache file of Failed
Events

- Current cache file of Historical
Data

- Last cache file of Historical
Data

- Current cache file of Mes-
sages

- Lastcache file of Messages

- Current cache file of Copy
Thread Progress

- Last cache file of Copy
Thread Progress

- Current cache file for the Pro-
file

- Last cache file for the Profile

- Current cache file of Managed
Files Listitems

- Last cache file of Managed
Files Listitems

- Contains the list of files that
PeerSync will try to include in
the supportzip folder

- Configuration File
- PeerlLock Log Files
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The files will be zipped and stored on the Desktop for easy at-
tachment to emails. A copy of the zipped folder will also be
stored in the PeerSync installation folder (i.e. C:\Program Files
\PeerSync\InfoFiles\Supportinfo_ date/time .zip).

Create System Info
File on the Desktop...

Creates a system info file (Sysinfo.nfo) on the Desktop. A copy
of the file will be kept in the InfoFiles folder located in the Peer-
Sync installation folder (i.e. C\Program Files\PeerSync\In-
foFiles\SystemInfo_200810081953.zip - where 200810081953
represents yyyymmddhhss respectively). Creating the System
Information File takes a few minutes. Keeping a copy of the
System Information file in the InfoFiles folder eliminates the
need to wait for the creation of a new file whenever one is
needed and provides an archive of previous system states
thatcan be used for troubleshooting.

Register PeerSync

Will display the PeerSync Registration Screen to activate the
PeerSync trial version or upgrade the currentlicense.

License Information

Will display the different Product Editions and Licensing avail-
able for PeerSync. Will also display what the current edition
has available as well as other useful information about the cur-
rent package you are running.

About PeerSync

Will display an about screen, which contains information about
the current PeerSync you are running.

8. Evaluation Menu

Evaluation

Only displayed in evaluation copies of the software, this menu item will contain features that
we believe are helpful to the user during evaluation such as demos, README files, and
other evaluation oriented features.

Read me first...

Opens the Evaluation.txt file that provides instruction on how to
run the built-in Demo, add yourfirst Job, run your first Profile and
steps on how to use Quick-Sync and the Wizard.

Reviewer's Guide

Opens the Reviewer's Guide manual that provides a quick
productoverview and useful evaluation scenarios and demon-
strations.

Real-Time Monitoring
Demo

Launches a demo that will synchronize the designated source
and targetfolders automatically upon change in real-time.

Scheduled Operation
Demo

Launches a demo that will synchronize the designated source
and targetfolders every 15 seconds.

End Demo

Available only if PeerSync is running either the "Real-Time" or
"Scheduled" demo. Selecting this option will terminate the run-
ning demo.

License Information

Opens the Licensing dialog which lists all the options/features
thatare Active or Inactive in the product. The About screen can
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be accessed from this dialog by clicking on the Register but-
ton.

Buy Now ... Opens the web browser to our online purchase page from
where the product can be purchased directly.

9. Popup View Menu

View Popup Menu

Activated by right clicking on the Tool Buttons Toolbar, Profile Description Toolbar, or the
Status Bar. Some ofthese options can be selected from the View Menu.

Tool Buttons Show/hide the Tool Buttons Toolbar.

Profile Description Show/hide the Profile Description Toolbar.

with Hot Tracks Show/hide the hottracks features for the Toolbars.

with Text Labels Show/hide description text labels for the Toolbars.
Status Bar Show/hide the Status Bar atthe bottom of the application.

10. Popup Tray Icon Menu

PeerSync Tray Icon Popup Menu

Activated by right clicking on the Tray Icon. The Tray Icon is only accessible when Peer-
Sync is running as an application (notas a service) and has the "Show tray icon" option en-
abled in the Options/Commands window.

View Log File Allows you to access, launch and view Log files in the default
text editor for the current Profile.

View Message Log Allows you to access, launch and view the Message log file for

File the current Profile.

View Admin Folder Allows you to access, launch and view Admin log file Folders in

Explorer for the current Profile.

Open Source Folder | Allows you to access, launch and view Source Folders in Ex-
plorer for the current Profile.

Open Target Folder Allows you to access, launch and view Target Folders in Ex-
plorer for the current Profile.

Show Status Display [ This item will show the PeerSync Status Display dialog box
during synchronization so the user can see activity, status, and
other information while PeerSync is running. T his feature is only
available ifthe Display Status in the PeerSync feature was en-
abled for the current Profile.

Connect/Launch Peer- | This item will open the Profiler, if it is not already open, and
Sync Profiler send status messages to be displayed on the Run/View Cur-
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rent Profile Activity screen. This connection feature will only
work ifthe Display Status in Profiler feature was enabled for the
current Profile.

About PeerSync Will display an about screen, that contains information about
the current PeerSync you are running.

Exit PeerSync Allows you to close/exit the current session of PeerSync.

Note: A pop-up hint message will be displayed when you mouse over the Tray Icon. This will provide key informa-
tion about the current PeerSync application running including the Profile name and the status of VSS if it is running.

11. Profile Job List

Located beneath the Toolbars, this window displays all Jobs associated with the current Pro-
file. Use of this listis central to the Profile-building process; all configurations made on the
Job Settings screens (accessed through the Selection Tree) will only be applied to those
Jobs currently selected from this list.

To selecta Job, highlight it using the left mouse button. The "Allow Multiple Selection” item
must be checked on the Job Menu in order to select and have settings applied to Multiple
Jobs. To select Multiple Adjacent Jobs, highlight the first Job, hold down the SHIFT key on
your keyboard, and then highlight the last Job you wish to include. You can also hold down
the SHIFT key and then use the up or down arrow keys on your keyboard. To select Multiple
Nonadjacent Jobs, highlight the first Job, then hold down the CTRL key on your keyboard
and click on each additional Job you wish to include. Once you have selected a Job or Jobs,
move through the screens found on the Selection Tree and apply settings as desired. High-
lighting on the selected Job(s) will appear gray as you move through these screens, indicat-
ing thatany configured settings will only be applied to those selected Jobs.

The box appearing to the left of each Job must be checked in order for that Job to be in-
cluded in the active Profile when launched. Although unchecked Jobs will not be processed
upon launch, they will be saved within the Profile for future use and/or selection.

Upon creating a new Profile, an initial Job will be displayed bearing the name "New Job ltem
1" by default (this applies to manual Job creation only). The first New Job added within an ex-
isting Profile will also bear this name. Successive Jobs will be named "New Job ltem 2"
"New Job Item 3," etc. Any selected Job can be renamed through the "Rename" Tool Button,
through items found on both the Job Menu and Profile Job List Pop-Up Menu described be-
low, or manually by selecting ita second time using the left mouse button.

In both new and stored Profiles, you can navigate the Profile Job List as well as add, copy,
delete, and navigate Jobs using the Tool Buttons; using items from the Job Menu, and by us-
ing items found on the Profile Job ListPop-Up Menu described below. You can also navigate
the listand delete items using the DELETE and up and down arrow keys on your keyboard.

Note: In orderto navigate or modify the Profile Job List, you must have first clicked somewhere within the Profile Job List
window; this ensures that during configuration any options chosen from the Selection Tree screens are applied exclusively
to the cumently selected Job.

The height of the Profile Job Listwindow can be changed by passing the mouse pointer over
its bottom border until a double/Arrow cursor appears, then dragging the window to meet the
desired size. At minimum size, only a single Job may be viewed. Adding a new Job while this
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view is in effect prompts display of up and down arrow buttons in the right side of the window.
These buttons allow you to view different Jobs within the list.

Job List Pop-Up Menu

Activated by right clicking on the Profile Job List, this menu duplicates the mostly used fea-
tures found on the Job Menu while providing some additional items listed below.

Synchronize Selected | This executes an immediate, non-persistent synchronization of
Jobs the currently selected Jobs ("non-persistent" refers to a one-
time sync process; "persistent’ refers to ongoing sync opera-
tions such as Real-Time Monitoring or Scheduled Operations).
During this process, persistent arguments set for the current
Profile will be ignored. When the button is released, a confirma-
tion dialog will be displayed indicating which Jobs have been
selected from the active Profile and asking you to confirm syn-
chronization through a "Yes" or "No" button. If"Yes" is selected,
the synchronization will proceed. A message will always be
displayed upon completion of this operation. Other sync opera-
tions allow you to choose whether or not such a message will
be displayed.

Create Pre-Sync Re- | This executes a pre-sync report of the currently selected Jobs.
port During this process, files and folders will not be modified and
persistent arguments set for the current Profile will be ignored.
A reportwill be created and displayed with the work that would
be performed ifa synchronization was actually run. This feature
may be quite helpful during evaluation and when running and
testing a newly modified Profile.

Connect: Enable Job | See description for this option under Tool Buttons.
Control Mode

Disconnect: Enable See description for this option under Tool Buttons.

Configuration Mode

Start Pending Job: See description for this option under Job _Control Mode. This op-

Name tion is only available when the Job List Display is in Control
Mode.

Start Pending Job:x See description for this option under Job Control Mode. This op-
tion is only available when the Job List Display is in Control

Mode.

Log File - View This menu item allows you to view Log reports by opening the
file in a texteditor. This feature is also accessible from the Re-
porting screen.

Log File - Clear This menu item allows you to clear Log reports. This feature is

also accessible from the Reporting screen.

Message Log File - This menu item allows you to view Message Log reports by
View opening the file in a text editor. This feature is also accessible
from the View Menu item.
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Message Log File -
Clear

This menuitem allows youto clear Message Log reports. This
feature is also accessible from the View Menu item.

Job List View Options

This feature enables/disables the ability to display the "Click
Here to Add Another Job" Job every time a new Job has been
created.

Use "<Click Here to
Add Another Job>"
Feature

This menu item will add a new Job to the end of the Job list
named "<Click Here to Add Another Job>" every time a new
Job is created.

Suppress Add Job
Confirm Dialog

This menu item will suppress the Confirmation Dialog that is
launched when clicking on the "<Click Her to Add Another
Job>" Job.

View Job Groups* (En-
hanced Package)

This feature enables/disables the ability to allow the user to or-
ganize/categorize Jobs within a Profile into Job Groups.

When this feature is enabled, you can create as many Job
Groups as desired. Each Job Group is represented by a Tab.
Each Tab displays the Job Group Name, the number of
Checked Jobs and the number of Total Jobs for the corres-
ponding Job Group, in the following format. GROUP NAME
[CHECKED JOBS / TOTAL JOBS]

Select All This menu item will select/highlight all Jobs within the current
Job Group for a quick and easy way of modifying all Jobs
within a given Profile. If this feature is not enabled you must turn
on the Allow Multiple Selection feature on from the Job Menu.

Last Run On This is a display of the last run date/time of the selected Job

within the current Profile. This is the date/time that will be used
when comparing files for the Bi-directional Synchronization
Mode option on the File Options screen. This feature is also
displayed on the from the Folder Selection screen.

Last Run On - Reset

This allows a means of resetting the lastrun date/time of the se-
lected Job within the current Profile.

Job Group Pop-Up Menu* (Enhanced Package)

Activated by right clicking on the Profile Job List, this Popup menu allows for the following

features:

Add Job Group

This menu item will create and add a new Job Group to the ex-
isting Profile.

Editor Delete Job
Groups

These menu items will display the Modify Job Groups Dialog,
allowing for the adding, renaming, moving, re-ordering, modify-
ing and/or the deletion of Job Groups.

Edit Job Groups Dia-
log

To add a Job Group click "New," then type the desired name
into the field located at the bottom of the dialog. Repeat this
process for each Job Group you wish to add. Entries can be
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deleted by selecting them from the listand clicking the "Delete"
key at the bottom of the box. You can also use the "Up" and
"Down" buttons to reorder the items.

All Tabs - Check All
Jobs

This menu item will set all Jobs to the checked state allowing
for a quick and easy way of checking all Jobs across all Job
Groups.

Jobs

All Tabs - Uncheck All

This menu item will setall Jobs to the unchecked state allowing
for a quick and easy way of unchecking all Jobs across all Job
Groups.

* Note: Some features described on this page require the Enhanced Package.

Selection Tree

| Customized

PeerSync

- PeerSync Job Settings

- Folder Selection

- Automation

- Blackout Settings

- 5can Limitations

- File Options

- MFS Settings

- Permissions

- Qpen Files

- Managed Files

- Performance

- ByteReplicator

- Revisioning

- Miscellaneous

- Additional Features

- Exceptions

- Reporting
Admin Reporting
‘. Email Reporting

- PrefPost Process

- Advanced Options

- PeerSync Global Settings
Options/Commands

PeerSync

PeerLock
Startup/Service

RunfView
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Screens can be accessed through the Selection Tree thatare used to setsynchronization cri-
teria for individual Jobs (Job Settings), as well as set global properties relating to execution
of the entire Profile and all related Jobs (Global Settings). Once you have selected a Job or
Jobs from the Profile Job List, all options configured on Job Settings screens will only be ap-
plied to those selections. After synchronization criteria for all individual Jobs have been es-
tablished, use the Global Settings screens to setglobal properties relating to all Jobs, as well
as choosing how you would like the Profile to be executed. The Profile Job List will appear
gray when any Global Settings screen is displayed, indicating that all properties set on that
screen will be applied to the entire Profile.

Selection Tree

The Selection Tree is located at the left side of the Profiler interface. The Selection Tree
can also be hidden by unchecking the "Selection Tree" option, accessed through the
"Toolbars" item on the View Menu.

Selection Tree Modes | The Selection Tree Modes are located in a drop-down list
above the Selection Tree. These modes can be used to show/
hide PeerSync configuration windows. The Selection Tree can
be setto Basic, Intermediate, Advanced or Customized.
Some Selection Tree items will not be accessible depending
on the package you are currently using. "Basic" is the default
Selection Tree Mode.

Selection Tree Cat- New in PeerSync v7.4, customers who are running PeerLock
egories v2.0.1 or higher on the same machine as PeerSync will now be
able to configure PeerlLock directly from the PeerSync Profiler.
Configuration options include the ability to link specific Peer-
Sync Profile Jobs to PeerlLock, ability to access/view/edit the
PeerLock Global Settings from the PeerSync Profiler, ability to
install/uninstall the PeerLock Service, as well as launch and
view PeerlLock directly from the PeerSync Profiler.

The Selection Tree can be categorized into four sections:
PeerSync,PeerLock, Startup/Service, and Run/View. By
default these categories will not be shown unless you have
PeerLock v2.0.1 or newer installed on the same computer as
PeerSync. You can manually display these categories by
adding PeerLock windows to the Customized tree mode.

Selection Tree Pop-Up Menu

Activated by right clicking on the Selection Tree, this menu duplicates the items listed in the
Selection Tree, as well as, the items listed in the drop-down list located on the right side of
the Back button on the Tool Buttons Toolbar. When right-clicking on the PeerSync Selec-
tion Tree Category, this Menu offers the following options:

Show All Profile Op- This feature will toggle between showing all Profile Options and
tions the Custom Options in the Selection Tree.

Customize This feature will allow the user to selectwhich Profile Options to
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display in the Custom Selection Tree, when the "Show All Pro-
file Options" is turned off. When selected the user will be given
the dialog box shown below to pick and choose which Profile
Options to use.

-I Selection Tree Categories

PeerSync
Peerlock

Startup/Service
Run/View

1. PeerSync
1.1 PeerSync Job Settings

This copy of Profiler may contain up to 255 Jobs for each Profie.

Each Job contains all the settings required for a Source to Target synchronization
process,

The current version will allow for synchronization to and from 10 remote machine(s).

IIse the options list to navigate through the various pages and set the options for each
Job as required.

= PeerSync Job Settings Screens
Eolder Selection
Automation
Blackout Settings
Scan Limitations
File Options
NFS Settings
Permissions
Open Files
Managed Files
Performance
Byte Replicator
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Revisioning
Miscellaneous
Additional Features
Exceptions
Reporting

Admin Reporting
Email Reporting
Pre/Post Process

Advanced Options

PeerSync Global Settings

Options/Commands

Note: Some settings are ignored when enabled in conjunction with other settings. For example, report summaries
are ignored in multiple threaded or enhanced Real-Time mode.

1.1.1 Job List Display

Job Mame Source Target
State: Active [2/2] ~
';‘;%Netﬁ.pp Backup Vnalab1vol1\Data W\192.168. 171, 142\cs\Data
{4 BIM & CAD Collaboration E:\BIM & CAD Projects \\192. 168. 171. 142\ &\BIM & CAD Pro...
State: Pending [1/1] h
J#MFS - Real-Time Synchronization  Yinalab1infs 1imisrc Vmsws 1ol _unixymitrg
State: Stopped [1/1] »
E,,New Site Migration E:\Data Set 11192, 168.171. 142'\es'\Data Set

=I Topics

Configuration Mode
Job Control Mode

Job List Popup Menu

Note: The Job List Display is the area within the Profiler listing all the Jobs and visually categorizing them based

on various modes.

The Job List Display is the area within the Profiler lists all the Jobs and visually categor-
izes them based on various modes forimproved Job review.

Configuration Mode

following states:

This is the default mode used by the Profiler. Here, each Job is categorized into one of the

Enabled All the Jobs which have a checked check box will be listed in
this category.
Disabled All the Jobs which have an un-checked check box will be listed

in this category.

The Job List Display is the area within the Profiler listing all the Jobs and visually categoriz-
ing them based on various modes forimproved Job review.
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The Profiler supports Job Control functionality thatallows every Job to be stopped, started,
orrestarted individually. To enter the Job Control mode, rightclick inthe Job List Display
and selectConnect: Enable Job Control Mode from the Profile Job List pop-up menu.

Job Control Mode

Active This category lists Jobs which are running successfully without
any errors.
Active w/Errors This category lists Jobs which are running but contain errors

typically indicating connectivity issues.

Active w/Warnings This category lists Jobs which are running but contain errors
typically indicating Failing Events.

Inactive Lists Jobs that were disabled or were newly added and the Pro-
filer does not yet know information about them. As soon as the
Profile is saved, newly added Jobs will be added to the Pending
state.

Pending Lists Jobs that were enabled or were newly added to the running
Profile but have not yet been started.

Stopped This category lists Jobs which have been stopped since the Pro-
file has been started.

Job Control Bar

The Job Control Bar buttons allows every Job to be stopped, started, or restarted indi-
vidually.

Start Pending Jobs:x | Start all the Jobs that are in a Pending state where x represents
the total number of Jobs that are in a Pending state.

Start Job Start the selected Job that is in a Sopped state.

Stop/Restart Job Stop or restart the selected Jobs that are in an Active state.

Save Profile and Re- | When Job changes are made to the running Profile, a Save
fresh Profile and Refresh option can be seen at the bottom right
corner of the Job List Display. Saving will refresh the Job
List Display to reflect any changes. The Job Control Bar but-
tons become disabled and grayed out to indicate that Profile
changes were made which require saving.

Configuration Mode Columns

The following columns can be viewed in the Job List Display when in Configuration or Con-
trol Mode:

Source Displays the source paths of the listed Jobs.

Target Displays the target paths of the listed Jobs.
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Group Lists the name ofthe group each Job belongs to.
State Identifies the State each Job belongs to.
Modified Displays the time and date the last time a Job was modified.

1.1.2 Folder Selection

Folder Selection

Mode Source Folder
Host Name: QASWM1
(®) Normal User & Password;: vsadmin FEEEEEERERsEEEE
) |'|,'|,qasvm 1\QATesting Mixed ] | B
O Tep
Include sub-folders Set Alternate fAdditional Targets
Mode Target Folder
Host Name: QALABIWINI2R2A
(®) Normal User & Password;: <Mone >
) |C: \Program Files (x86)\PeersSynciTarget ] | IZ|
O Tcp

Last Save: 5/23/2016 11:03:34 AM (Saved by: QALAB 1\Administrator)
Last Scan: 5232016 11:03:44 AM (Completed Successfully)

= Topics
Folder Selection Overview
Source Folder Selection

TargetFolder Selection
Include Sub-folders

Swap Source and TargetFolders
LastSave

LastScan
Other Features

Note: Features listed on this page may require the TCP_ WAN Connector, NetApp, or NFS options.

Each Job within a Profile is initially defined by using the Eolder Selection screen to select

a

Source and TargetFolder. The contents ofa Source Folder will be synchronized to a Target
Folder according to criteria further defined on other Settings screens. Once you have high-

lighted a Job or Jobs from the Profile Job List, this screen offers several different methods #
locate and select folders for synchronization. File paths can be typed manually, or you ca
browse local and network drives to locate and selectyour desired folders.

(0}
n

Source Folder Selection

following options are available for selecting a Source folder.

The options listed on this page can be accessed from the Eolder Selection window. The

sired Source directory via a Local Path, a UNC Path, or a

Using Normal Mode Selecta "Normal" Source folder if you can navigate to the de-
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Mapped Drive. This selection requires that the machine on
which PeerSync is running has full access to the desired
Source directory. In some instances Network Logon may be re-
quired.

Select a Source Folder by typing the file path into the field
provided or by using the Select Source Folder Button. By de-
fault, the Source Folder field will contain the path in which Peer-
Sync has beeninstalled: in most cases this will be C:\\Program
Files\PeerSync\Source. The convention outlined in this path
must be used when manually typing entries, (i.e. a drive must
be specified followed by a colon, with subsequent folders sep-
arated by backslashes). This field is not case sensitive, though
spaces may only be entered where they are partof valid folder
names (i.e. "Program Files"). No space should appear
between slashes and folder names. This field also supports
File/Folder Path Variables.

UNC names can be entered manually, or can be selected from
the Network Neighborhood using the "Browse for Folder" dia-
log box (see Select Source Folder Button). UNC names will ap-
pear in the form W\COMPUTER\SHAREDDEVICE\PATH. For
example:\\SERVER11\D\USERDATA.

Starting with the release of v9.0, we now support the ability to
connect to a remote NetApp filer and register for real-time
event notification. Please visit http://www.peersoftware.com or
contact Sales for license information.

Note: We do not recommend using UNC paths for folders that reside on the
local machine, in this scenario you should use the local path to that folder.

Folders canalso be dragged and dropped from MS Windows
Explorerinto the Source Folder Field forautomatic insertion.

The Source Folder Field holds a folder selection History of up
to 10 entries. They can be selected by clicking on the drop
down button located to the right of the field.

The current path will be displayed below the Source Folder
Selection Field. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to cor-
rect the invalid path and you exit the Source Folder Selection
field, the application will throw a message and use the default
PeerSync installation path C:\Program Files\PeerSync\Source
instead.

The Host Name and User Name & Password values (if
provided) are displayed above the Source Folder Selection

field (see Network Logon).
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Using TCP Mode Selecta "TCP" Source folder if the Source directory is outside
the scope of the machine on which PeerSync is running. TCP
enables access to machines not located on the same network
as PeerSync. As a prerequisite, the PSListener needs to be in-
stalled and running on the remote Source machine in order for
PeerSync to be able to communicate with it. This feature sup-
ports encryption and compression.

Note: We strongly recommend the use of a VPN when transfening files over
the public Intemet for security purposes. Otherwise, you should use our En-
cryption feature with a user name and password to protect data and all commu-
nication as it is being transferred.

When selecting the TCP Mode for the first time the Source
TCP/Port Configuration window will open automatically for
Source Folder configuration. Otherwise, the previously entered
TCP folder path will be displayed. This path can be manually
edited by typing directly into the field provided or by using the
Configuration button. The convention outlined in this path must
be used when manually typing entries, (i.e. the key word TCP
must be specified followed by a colon, two backslashes, the
Source IP address or machine name, and subsequent folders
separated by backslashes). This field is not case sensitive,
though spaces may only be entered where they are part of
valid folder names (i.e. "Program Files"). No space should ap-
pear between slashes and folder names. This field also sup-
ports File/Folder Path Variables.

The Source Folder Field holds a folder selection History of
more then 10 entries. They can be accessed by clicking on the
drop down button located to the right of the field.

The current path will be displayed bellow the Source Folder
Selection Filed. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to cor-
rect the invalid path and you exit the Source Folder Selection
field, the application will throw a message and use the last
valid TCP path specified or the default path TCP:\\127.0.0.1\C
\Source. 127.0.0.1 represents the loopback IP address of the
local host (i.e. the machine on which PeerSync is running).

The provided Host Name and User Name & Password values
are displayed above the Source Folder Selection field.

= Related Options
Source TCP/Port Configuration
Source Folder Configuration Button
Select Source Folder Button
Explore/Open/Create Button
Source Folder Popup Menu
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Notes:

1. The TCP features listed on this page require the TCP_ WAN Connector option. Please visit http:// www.peersoft-
ware.com or contact Sales for additional information.

2. You cannot monitor a TCP source in Real-Time.

3. NetApp CIFS realtime support requires the NetApp option. Please visit hitp:// www.peersoftware.com or con-
tact Sales for additional information.

4. NFS realtime support requires an NFS and NetApp enabled license. Please visit http:// www.peersoftware.com
or contact Sales for additional information.

5. Bidirectional synchronization mode, as well as other non applicable features are ignored when using a TCP
Source.

6. Selecting a TCP Source and a TCP Target for the same Job is not supported.

7. Generally perfformance will be optimal when PeerSync is installed on one of the machines involved in the syn-
chronization process (Source or Target).

We strongly recommend the use of a VPN when transferring files over the public
Internet for security purposes. Otherwise you should use our Encryption feature
with a user name and password to protect the data and all communicaiton as it is
being transferred.

This option requires our PSListener tool to be installed on the remote computer
with identical Encryption and Port configuration.

Source TCP/Port Configuration

The Source Folder Configure Button is activated by clicking on the Configure button located
in right lower corner of the Source Folder panel/section. Selecting the Configure button opens
the Source TCP/Port Configuration window. Alternatively, you may right-click on the Source

Folderfield and select Configure: Source Folder (See Source Folder Popup Menu).

TCP Configuration Tab

General Settings

Host Name Enter the IP address or machine name of the Source Folder
into this filed. You may use the machine name only if the remote
Source Machine resides on the same network as that on which
PeerSync is running.

Path on Host Provide the full path (i.e. C:\Documents and Settings\Source) to
the Source folder in this field. The path entered needs to be a
local path without a machine name or UNC format. This field
does not validate the existence of the path you provide there-
fore you must exercise great care when doing so. If the path
does not exist, PeerSync will create it during run time as long
as a valid host name or IP address has been provided and it
can find the drive letter specified.

A UNC path can be entered for the Path on Host selection for
aTCP source or TCP target. This gives the ability to con-
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figure non-windows to non-windows Jobs over TCP (i.e.
NetApp to NetApp over TCP). Note: This will make use of
a new NETWORK constantin the source ortarget selection.

Example:

TCP: \\ W ndows Ser ver \ NETWORK\ \ Net AppSVM
\vol 1\ Dat a

Care must be exercised if your PSListener contains a "Root
Path". If you specify such a path in your PSListener it will be-
have like an FTP server that sets Root Paths to limit user ac-
cess to the local file system. If a "Root Path" exists on the
PSListener it will limit PeerSync's ability to access directories
on the remote device. PeerSync will only be able to access dir-
ectories equal to or bellow the specified "Root Path" level
provided thatit meets the Port and Encryption requirements.
In no circumstances can PeerSync access directories located
above this path. If the remote path you enterin the Path to Host
field references a directory above the "Root Path", PeerSync
will create that folder structure at runtime bellow the "Root
Path".

Example:

PSListener "Root Path" = C:\Backup\Users\Admin
PeerSync's "Path to Host" = C:\Backup\My Documents
Actual Remote Source Path =  C:\Backup\Users\Admin\C

\Backup\My Documents

Note: The "Root Path" will be ignored when performing byte-level replication
using Normal Mode (i.e. Local or UNC paths).

Port Configuration Tab

Port Configuration

Time Out Sets the amount of time a connection will wait to complete a
data transfer before exiting and performing the failure opera-
tion.

Port This is the TCP Port used to communicate with the Listener on

the remote machine. This must match the port number that the
PSListeneris configured for. By default both Listener and Peer-
Sync use port 7333.

Note: The Profiler will not support Well Known Port numbers 0 - 1023. You
must use port numbers that are greater than or equal to 1024.

Compression

Uses a lossless compression algorithm to transmit data in
fewer bits. By default Compression is disabled to achieve
faster performance.
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User Information (To be used for encryption)

This is an optional setting that allows you to specify a User Name and Password to be
used for encryption as well as authentication purposes when connecting to the remote
PSListener. In order to activate encryption or authentication, you must specify both a User
Name and a Password value. Strong DES encryption will be used to encrypt the data
and communication as itis being transmitted over the Internet, LAN, WAN, or VPN.

User Name The User Name can be arbitrarily chosen and is not tied to
Active Directory. However, once specified, you must enter the
same User Name entry in the PSListener Configuration resid-
ing on the remote location.

If you specify a User Name without a Password, the User
Name entry will be ignored and no encryption or authentication
with the PSListener will occur.

Password The Password can be arbitrarily chosen. Once specified, you
must enter the same Password in the PSListener Configuration
residing on the remote location.

Notes:

1. The TCP features listed on this page require the TCP WAN Connector option. Please visit http:// www.peersoft-
ware.com or contact Sales for additional information.

2. You cannot monitor a TCP source in Real-Time.

3. Bidirectional synchronization mode as well as other non applicable features are ignored when using a TCP
Source.

4. Selecting a TCP Source and a TCP Target for the same Job is not supported.

5. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the syn-
chronization process (Source or Target).

Source Folder Configuration: Using Normal Mode

The Source folder configure button is activated by clicking on the Configure button located
in right lower corner of the Source Folder panel/section. Selecting the Configure button opens
the Source Folder Configuration window. Alternatively, you may right-click on the Source
Folder field and select Configure: Source Folder (See Source Folder Popup Menu).

- Related Options
Detection Method - Global
Connection Manager - Global
Network Logon Settings
NetApp FPolicy
NetApp FPolicy cDOT
CIFS/NFS

FPolicy Utilities
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lowing options:

Detection Method for Real-time Monitoring

Choose the desired detection method for the Source folder. You may choose from the fol-

Default

Select this option to specify a local or remote drive which
resides on the network (LAN, WAN, or VPN). This is the recom-
mended detection method for most scenarios. Close the
Source Folder Configuration dialog once you have selec-
ted your desired source folder detection mode and enter the
path to the source folder in the Folder Selection screen (i.e.
D:\Path\Folder).

Note: PeerSync must reside on the source system in order to enable Normmal
real-time detection.

NetApp FPolicy 7-
Mode

Select this option to specify the path to a 7-Mode NetApp filer
for either real-time or scanning scenarios. Close the Source
Folder Configuration dialog once you have selected your
desired source folder detection mode and enter the path to the
source folder in the Folder Selection screen (i.e. \\NetAp-
pFilenShare\Folder).

Note: This option can only be activated if the license supports NetApp detec-
tion. Please visit http:// www.peersoftware.com or contact Sales for additional
information.

NetApp FPolicy cDOT

Selectthis option to specify the pathto a cDOT NetApp filer for
either real-time or scanning scenarios. Close the Source
Folder Configuration dialog once you have selected your
desired source folder detection mode and enter the path to the
source folder in the Folder Selection screen (i.e. \\NetAp-
pFilenShare\Folder).

Note: This option can only be activated if the license supports NetApp detec-
tion. Please visit http:// www.peersoftware.com or contact Sales for additional
information.

EMC CEE Celerra/
VNX

Sales for additional information.

Select this option to specify the path to a EMC CEE Celerra/
VNX filer for either real-time or scanning scenarios. Close the
Source Folder Configuration dialog once you have selec-
ted your desired source folder detection mode and enter the
path to the source folderinthe Folder Selection screen (i.e. \
\CEEVNX1\Share\Folder).

Note: This option can only be activated if the license supports EMC CEE Cel-
ema/ VNX detection. Please visit http:// www.peersoftware.com or contact

EMC CEE Isilon

Selectthis option to specify the path to a EMC CEE Isilon filer
for either real-time or scanning scenarios. Close the Source
Folder Configuration dialog once you have selected your
desired source folder detection mode and enter the path to the
source folderinthe Folder Selection screen (i.e. \CEEVNX1
\Share\Folder).
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Note: This option can only be activated if the license supports EMC CEE Isilon
detection. Please visit http:/ / www.peersoftware.com or contact Sales for addi-
tional information.

NetApp FPolicy Screening Options

Enable CIFS Screen- [ CIFS Screening is enabled by default when clicking the "Set

ing CIFS Defaults" button in the CIFS/NFS tab.
Enable NFSv3 NFSv3is the only NetApp FPolicy Screening option supported
Screening when working with NFS.. This must be set when utilizing NFS

detection and is automatically selected when the "Set NFS De-
faults" button is clicked in the CIES/NFS tab.

Enable NFSv4 NFSv4 screening is presently not supported.
Screening

Detection Method Options

Exclude Users When selecting NetApp FPolicy 7-Mode or NetApp
FPolicy cDOT as the source detection mode, you have the
option to filter/exclude real-time activity from a list of specific
users. Real-time events from the users in this field will be ex-
cluded. Enter the desired user names in a semi collon delim-
ited format (i.e. userl;user2;user3).

Allow for remote real- | This optionindicates whether or not the selected source folder
time configuration detection method supports real-time detection for remote
paths. Presently, this feature is only supported for NetApp
FPolicy Mode orNetapp FPolicy cDOT detection modes.

Notes:

1. NetApp CIFS real-time support requires the NetApp option. Please visit http:// www.peersoftware.com or con-
tact Sales for additional information.

2. NFS realtime support requires an NFS and NetApp enabled license. Please visit http:// www.peersoftware.com
or contact Sales for additional information.

3. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the syn-
chronization process (Source or Target).

The Connection Manager tracks and determines if connections are lost to source and/or
targetfolders. With this new capability PeerSync can proactively detect when a connection is
lostorreconnected, giving the ability to restartreal-time and/or scan Jobs ifneeded.

Automatically use recommended settings based on Detection Method

Check this option if you wish to let the Connection Manger track the connection status on
both the source and targetlocations. When a lost connection is restored, PeerSync will restart
real-time and/or scan Jobs ifthe option to "Scan Job once atstart" is enabled. In addition, this
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logic will apply to only connections which are setfor real-time monitoring.

Connection Manager for Failed Connections
Choose one of the following options to manually disable or enable the Connec-
tion Manger which tracks the connection status on the desired locations.

Disabled

Disable the Connection Manager

Enabled for Source
Connections Only

Enable the Connection Manger to track the connection
status only on the source location.

Enabled for Target
Connections Only

Enable the Connection Manger to track the connection status
only on the targetlocation.

Enabled for Source
and Target Connec-
tions

Enable the Connection Manger to track the connection
status on both the source and targetlocations.

Connection Manager Options

Only include connec-
tions that are set for
real-time monitoring

Set the Connection Manager to monitor only connections
thatare setforreal-time detection.

Scan real-time Jobs
onreconnectif "Scan
Job once at start" is
enabled

Setthe Connection Manager to scan real-time Jobs on re-
connectifthe Scan Job once atstartoptionis enabled.

Notes:

1. NetApp CIFS real-time support requires the NetApp option. Please visit http:// www.peersoftware.com or con-
tact Sales for additional information.

2. NFS realtime support requires an NFS and NetApp enabled license. Please visit hitp:// www.peersoftware.com
or contact Sales for additional information.

3. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the syn-
chronization process (Source or Target).

Network Logon Settings

Provides the ability to connect to a source folder that may require a different account then
the on PeerSync is running under.

Connect As Provide the user name to allow PeerSync connection to the
source directory thatis notaccessible using the current service
or logged on account. Be sure to include the domain name if
applicable (i.e. MyDomain\UserName).

Password Enter the password information for login.
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System Information for Source Host

Get Info Click this button to display a short description about the source
host PeerSync is connecting to.

Edit or maintain default NetApp settings when selecting NetApp FPolicy cDOT as the detec-
tion method. These options are only applicable when using the NetApp FPolicy 7-Mode or
NetApp FPolicy cDOT detection method.

Automatically detect and use recommended NetApp configuration
When using the NetApp FPolicy 7-Mode or NetApp FPolicy cDOT detection method,

checking this option will automatically populate the required NetApp settings with the defaults.
Uncheck this option if you wish to manually edit these settings.

NetApp Settings

Host Server Name Editthe hostname or IP address ofthe NetApp filer.
Root Path Prefix Editthe local path of the NetApp share you wish to monitor.
FPolicy Name Editthe FPolicy name that is used to register for event notifica-

ton on the filerr By default PeerSync uses
PEERSYNC_COMPUTERNAME, where COMPUTERNAME is
the name ofthe host where PeerSync is running. PeerSync will
create the FPolicy name atthe startofthe Job.

FPolicy Options - Global

Use cDOT Detection | Check this option when using NetApp FPolicy cDOT detec-

tion method.
Use Asynchronous If enabled, PeerSync will not wait for a response from the
Mode FPolicy server, which enhances overall performance. To en-

able Asynchronous Mode via the command line argument
use /Q74Y. This option is enabled by default for both NetApp
detection methods (7Mode and cDOT) and cannot be disable
when using cDOT detection mode.

Disable FPolicy on By default PeerSync will disable the FPolicy name itused to re-
Close gister for event notification when the Job is stopped. Disable
this option if you do not want PeerSync to delete the FPolicy
name when the Job is stopped.

NetApp FPolicy Additional Settings - Global

Exclude Volumes Provides the ability to exclude entire volumes from scans
and real-time detection, which enhances overall perform-
ance. Enter a list of comma (,) delimited volumes to ex-
clude when using NetApp FPolicy detection during scans
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orin real-time. Here is an example of excluding volumes
vol3 and vol4: vol3,vol4. To exclude volumes via the com-
mand line use /Q7-s, where s represents the comma (,)
delimited list of volumes to exclude (i.e./Q7-vol3,vol4).

Include Volumes

Provide a list of comma (,) delimited volumes to include when
using NetApp FPolicy detection during scans or in real-time.
This field is visible only if the “Exclude Volumes” check box is
un-checked. Here is an example of including volumes voll
and vol2: vol1,vol2. To include volumes via the command line
use /Q7+s, where s represents the comma (,) delimited list of
volumes to include (i.e./Q7+vol1,vol2).

Exclude Extensions

Provide a list of comma (,) delimited file extensions to exclude
when using NetApp FPolicy detection during scans or in real-
time. To exclude extensions via the command line use /Q70:s,
where s represents the comma (,) delimited list of extensions to
exclude (i.e. /Q70:tmp,dwl,dwl2). Use % AUTO% for PeerSync
to build a list of file extensions dynamically. To use the %AUTO
% option via the command line use /Q70. This is the equivalent
of using the /QR argument for FPolicy only

Exclude IP addresses

Provide a list of comma (,) delimited IP addresses to exclude
when using NetApp FPolicy detection during scans or in real-
time.

Notes:

1. NetApp CIFS real-time support requires the NetApp option. Please visit http:// www.peersoftware.com or con-
tact Sales for additional information.

2. NFS realtime support requires an NFS and NetApp enabled license. Please visit http:// www.peersoftware.com
or contact Sales for additional information.

3. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the syn-
chronization process (Source or Target).

NetApp FPolicy cDOT SVM Logon Settings

Username Provide the user name for the account that will be used to run
the APl calls againstthe vServer.
Password Provide the password for the account that will be used to run

the APl calls againstthe vServer.

NetApp FPolicy cDOT Additional Settings

Management IP

Optionally, specify the IP address for the system where the
Managementnode is on a separate IP from the IP used to ac-
cess the shares.

Include Shares

Provide a list of alternate shares to register for. Alternate
shares are automatically discovered and registered by default.
This can be disabled by unchecking the Disable Alternate
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Share Lookup option. For example, use this in cases where
the alternate share points to the rootlevel and should not be in-
cluded.

Primary Server This is an optional list of semi colon (;) delimited IP addresses
of the system(s) where the FPolicy server is running (i.e. the
system where PeerSync is running). Events generated on the
SVM from this IP will be automatically filkered unless the "Dis-
able IP Filtering" option is used. Therefore itis importantto note
thatin order for real-time detection to work, all changes must be
made from different systems and not the system where Peer-
Sync is running.

cDOT Options - Global

Asynchronous Mode Enabled by default, PeerSync will not wait for a response from
the FPolicy server, which enhances overall performance. Cur-
rently, this setting mustalways be enabled.

Disable Alternate Alternate shares are automatically discovered and registered
Share Lookup for by default. This can be disabled by unchecking the Dis-
able Alternate Share Lookup option. For example, use
this in cases where the alternate share points to the root level
and should notbe included.

System Information for Source Host

Get Info Click this button to display a short description about the source
hostPeerSync is connecting to. This also checks if the creden-
tials provided gain access to the SVM.

Notes:

1. NetApp CIFS real-time support requires the NetApp option. Please visit http:// www.peersoftware.com or con-
tact Sales for additional information.

2. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the syn-
chronization process (Source or Target).

Job Scan Method - Global

CIFS - Default This scan method should be selected when using Normal or
NetApp 7Mode or cDOT detection and is selected automatically
when clicking on the "Set CIFS Defaults" button at the bottom.

NFS - Unix/Linux This scan method utilizes the Unix/Linux rsync algorithm to
rsync command scan folders and files. It should be selected when using NFS de-
tection and is selected automatically when clicking on the "Set
NFS Defaults" button at the bottom.
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Copy File Method - Global

CIFS - Default

This copy method should be selected when using Normal or
NetApp 7Mode or cDOT detection. This option is selected auto-
matically when clicking on the "Set CIFS Defaults" button at the
bottom.

NFS - Unix/Linux
rsync command

This copy method utilizes the Unix/Linux rsync algorithm to
sync and transfer files. It should be selected when using NFS
detection and is selected automatically when clicking on the
"Set NFS Defaults” button at the bottom.

NFS - Unix/Linux cp
command

This copy method utilizes the Unix/Linux cp command to sync
and transfer files. It provides an alternative sync/transfer method
to rsync for NFS detection.

CIFS - CopyFile API

This copy method uses a basic file transfer API call (CopyFile)

- /|GFC Argument that provides no progress and therefore may be faster.
CIFS - CopyFileEx API | This copy method uses an advanced copy method via the
- /|GFE Argument CopyFileEx API call that provides feedback.

CIFS - File Stream
Method - /GFS Argu-
ment

This copy method uses an alternate file stream method to trans-
fer the files.

Permissions (Security style) - Global

CIFS - Default (NTFS)

This security style should be selected when using Normal or
NetApp 7Mode or cDOT detection. This option is selected auto-
matically when clicking on the "Set CIFS Defaults" button at the
bottom.

NFS - Unix/Linux down
and chmod com-
mands (UNIX)

This security style should be selected when using NFS detec-
tion. This option is selected automatically when clicking on the
"Set NFS Defaults” button at the bottom.

Enable NFS Extended
Reporting and Dis-
play

Check this option to enable extended reporting and display in-
formation for permssions when working with NFS detection.

Set CIFS Defaults

Click this button to automatically set the global scan, copy, and
permission settings to use the CIFS protocol. This protocol is
used for Normal or NetApp 7Mode or cDOT real-time monitor-

ing.

Set NFS Defaults

Click this button to automatically set the global scan, copy, and
permission settings to use with NFS.

Notes:

1.

NetApp CIFS realtime support

requires the NetApp option. Please visit hitp:// www.peersoftware.com or con-
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tact Sales for additional information.

2. NFS realtime support requires an NFS and NetApp enabled license. Please visit hitp:// www.peersoftware.com
or contact Sales for additional information.

3. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the syn-
chronization process (Source or Target).

FPolicy Utility Features

Delete 7-Mode Available when using NetApp FPolicy 7-Mode detec-
FPolicy tion. Click this button to delete all FPolicies that are in

an "idle" state and were created from the FPolicy sys-
tem where PeerSync is running.

Disable cDOT Available when using NetApp FPolicy cDOT detection
FPolicy mode. Click this button to disable any policies that
match the naming convention defined in the Profile.
The default policy naming convention is

PEERSYNC_FPOLICY - SERVER-NAME).

All Check this option to disable all cDOT policies that
Policies are in an "idle" state and were created from the
FPolicy system where PeerSync is running.

Regard- Check this option to disable cDOT policies created
less of regardless of their state.
state

Notes:

1. NetApp CIFS realtime support requires the NetApp option. Please visit http:// www.peersoftware.com or con-
tact Sales for additional information.

2. NFS realtime support requires an NFS and NetApp enabled license. Please visit http:// www.peersoftware.com
or contact Sales for additional information.

3. Generally performance will be optimal when PeerSync is installed on one of the machines involved in the syn-
chronization process (Source or Target).

Located to the right of the Source Folder Selection Field, this button opens a "Browse for
Folder" dialog box. Once this box has opened, locate your chosen Source folder, select it us-
ing the leftmouse button, and click "OK."

Note: This button is not available when selecting TCP Source or Target.

Explore/Open/Create Source Button

This button provides three options to be selected from the attached drop-down list. The but-
ton label will change to reflect whichever item has been checked on this list.

Explore When "Explore" has been selected and the button is de-
pressed, an Explorertype window will open displaying all
available directories. By default, this window will show the
folder whose pathis currently designated in the Source Field. If
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the folder shown in this field does not exist, Profiler will display
a dialog alerting you to this fact and asking if you would like to
create it. Youmay do so by clicking the "Yes" button located at
the bottom of this dialog. Once you have done so the newly
created folder will be shown in the Explorer-type window.

Open

When "Open" has been selected and the button is depressed,
a traditional MS navigation window is opened displaying the
contents of whichever folder is currently shown in the Source
Folder Field. If this folder does not exist, Profiler will display a
dialog alerting you to this fact and asking if you would like to
create it. Youmay do so by clicking the "Yes" button located at
the bottom of this dialog. Once you have done so the newly
created Folder will be shown in the navigation window.

Create

When "Create" has been selected and the button is de-
pressed, a "Select Directory" dialog will open allowing you to
specify a Source Folder path by using the mouse to select a
desired drive, directory, and folder. Folder paths can also be
manually entered into the "Directory Name" field. If you enter a
path for a folder that does not exist and hit the ENTER key or
click "OK," a dialog box will appear allowing you to create this
folder.

Note: This button is not available when selecting TCP for Source or Target.

Source Folder Popup Menu: Using Normal Mode

The Source Folder PopUp Menu is activated by right clicking on the Source Folder field.
The first four features allow the user to Browse for Source Folder, Explore, Open and/or
Create the Source Folder selection.

Configure: Source
Folder

Selecting this option displays the Source Network Logon Set-
tings window. T his allows the user to specify Network Logon
credentials for the Source Folder which enables connection to
directories that are notaccessible with the currentlogged on
account.

Edit: Source Variable
File

This will allow the userto view/edit Variable Data Import and/
orJob Data Impottfiles thatare used in the Source Folder se-
lection. This optionis only available ifusing Job data import
files.

Create Auto Job
Name

This feature allows a simple way to generate meaningful Job
names. When selecting this item, Job names are automatically
generated based on their Source and Target paths which
make ita simple task to organize the Job list.

Source Folder Popup Menu: Using TCP Mode

The Source Folder PopUp Menu is activated by right clicking on the Source Folder field.
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The firsttwo features allow the userto Explore and Open the Source Folder selection.

Configure: Source Selecting this option displays the Source TCP/Port Configura-
Folder tion window. This window provides a guided method for enter-
ing the Source TCP path as well as TCP and/or Byte Replic-

ator settings (see TCP Configuration).

Create Auto Job This feature allows a simple way to generate meaningful Job
Name names. When selecting this item, Job names are automatically
generated based on their Source and Target paths which
make ita simple task to organize the Job list.

Notes:

1. The TCP features listed above require the TCP_WAN Connector option. Please visit http:// www.peersoft-
ware.com or contact Sales for additional information.

2. The Browse for Source Folder and Create options are not available when using TCP Source Mode.

Target Folder Selection

The options listed on this page can be accessed from the Eolder Selection window. The
following options are available for selecting a Targetfolder.

Using Normal Mode Select a "Normal" Target folder if you can navigate to the de-
sired Target directory via a Local Path, a UNC Path, or a
Mapped Drive. This selection requires that the machine on
which PeerSync is running has full access to the desired Tar-
get directory. In some instances Network Logon may be re-
quired.

Select a Target Folder by typing the file path into the field
provided or by using the Select Target Folder Bution. By de-
fault, the TargetFolder field will contain the path in which Peer-
Sync has been installed: in most cases this will be C:\Program
Files\PeerSync\Target. The convention outlined in this path
must be used when manually typing entries, (i.e. a drive must
be specified followed by a colon, with subsequent folders sep-
arated by backslashes). This field is not case sensitive, though
spaces may only be entered where they are part of valid folder
names (i.e. "Program Files"). No space should appear
between slashes and folder names. This field also supports
File/Folder Path Variables.

UNC names can be entered manually, or can be selected from
the Network Neighborhood using the "Browse for Folder" dia-
log box (see Select Target Folder Button). UNC names will ap-
pear in the form \COMPUTER\SHAREDDEVICE\PATH. For
example:\SERVER11\D\USERDATA

Note: We do not recommend using UNC paths for folders that
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reside on the local machine, in this scenario you should use the
local path to thatfolder.

Folders canalso be dragged and dropped from MS Windows
Explorerinto the Target Folder Field for automatic insertion.

The Target Folder Field holds a folder selection History of
more then 10 entries. They can be selected by clicking on the
drop down button located to the right of the field.

The current path will be displayed bellow the Target Folder
Selection Filed. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to cor-
rect the invalid path and you exit the Target Folder Selection
field, the application will throw a message and use the default
PeerSync installation path C:\Program Files\PeerSync\Target
instead.

The Host Name and User Name & Password values (if
provided) are displayed above the Target Folder Selection

field (see Network Logon).

Using TCP Mode Selecta "TCP" Target folder if the Target directory is outside
the scope of the machine on which PeerSync is running. TCP
enables access to machines not located on the same network
as PeerSync. As a prerequisite, the PSListener needs to be in-
stalled and running on the remote Target machine in order for
PeerSync to be able to communicate with it. This feature sup-

ports encryption and compression.

Note: We strongly recommend the use of a VPN when transfening files over
the public Intemet for security purposes. Otherwise, you should use our En-
cryption feature with a user name and password to protect data and all commu-
nication as it is being transferred.

When selecting the TCP Mode for the firsttime the Target TCP/
Port Configuration window will open automatically for Target
Folder configuration. Otherwise, the previously entered TCP
folder path will be displayed. This path can be manually edited
by typing directly into the field provided or by using the Config-
uration button. The convention outlined in this path must be
used when manually typing entries, (i.e. the key word TCP must
be specified followed by a colon, two backslashes, the Target
IP address or machine name, and subsequent folders separ-
ated by backslashes). This field is not case sensitive, though
spaces may only be entered where they are partof valid folder
names (i.e. "Program Files"). No space should appear
between slashes and folder names. This field also supports
File/Folder Path Variables.

The Target Folder Field holds a folder selection History of
more then 10 entries. They can be accessed by clicking on the
drop down button located to the right of the field.
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The current path will be displayed bellow the Target Folder
Selection Filed. An invalid path will display a red INVALID
SELECTION label instead. If there are no efforts made to cor-
rect the invalid path and you exit the Target Folder Selection
field, the application will throw a message and use the last
valid TCP path specified or the default path TCP:\\127.0.0.1\C
\Target. 127.0.0.1 represents the loopback IP address of the
local host (i.e. the machine on which PeerSync is running).

The provided HostName and User Name & Password values
are displayed above the Target Folder Selection field (see

Configuration Button).

= Related Options

Target Folder Configuration Button
Select Target Folder Button
Explore/Open/Create Button
TargetFolder Popup Menu
Alternate Target Path Selection

Notes:

1. TCP (i.e.TCP WAN Connector Option) is optional modes which may not be included in your package. Please
visit http:// www.peersoftware.com or contact Sales for additional information.

2. Bidirectional synchronization mode as well as other non applicable features are ignored when using a TCP Tar-

get.

3. Selecting a TCP Source and a TCP Target for the same Job is not supported.

4. Generally perfformance will be optimal when PeerSync is installed on one of the machines involved in the syn-
chronization process (Source or Target).

Using Normal Mode

The TargetFolder Configuration Button can be activated by clicking on the Configure button
located inrightlower cornerofthe Target Folder panel/section. Selecting the Configure but-
ton opens the Target Network Logon Settings window. Alternatively, you may right-click on
the TargetFolderfield and select Configure: TargetFolder (See Target Folder Popup Menu).
This window allows for network logon Name and Password information for a remote Target

connection.

Using TCP Mode

The TargetFolder Configuration Button can be activated by clicking on the Configure button
located inrightlower corner ofthe Target Folder panel/section. Selecting the Configure but-
ton opens the Target TCP/Port Configuration window. Alternatively, you may right-click on the

TargetFolderfield and select Configure: TargetFolder (See Target Folder Popup Menu).

TCP Configuration Tab
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This window provides a guided method for entering the Target TCP path.

Host Name

Enter the IP address or machine name of the Target folder into
this filed. You may use the machine name only if the remote
Target machine resides on the same network as that on which
PeerSync is running.

Path to Host

Provide the full path (i.e. C:\Documents and Settings\Target) to
the Target folder in this field. The path entered needs to be a
local path without a machine name or UNC format. This field
does not validate the existence of the path you provide there-
fore you must exercise great care when doing so. If the path
does exist, PeerSync will create it during run time as long as a
valid host name or IP address has been provided and it can
find the drive letter specified.

A UNC path can be entered for the Path on Host selection for
aTCP source or TCP target. This gives the ability to con-
figure non-windows to non-windows Jobs over TCP (i.e.
NetApp to NetApp over TCP). Note: This will make use of
a new NETWORK constantin the source ortarget selection.

Example:

TCP: \\ W ndows Ser ver \ NETWORK\ \ Net AppSVM
\vol 1\ Dat a

Care must be exercised if your PSListener contains a "Root
Path". If you specify such a path in your PSListener it will be-
have like an FTP server that sets Root Paths to limit user ac-
cess to the local file system. If a "Root Path" exists on the
PSListener it will limit PeerSync's ability to access directories
on the remote device. PeerSync will only be able to access dir-
ectories equal to or bellow the specified "Root Path" level
provided thatit meets the Port and Encryption requirements. In
no circumstances can PeerSync access directories located
above this path. If the remote path you enterin the Path to Host
field references a directory above the "Root Path", PeerSync
will create that folder structure at runtime bellow the "Root
Path".

Example:

PSListener "Root Path" = C:\Backup\Users\Admin
PeerSync's "Path to Host" = C:\Backup\My Documents
Actual Remote Target Path =  C:\Backup\Users\Admin\C

\Backup\My Documents

Note: The "Root Path" will be ignored when performing byte-evel replication
using Nomal Mode (i.e. Local or UNC paths).

Port Configuration Tab
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Provides settings to be used by both the Source and Target connections when using TCP
and/or Byte Replicator.

Time Out Sets the amount of time a connection will wait to complete a
data transfer before exiting and performing the failure opera-
tion.

Port This is the TCP Port used to communicate with the Listener on

the remote machine. This must match the port number that the
PSListeneris configured for. By defaultboth Listener and Peer-
Sync use port 7333.

Note: The Profiler will not support Well Known Port numbers 0 - 1023. You
must use port numbers that are greater than or equal to 1024.

Compression Uses a lossless compression algorithm to transmit data in
fewer bits. By default Compression is disabled to achieve
faster performance.

User Information This is an optional setting that allows you to specify a User

Name and Password to be used for encryption as well as au-
thentication purposes when connecting to the remote
PSListener. In order to activate encryption or authentication,
you mustspecify botha User Name and a Password value.
Strong DES encryption will be used to encrypt the data and
communication as itis being transmitted over the Internet, LAN,
WAN, or VPN.

The User Name and Password entries can be arbitrarily
chosen and are not required to be valid. However, once spe-
cified, you must enter the same User Name and Password
entries in the PSListener Configuration residing on the remote
location.

If you specify a User Name without a Password, the User
Name entry will be ignored and no encryption or authentication
with the PSListener will occur.

Notes:

1. The TCP features listed on this page require the TCP_ WAN Connector option. Please visit http:// www.peersoft-
ware.com or contact Sales for additional information.

Located to the right of the Target Folder Selection Field, this button opens a "Browse for
Folder" dialog box: once this box has opened, locate your chosen Target folder, select it us-
ing the leftmouse button, and click "OK."

Note: This button is not available when selecting TCP for Source or Target.

Explore/Open/Create Target Button

This button provides three options to be selected from the attached drop-down list. The but-
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ton label will change to reflect whichever item has been checked on this list.

Explore

When "Explore" has been selected and the button is de-
pressed, an Explorertype window will open displaying all
available directories. By default, this window will show the
folder whose path is currently designated in the Target field. If
the folder shown in this field does not exist, Profiler will display
a dialog alerting you to this fact and asking if you would like to
create it. you can do so by clicking the "Yes" button located at
the bottom of this dialog. Once you have done so the newly
created Folder will be shown in the Explorer-type tree.

Open

When "Open" has been selected and the button is depressed,
a traditional MS navigation window is opened displaying the
contents of whichever folder is currently shown in the Target
Folder Field. If this folder does not exist, Profiler will display a
dialog alerting you to this fact and asking if you would like to
create it you can do so by clicking "Yes" button located at the
bottom of this dialog. Once you have done so the newly cre-
ated Folder will be shown in the navigation window.

Create

When "Create" has been selected and the button is de-
pressed, a "Select Directory" dialog will open allowing you to
specify a Target Folder path by using the mouse to select a
desired drive, directory, and folder (See image in "Source
Folder Selection" topic above). Folder paths can also be
manually entered into the "Directory Name" field. If you enter a
path for a folder that does not exist and hit the ENTER key or
click "OK," a dialog box will appear allowing you to create this
folder.

Note: This button is not available when selecting TCP for Source or Target.

Target Folder Popup Menu: Using Normal Mode

The Target Folder PopUp Menu is activated by right clicking on the Target Folder field.
The first four features allow the user to Browse for Target Folder, Explore, Open and/or
Create the TargetFolder selection.

Configure: Target
Folder

Selecting this option displays the Target Network Logon Set-
tings window. This allows the user to specify Network Logon
credentials for the Target Folder which enables connection to
directories that are not accessible with the current logged on
account.

Edit: Target Variable
File

This will allow the user to view/edit Variable Data Import and/
or Job Data Importt files that are used in the Target Folder se-
lection. This option is only available if using Job data import
files.

Create Auto Job
Name

This feature allows a simple way to generate meaningful Job
names. When selecting this item, Job names are automatically
generated based on their Source and Target paths which
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make ita simple task to organize the Job list.

Set Alternate/Addi- Selecting this menu item will open the Alternate/Additional Tar-
tional Targets gets selection window. This feature allows for alternate or addi-
tional Target paths associated with the base Job.

Force Source Folder [ Appends the Source folderdirectory to the Targetfolder path.
Rootas Target Folder
Root

Target Folder Popup Menu: Using TCP Mode

The Target Folder PopUp Menu is activated by right clicking on the Target Folder field.
The firsttwo features allow the userto Explore and Open the Target Folder selection.

Configure: Target Selecting this option displays the Target TCP/Port Configura-
Folder tion window. This window provides a guided method for enter-
ing the Target TCP path as well as TCP and/or Byte Replicator

settings (see TCP Configuration).

Create Auto Job This feature allows a simple way to generate meaningful Job
Name names. When selecting this item, Job names are automatically
generated based on their Source and Target paths which
make ita simple task to organize the Job list.

Force Source Folder | Appends the Source folderdirectory to the Targetfolder path.
Root as Target Folder
Root

1. The TCP features listed above require the TCP_WAN Connector option. Please visit http:// www.peersoft-
ware.com or contact Sales for additional information.

2. The Browse for Target Folder and Create options are not available when using TCP Target Mode.

Notes:

1. The TCP features listed on this page require the TCP WAN Connector option. Please visit http:// www.peersoft-
ware.com or contact Sales for additional information.

2. The Browse, Explore, Create, and Set Altemate/ Additional Target options are not available when using TCP.

This link will be enabled if you are using a Normal Target Mode Selection. By selecting this
link you can set and access your current Alternate Target Path Selections. Through this fea-
ture, Jobs can now have alternate or additional Target paths associated with the base Job.
This allows for the ability to redirect data on a failed connection to the base Target and/or
easily setup, one-to-many scenarios for distribution purposes. Selecting this menu item will
open the Alternate Target Path Selection dialog.

To add an alternate or additional Targetclick "New," then type the desired path into the field
located atthe bottom of the dialog or selectthe "Browse" button to select a path.. Repeat this
process foreach Targetpath you wish to add. Entries can be deleted by selecting them from
the listand clicking the "Delete" key atthe bottom of the box. You can also use the "Up" and
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"Down" buttons to reorder the paths.

Notes:
1. This feature requires the Enhanced Package.
2. Altemate Target Path Selection is not available for TCP.

3. When using Altemate Target Path Selections you cannot use variables that are specific to the Job (i.e. %
JobName%, %SourcePath%, etc.) for the Move unmatched Target Files option.

If this check box is selected, all sub-folders contained within the Source Folder will be syn-
chronized to the Target.

This button reverses placement of the file paths shown in the Source and Target Folder
Fields (so that what was formerly a Source Folder now becomes a Target Folder, and vice
versa).

Represents the date/time the last scan started for the selected Job. This is the date/time of
the last bi-directional synchronization scan of a Job that will be used when comparing files
during the Bi-directional Synchronization Mode option on the File Options screen. This feature
is also displayed and can be resetfrom the Profile Job List Pop-Up Menu.

Represents the date/time and user when the selected Job was lastsaved.

This section describes additional features related to the Folder Selection topic. The features
below apply to both the Source and Target folder selections and related configuration op-
tions.

= Related Options
File/Folder Path Variables
Variable Data Import
Job Data Import
Dvynamic Network Drive Mapping and Unmapping

Variable file/folder paths can be used to create:

Dynamic archives for yearly, monthly, weekly and/or daily backups

Dynamic synchronization based on date

Dynamic synchronization based on logged on user or machine name

Dynamic synchronization based on personal folders or other variables read in from the
registry

Log file storage, manipulation and organization

Administrative reportfile storage, manipulation and organization

7. Deleted file storage, manipulation and organization

PN~

o o

File/Folder Path Variables

Depending upon the argument used, these folders will be dated, named after the currently
logged user, named for the PC from which synchronization was launched, or based on a
pre-determined variable stored out and read in from the registry. The following variables
canbe used inany folder path Job setting available through the Profiler:
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Date %Date%
Time %Time%
Date/Time %DateTime %
Minute % Minute %
Hour %Hour%

Day %Day%

Year %Year%
Month/Year %MonthYear%
Minute (all formats) %n, nn%

Hour (all formats) %h, hh%

Day (all formats)

%d, dd, ddd, dddd, ddddd, dddddd%

Month (all formats)

%m, mm, mmm, mmmm, mmmm%

Year (all formats) %Y, yy%

Custom Peer Variables

Logged On User Name %UserName %
Computer Name %ComputerName %
Job Name %JobName %
Source Folder Path %SourcePath%
TargetFolder Path %TargetPath%

Deletion Folder Path

%DeletePath%

ReportFile Path

%ReportPath%

Windows Variables

Windows Directory

%WinDir%

Windows

%Windows% (also %SystemRo0t%)

System Temp Path

% Temp%

NT/00)

System Temp Path %Tmp%
System Drive Letter %SystemDrive %
System 32 (WIN 9x/ %System32%

Windows Variables from the "HKEY_CURRENT_USER\Software\Microsoft
\Windows\CurrentVersion\Explorer\Shell Folders" Registry

Desktop

%Desktop%

Favorites

%Favorites%
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Fonts %Fonts%
Personal %Personal%
Programs %Programs%
Recent %Recent%
SendTo %SendTo%
StartMenu %Start Menu%
Startup % Startup %
Templates %Templates%
Notes:

You can also use any variables that are located in the registry under HKEY_CURRENT_USER. For example:

HKEY_CURRENT_USER\ Environment (used by default default)
HKEY_CURRENT_USER\ Volatile Environment (used by default)

The HKEY_CURRENT_USERS locations can be modified in the PSDef.cfg file as follows:

[Misc Options]
RegVarStr=\ Environment;\ Volatile Environment;

In addition, the %USERPROFILE% Environmental Variable is now also supported.

Use the variable %Personal% to define the "My Documents" folder in Profiles that will be used on multiple operat-
ing systems such as XP and Windows 7. Since the location of the My Documents folder is different on these operat-
ing systems, using the %Personal% variable will dynamically resolve to the comect location on each system. This
simplifies configuration and keeps the Profile generic and deployable on multiple operating systems.

Note for PeerSync Jobs linked to PeerLock: PeerLock supports the usage of Windows System and Re-
gistry variables in the Source and Target fields (i.e. %UserName%, %ComputerName%). Custom PeerSync variables
such as %JobName% are curmrently not supported and will not work in PeerLock.

PeerSync now contains tools forimporting data from files. The ability to extract specific fields
of data from a file has been included to allow unlimited scalability. Within an organization, one
generic Profile can now be created, and utilizing text files, specific information about the user
and the desired folders to be synchronized can be imported dynamically. Variables can be
used to dynamically introduce data from a file into various fields throughout the interface in-
cluding file paths, deletion paths, log file paths, log file names, etc.

Field data is imported through:
<<#FileName.txt [section] item#>>
In which the [section] is a defined field in a file, such as the example file contentbelow.

[Info]
Name=Cris Smith
Home=c:\\mydocuments

Using <<#FileName.txt [Info] Name#>> will import "Cris Smith" into the path it was used in and
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using <<#FileName.txt[Info] Home#>> will import "c:\mydocuments" into the path it was used
in.

Note: This feature requires the Enhanced Package.

PeerSync now contains tools forimporting data from files to dynamically create Jobs. Within an or-
ganization, one generic Profile can now be created, and utilizing textfiles, specific information
aboutthe userand the desired folders to be synchronized can be imported dynamically. Lists can
be used in Source and Targetpath names as such:

Source: <<$FileNameSources.txt$>>
Target: <<$FileNameTargets.txt$>>

or:

Source: <<$C:\Path\T o\File\FileNameSources .txt$>>
Target: <<$C:\Path\T o\File\FileNameTargets.ixt$>>

Corresponding entries of each delimited file entry will be used to dynamically create a Job
based upon the Jobs properties.

Note: This feature requires the Enhanced Package.

PeerSync allows for the ability to dynamically map and un-map a Source or Target folder se-
lection. The way you do this is to add a letter to the beginning ofthe UNC path thatyou wish to
map the drive to. This can be done for the Source or Target selection (i.e. 'W\COMPUTER
\SHAREDDEVICE\PATH).

For Example: '\\DELLSERVER\D\USERDATA

The example above will map the D drive on the DELLSERVER to the N drive upon start of
PeerSync and will unmap the drive when PeerSync terminates. This is a quite useful feature
especially when running PeerSync as a service in the scenario where you want to synchron-
ize to a mapped drive. This feature will allow foritto occur seamlessly.

Note: Ifyou are going to run PeerSync as a Setrvice itis advised to use UNC paths or Peer-
Sync's Dynamic Network Drive Mapping and Unmapping feature instead of using mapped
drives due to the factthatmapped drives are notunderstood when a useris notlogged on.

Next/Last Available Drive Mapping

This feature allows for the dynamic mapping of the next (A) or last (B) available network drive
by using the following formatin the Source or Target Fields:

Map NextAvailable Example: ANCOMPUTER\SHAREDDEVICE\PATH
Map Last Available Example: BACOMPUTER\SHAREDDEVICE\PATH

Local Drive Mapping

This feature allows for the dynamic mapping of a local drive by using the following format in
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the Source or TargetFields:

Map Local to N Example: N\LOCALCOMPUTER\SHAREDDEVICE\PATH

1.1.3 Automation

Automation
Scanning Oplions
Scan Job once at start

[T]scan Job every (120

minute(s)

|:| Scan Job at | <Mo Selections =

[ ]use Enhanced Scanning

Real-time Event Detection Options

Lise real-time monitoring

=I Topics
Automation Overview
Automation Options

Real-ime Options. .. Global Settings

The Automation screen allows you to apply Real-Time Monitored or Scheduled synchroniza-
tion to individual Jobs within a given Profile. Real-Time operations (also referred to as "File/

Folder Change Detection'

") monitor Source Folders for any changes and synchronize them to

the specified Targetas they occur. Scheduled operations automatically launch synchroniza-
tion according to a user-specified schedule. Through these settings, PeerSync allows you to
build a Profile with as many as 255 different Jobs -- each run according to a unique schedule
orin Real-Time (Also see Command Line Arguments for Global Automation Settings).

Scanning Options

allows the userto setthe

The options listed on this page can be accessed from the Automation window. T his screen

frequency of scans as well as enable Real-Time replication.

Scan Job Once at
Start

This feature directs PeerSync to run the current Job as an Auto-
matic Operation. An Automatic Operation allows you to perform
animmediate launch of the current Profile. As a non-persistent
process, Automatic Operations are run a single time upon
manual initiation by the user. We also refer to this type ofrun as
an Initial Sync.

Scan Job every x
minute(s)

Checking this feature assigns a Scheduled operation to the se-
lected Job(s). The field associated with this feature allows you
to setaninterval in minutes: after this time has elapsed the se-
lected folders will be synchronized. 5 minutes is the default set-
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ting. Intervals in seconds can be specified through the use of
decimals, (i.e. 0.5, 2.5, etc.); the minimum interval is 0.01.

Scan Job at x

Checking this feature will allow for the synchronization of Jobs
at a specific times of the day for selected days of the week.
When selected the Daily Timer Options dialog will appear
with the following options:

Run selected Jobs at

Available from the "Daily Timer Options" dialog opened by
clicking on the button to the right of the "Scan Job at" field.
Selecting this feature will run the Job at the selected time of
day.

List of Job Selections

Available from the "Daily Timer Options" dialog opened by
clicking on the button to the right of the "Scan Job at" field. This
is a list of the currently selected Daily Timer selections. You
can Add New selections by selecting the New button and De-
lete existing selections by selecting the Delete button.

Select days of week to run

Available from the "Daily Timer Options" dialog opened by
clicking on the button to the right of the "Scan Job at" field. Al-
lows you to turn on/off which days to run this schedule.

Selection Options

Available from the "Daily Timer Options" dialog opened by
clicking on the button to the right of the "Scan Job at" field. This
feature will give you the option to run the selected daily timer
schedules in a Recurring mode (synchronization will run every
time according to the setscheduled options) or Run Once (syn-
chronization will run only once).

Use Enhanced Scan-
ning (Enhanced Scan-

ning)

The Enhanced Scanning option is required for this feature to be
enabled. Enhanced Scanning provides the ability to build mul-
tiple dynamic Jobs for parallel processing of folders during
scans. This will significantly improve the time PeerSync takes
to scan trough directories. By default PeerSync scans through
a Job sequentially, one folder at a time. With the Enhanced
Scan option enabled PeerSync will spawn a Job Thread for
each folder or subfolder encountered during a scan.

When the Use Enhanced Scanning checkbox on the Auto-
mation window is checked the Enhanced Scanning dialog
will open. By default the slider in the Enhanced Scanning dia-
log is set to the Off position all the way to the left side. To en-
able the Enhanced Scan feature move the slider to the right.
Eachslide position represents a depth level of 1,2, 3,4, and 5
respectively. Each value represents the depth level at which
PeerSync will spawn a Job thread for each folder itencounters.

Example:
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If you set the Enhanced Scanning slider to Level 3, then Peer-
Sync will spawn 7 dynamic Jobs for the Users directory depic-
ted bellow. It will in essence create a dynamic Job for each of
the folders at Level 3 (Folder1, Folder2, Folder3, and Folder4).
It will then create a Job for the folders at Level 2 (Users1 and
User2) but will exclude all their subfolers. Lastly, it will create a
Job for the directory atLevel 1 (Users) and exclude all the sub-
folders.
= ) Users
=l |} Userl
=l |} Folderi
) Falderd
= ) Folderz
) FolderE
= ) Userz
= ) Folders
) FolderC
= |} Folders
) FolderD

Notes:

1. The Enhanced Scanning and the Multi-Threading add-on options are re-
quired for this feature. Please visit http:// www.peersoftware.com or con-
tact Sales for additional information.

2. When using this option be sure you make available a large pull of Job
Threads to be used by PeerSync so that dynamic Jobs can be created for
each folder during a scan.

3. This feature is not supported when using the Enhanced Bi-directional op-
tion.

Real-Time Event Detection Options

The options listed on this page can be accessed from the Automation window. T his screen
allows the user to setthe frequency of scans as well as enable Real-Time replication.

Use Real-Time Monit-
oring

Selects the current Job(s) for Real-Time Monitoring.

Real-Time Options...

This button opens an "Additional Options" dialog box. Once
this box has opened, it allows you to choose from two Real-
Time operations. The firstis a Folder Replication feature, which
monitors for changes to the Source Folder and synchronizes
the Targetaccordingly. The second, a Folder Restoration fea-
ture, monitors for changes to the Target Folder and restores
files on the Targetaccordingly. To properly use the restore fea-
ture, you will need to select the "Always overwrite Target files"
option.

Notes:
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1. Bi-directional will be ignored for Real-Time Jobs.

Enhanced Real-Time Monitoring

This feature allows the Real-Time feature in PeerSync to de-
tect individual changes to files and synchronize only the file
which has changed without scanning the entire folder where the
change occurred. Normally, synchronization software scans
and compares all files into a folder which is being synchron-
ized. This feature does not scan folders unless the change is
indeterminate. If a file or folder is renamed, PeerSync will re-
name the corresponding Target File or folder using rename
functions as opposed to copying the newly renamed Source
Folder to the Target and then subsequently deleting the out-
dated Target file/folder. This feature greatly reduces the time
required to synchronize files and also reduces network band
width requirements.

With this option enabled PeerSync will continue to detect real-
time events even during a scan.

Notes:

1. Bi-directional, During comparison subtract/add x minute(s)

from Target, and Trigger Selections, as well as, other non ap-
plicable features may be ignored during Enhanced Real-Time.

2. ltis recommended either use the Enhanced Real-Time op-
tion for all or none of your Real-Time Jobs within a Profile.

3. Using Enhanced Real-Time will produce a different file out-
putformatforall modes of reporting and message logging (Re-
porting, Admin Reporting and Email Reporting). The output will
NOT contain a startand stop section or a summary, each entry
will also be initially marked with a date and time stamp. If use
summary is selected for Admin or Email reporting then the

standard selection will be used. The reason this is done is due to the fact
that processes will be running in parallel.

Use Standard Real-Time Monitoring

When the Real-Time feature detects a change to synchronize,
this method will cause a scan to run on the root folder, but not
the subfolders. For folder manipulations such as renames, the
entire folderincluding its subfolders will be scanned.

Global Settings

See Source Folder Global Options.
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1.1.4 Blackout Settings

Blackout Settings
| Set Blackout Ti
=t Siackaut Times List of Current Selections (1) :
Start time: | :00 AM Mew 8:00:00 AM - 6:00:00 PM
o)

End time: | &:00 PM

Ok C1 02 03 04 OS5 06 07 06 0% 10 11 12 13 14 15 16 17 16 1% 20 21 22 23

[]suspend active scans when a Blackout period starts

=I Topics
Blackout Settings Overview

Blackout Period

This screen will enable you to set a Blackout period during the daily synchronization. This
is a period in which the synchronization will stop and wait until the blackout period has ex-
pired according to the specified settings. This would be a useful feature if you wish to stop
all the synchronization activities during a particular time when the Network Bandwidth is
busy with other activities (such as during working hours).

Suspend active scans | Enabling this option will pause all the scheduled scans during
when a Blackout | the specified Blackout and will resume after the Blackout
period starts period ends.

What happens if PeerSync is performing a scan when it enters the Blackout
period?

If the option to "Suspend active scans when a Blackout period starts” is enabled the scan will
be suspended and resumed atthe pointitwas left off after the Blackout period ends. If this op-
tionis notenabled, the scan will be stopped during the Blackout period and will be restarted
from the beginning after the Blackout period ends.

What happens if PeerSync was in the middle of transferring a large file
when it entered the Blackout period?

PeerSync will allow the transfer to complete but suspend any new events from being pro-
cessed until the Blackout period ends. The suspended events or scans will be processed
after the Blackout period ends.

What happens if a scan is scheduled to run during the Blackout period?

Regardless ifthe option to "Suspend active scans when a Blackout period starts” is enabled
the scan thatis scheduled to run during the Blackout period will run after the Blackout period
ends. Multiple suspended scans fora single Job will be compiled into a single scan that will
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run atthe end of the Blackout period.

1.1.5 Scan Limitations

Scan Limitations

Maximum Duration of Scans

Set maximum duration of scans to minute(s)

Initiate Scan on Trigger File Change

[Juse Trigger Files

=l Topics

Maximum Duration of Scans
Initiate Scan on trigger File Change

Note: Features listed on this page require the Enhanced Package.

Enabling the Set maximum duration to x minutes option allows you to specify a max-
imum duration for each Job. This gives you the ability to limit the run time of a Job during ini-
tial, interval, and scheduled scans.

Trigger Files

These settings ensure thatthe Target Folders always remain updated to their correspond-
ing Source by comparing dates indicated by individual Trigger Files. For example, if a
Source Trigger is found to be newer than a corresponding Target Trigger, a synchroniza-
tion process will be allowed to proceed for the selected Job(s). If the files date and time
stamps match then the synchronization will notbe processed. Therefore, the run of the sync
process is in essence, determined by the trigger files.

Use Trigger Files

This feature is used to activate or trigger synchronization
based upon date comparison between an individual Source
Trigger File and a separate Target Trigger File. If the Target
Trigger File is older then the Source Trigger File, the entire
Source Folder(s) will be synchronized.

Default File Name

Displays the Default Global Trigger File Name: GLBCHG.000

Source Trigger File

This field allows you to specify a Global Trigger File by enter-
ing it manually, or by selecting it using the browse button loc-
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ated atthe right side of the field.

Use Current Paths

Automatically selects the current Trigger Files associated with
the Source and TargetFolders.

Target Trigger File

This field allows you to specify a Global Trigger File by enter-
ing it manually, or by selecting it using the browse button loc-
ated atthe right side of the field.

Note: During Enhanced Real-Time, Trigger Selections will be ignored.

1.1.6 File Options

File Options

Mode Selection

(®) Standard (update target files if source is newer)

() Always Overwrite (update target flles if source is newer or older)

() Bi-directional {both directions)

Ewent Options
Add - synchronize new files

Update - synchronize existing files

Replicate - Delete unmatched files

Deletion Folder

Move deleted files to an alternate location

=l Topics
Mode Selection
Event Options

| Deletion Options... |

| Move Options... |

Mode Selection

The options listed on this page can be accessed from the File Options window.

Standard (update Tar-
get Files if Source is
newer)

With this mode selection, PeerSync will update files on the Tar-
getonly ifthe Source is newer.

Always overwrite (Up-
date Target Files if
the Source is newer or
older)

This feature automatically overwrites any files in the Target
Folder that have a different date\time stamp than their corres-
ponding Source File, evenif the Target File is newer. This fea-
ture can be used to restore folders to a previous state either for
backup/restore operations or to reset files after training opera-
tions.

Bi-directional
directions)

(both

With this feature selected, PeerSync will merge the data of the
Source and the Targetfolders during Scan at Start, interval and
scheduled scans. This feature may be ignored during Real-
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Time and Enhanced Real-Time modes. The following will hap-
pen when this feature is selected with the Replicate - Delete un-
matched files/folders option enabled:

If a File exists in both Source and Target Folders
PeerSync will compare the Modified date/time of the files and
update/overwrite the older file with the newer file. If the modified
date/time is identical PeerSync will not perform any action.

If a File exists in only the Source or Target Folder
PeerSync will compare the Modified, Created and Accessed
date/time of the file with the stored Last Run On date/time of the
Job. Ifany ofthe three file date/times are newer than the stored
Last Run On date/time the file will be added, otherwise the file
will be deleted.

If a Sub-Folder exists in only the Source or Target
Folder

The Source will be seen as the primary folder and any sub-
folders with content existing on the Source will be added to the
Target. Ifthe folder is empty or exists on the Target, PeerSync
will compare the Modified, Created and Accessed date/time of
the folder with the stored Last Run On date/time of the Job. If
any ofthe folder date/times are newer than the stored Last Run
On date/time the folder and all of its contents will be added, oth-
erwise the folder will be deleted.

Note:

PeerSync now also supports real-time or scheduled bi-directional replication us-
ing our TCP replication mode. To achieve real-time bi-directional replication
across TCP, PeerSync and PSListener would need to be installed on both the
Source and the Target machines. For scheduled bi-directional replication
across TCP, PeerSync would need to be installed on one side, while the
PSListener on the other. This feature is not supported when using a TCPTar-
get.

= Related Options

Global Bi-directional Options

Notes:

1.

2.

The Bi-directional feature is only supported when working with a Normal Source and a Normal or TCP Target.

The Bi-directional feature may be ignored when using TCP Source.

The Bi-directional feature is only valid during scans and will be ignored during Real-time monitoring.

Non NTFS partitions may behave differently using the Bi-directional mode. You may notice files being retained for up to
one day, even if you delete a file from the Source or Target.

Modifications, such as renames and deletes, of Target Folders are subject to restoration in the Bi-directional mode.

Event Options
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The options listed on this page can be accessed from the Eile Options window.

Add - synchronize
new files to Target

If the Source contains files not found within the Target and this
feature is selected, those files will be added to the Target
Folder during synchronization. This feature is selected by de-
fault.

Update - synchronize
existing files in Target

If this feature is selected, Target Folder files which are also
found within the Source will be updated to match those Source
files during synchronization. This feature is selected by default.

Replicate - Delete un-
matched files

If this feature is selected, any unmatched files found in Target
Folders will be deleted automatically.

CAUTION: Use this feature carefully. If not configured prop-
erly, needed files may be permanently deleted. A deletion
warning is NOT displayed by default: Profiler mustbe firstsetto
display this warning through the "Deletion Warning Message"
check box.

- Related Options
Deletion Options
Move Options

Delete Options

following features:

The options listed on this page can be accessed by clicking on the Deletion Options
button from the Eile Options window. Once the Replicate - Delete unmatched files option is
turned on the Deletion Options button will be enabled for further configuration. Clicking on
the Deletion Options button opens the "Additional Options" dialog box which contains the

Deletion Warning
Message

The upper section of this screen allows you to enable or dis-
able a Deletion Waming Message, as well as set the number
of seconds for which a Message will be displayed. (a mes-
sage is NOT enabled by default and is not available during
Enhanced Real-Time). In addition, you can also choose to dis-
play a message requiring manual intervention in order to activ-
ate deletions.

Move Options

By clicking on the Move Options button in the File Options window you will be able to ac-
cess the Move Deleted File Options dialog which has the following settings available:

Move Deleted Files
Options

This section provides a field where the user can designate an
alternate folder to which unmatched files will be moved in order
to avoid permanent deletion. This folder path can be typed
manually, or selected using the browse button provided to the
right of the field. If the designated folder exists, all unmatched
files will be moved there, allowing you the opportunity to re-
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cover files deleted from the Target. This field also supports
File/Folder Path Variables and when used, the current path will
be displayed above the field. Beneath this field are path op-
tions.

We strongly recommend using a Deletion Folder that is loc-
ated on the Target host computer. Relocation to an alternate
drive or host adds unnecessary processing and bandwidth
overhead. For this reason PeerSync uses the following Dele-
tion Foldervariables:

% TARGETROOT%
This variable resolves to the root directory of the target path.
For example if the target path is \\machine1\c$\Target\Docs,
the deletions path % TARGETROOT %\Deletions will resolve to
\\machine 1\c$\Deletions. This variable is used by default.

% TARGETPARENT %
This variable resolves to the parentdirectory of the target path.
For example if the target path is \\machine1\c$\Target\Docs,
the deletions path %TARGETPARENT %\Deletions will re-
solve to \\machine 1\c$\Target\Deletions.

Relative Paths

This feature will move files deleted by PeerSync from the root
folder to the root of the selected folder. Files deleted from sub
folders will be moved to corresponding sub folders below the
root selected deletion folder. This feature is intended (works
best) for a Profile with a single Job.

E Source Folder: C:\ MyDocs\ Files\

X

a

m

p

I

e
Target Folder: D:\MyDocs\ Files\
Move Path: C:\ DeleteFolden\
If you delete: C:\ MyDocs\ Files\ Sub\ File.txt
PeerSync will D:\ MyDocs\ Files\ Sub\ File.txt
move:
To: C:\ DeleteFolden Sub\ File.xt

Preserve Paths

This feature will recreate the original path of the deleted file un-
der the specified path. Therefore, a file deleted by PeerSync
will be moved into a folder thatcorresponds to the file's original
location: under the selected deletion folder. This feature is in-
tended (works best) for a Profile with Multiple Jobs.

Source Folder: C:\MyDocs\ Files\

T 3o Xm
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e
Target Folder: D:\ MyDocs\ Files\
Move Path: C:\ DeleteFolden
If you delete: C:\ MyDocs\ Files\ Sub\ File.txt
PeerSync will D:\ MyDocs\ Files\ Sub\ File.txt
move:
To: C:\ DeleteFolder D_MyDocs\ Files\ Sub

\ File.txt

Use Recycle Bin

This feature allows you to specify the Windows Recycle Bin as
a location for unmatched files. This feature is not intended for
use when file deletions made by PeerSync may occur on a
non-local machine or device. Only files deleted from a local
drive can be moved to the Recycle Bin, if this feature is used all
network files will be permanently deleted.

Delete unmatched
Target Files older
than x days

This feature is intended for the cleanup of files that were can-
didates for deletion but were selected to be moved to an un-
matched folder. By use of this feature, PeerSync can be used
to temporarily store files setup for deletion and then have the
files deleted after a specified number of days. By default dele-
tion folders are checked every 24 hours or immediately after
the initial scan (if Scan Job Once at Startis enabled). This inter-
val can be modified by using the /LH:n argument where n is
represented in minutes.

Notes:

1. Only one copy of any file can exist in your designated Recovery folder.

2. To avoid filing up your hard drive unnecessarily, you should periodically check this folder and delete unwanted
files or use the Delete unmatched Target Files older than x days option.

3. Only files deleted from a local drive can be moved to the Recycle Bin, if this feature is used, all network files will

be pemanently deleted.

4. The Deletion Waming Message option is not available during Enhanced Real-Time.

5. When using the Altemate Target Path Selections feature you cannot use variables that are specific to the Job
(i.e. %JobName%, %SourcePath%, etc.) for the Move unmatched Target Files option.
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1.1.7 NFS Settings

NF5 Settings
Use Unix/Linux system for Job Scans, Copy File and/or setting Permissions

IP Address: |192.168.170.21 v| | configue... |
User Name: |vsadmin | | MountPaths |
Password: |"“"“" | | Unmount Paths |

Use Optional Target Unix/Linux system for use with rsync daemaon

IP Address: |192.168.170.23 vl | setupfTestrsyncd |
User Mame: |a|:|min | | Mount Target Path |
Password: |"“"“" | |Qnmour1tTarget Paﬂ'1|

[ Modify NF5 Default Options

soft,intr,posix, lockupcache=none, rsize =65536, wsize =65536,vers=3

—progress v - -z -H

=I Topics
Use Unix/Linux system for Job Scans, Copy File and/or sefting Permissions
Use Optional Target Unix/Linus system for use with rsync daemon
Modify NFS Default Options

Note:

Features on this screen require an NFS and NetApp enabled license. Please visit http:// www.peersoftware.com or
contact Sales for additional information.

Use Unix/ Linux system for Job Scans, Copy File and/or setting Permissions

IP Address Enter the IP address of a Unix/Linux system to use (i.e. Ubuntu
or Red Hat) for processing NFS commands.

User Name Provide the user name for a Unix/Linux system to use (i.e.
Ubuntu or Red Hat) for processing NFS commands.

Password Provide the password for a Unix/Linux system to use (i.e.
Ubuntu or Red Hat) for processing NFS commands.

Configure... Click this button to access the CIES/NFS configuration dialog.

Mount Folders Click this button to mount the current Source and Target Folder

selection on the selected Unix/Linux system.

Unmount Folders Click this button to unmount the current Source and Target
Folder selection on the selected Unix/Linux system.

Note:

Features on this screen require an NFS and NetApp enabled license. Please visit http:// www.peersoftware.com or
contact Sales for additional information.
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Use Optional Target Unix/Linux system for use with rsync daemon
IP Address Enter the IP address of a target Unix/Linux system to use with
rsync daemon (optional target side).
User Name Provide the user name for a target Unix/Linux system to use
with rsync daemon (optional target side).
Password Provide the password for a target Unix/Linux system to use with
rsync daemon (optional target side).
Setup/Testrsyncd Click this button to setup optional rsyncd (optional target side).
Mount Target Path Click this button to mount the current Source and Target Folder
selection on the selected Unix/Linux system (optional target
side).
Unmount Target| Click this button to unmount the current Source and Target
Folders Folder selection on the selected Unix/Linux system (optional
target side).
Note:

Features on this screen require an NFS and NetApp enabled license. Please visit http:// www.peersoftware.com or
contact Sales for additional information.

pected results.

Modify NFS Default Options

Check this option if you wish to modify the mount orrsync commands used by PeerSync.
Modifying the defaults should be done with caution as changes can drastically affect ex-

NFS mount Options

Lists the NFS mount options to be used when creating source
and target folder mounts on selected Unix/Linux system. Please
use caution if making changes to the defaults:

soft,intr, posix, acti neo=5, rsi ze=65536, ws-
i ze=65536, ver s=3

NFS rsync Options

Additional options to use when executing rsync commands.
Some options may be dynamically added based on Profile and/
or Job settings such as: -a, -, -, -t, -D, -A, --update, --partial, --
inplace, --exclude, --include and -n. The defaults are:

--progress -v -i -z -H

Note:

Features on this screen require an NFS and NetApp enabled license. Please visit http:// www.peersoftware.com or
contact Sales for additional information.
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118

Permissions

Permissions

File/Folder Permission Options

Transfer File and Folder Permissions NTFS Options... Global Settings

Related Global Settings

Mote: NTFS style permissions via CIFS is currently set.

Security style
To change this to UNIX security style permissions via NF5S select the
"Security style” link and go to the "CIFS/MFS” tab.

=l Topics

File/Folder Permission Options
Related Global Settings

Note:

Some features on this screen require an NFS and NetApp enabled license. Please visit hitp://www.peersoft-
ware.com or contact Sales for additional information.

File/Folder Permission Options

Transfer File and | Enable this option to transfer File and Folder Permissions
Folder Permissions (NTFS security style via CIFS or UNIX security style via NFS).
When enabled, the NTFS Options and Global Settings link
will be enabled for further configuration.

NTFS Options Click this button to open the ACL Options dialog. The options
in this dialog allow you to specify the types of permissions you
want PeerSync to detectand transfer.

Global Settings Click this link to open the Global Settings dialog and set the
global permission settings.

Notes:

1.

Care must be exercised when using ACL options to synchronize files and folders between different domains. File
security transfers could make the target file inaccessible after transfer/ update.

2. When you use a local drive letter (either for the source or target path) you need to make sure the drive is as-

signed as an administrative share (i.e. D$) in order for ACLs to work properly.

3. This feature may be ignored when using an TCP Source or Target.

4. Some features on this screen require an NFS and NetApp enabled license. Please visit http:// www.peersoft-

ware.com or contact Sales for additional information.
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Related Global Settings

This section identifies the security style thathas been globally set. The choices are NTES
style (via CIFS) or UNIX style (via NFS).

Security style

Click the Security style link to change the security style per-
missions in the CIFS/NFS tab.

Note:

Some features on this screen require an NFS and NetApp enabled license. Please visit hitp://www.peersoft-
ware.com or contact Sales for additional information.

1.1.9 Open Files

Open Files
Open Files

() Indude open files (allow read and write access to source file during transfer)

(®) Indude open files (allow read access to source file during transfer)

(") Exdude open files (allow read access to source file during transfer)

() Exdude open files {deny all access to source file during transfer)

Open/Locked Files

- To configure options for Open/Locked Files dick here Managed Files

Related Global Settings

- To set Global Recovery/Offiine Options didk here Global Settings

=l Topics
Open Files Overview
Managed Files
Global Settings

Open Files

The options listed on this page can be accessed from the Open Files window.

Include open files (al-
low read & write ac-
cess to source file
during transfer)

Use this option when you want to include open files and allow
users to modify them while they are being transferred. For
locked files such as database files, PeerSync will first attempt
to process them using the Managed Files setting if enabled. If
this process is not enabled or fails, locked files will be retried

based onthe retry open/inaccessible files setting.

Note: If PeerSync is able to synchronize files which are in use by other applic-
ations, access to those applications may in certain instances be temporarily lost
during synchronization.
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Include open files (al- | Use this option when you want to include files that are open for

low read access to read-only access. Users will be able to open source files for
source file during read-only access while they are being transferred. For files
transfer) thatare being modified or are locked PeerSync will first attempt

to process them using the Managed Files setting if enabled. If
this process is not enabled or fails, these files will be retried

based onthe retry open/inaccessible files setting.
Exclude open files (al-| Use this option when you want to replicate only files that are

low read access to closed. Files that are opened or locked will be retried based
source file during on the retry openlinaccessible files setting. Users will be
transfer) denied write access to source files that are being transferred

but may have the option to open them in read-only mode.

We recommend you use this option when doing replication/col-
laboration from one source to multiple destinations. This option
allows PeerSync to replicate files from one source to multiple
destinations, in parallel, while at the same time protecting the
source files from write access during their transfer.

Exclude open files Use this option when you want to replicate only files that are

(deny all access to closed. Files that are opened or locked will be retried based

source file during on the retry openlinaccessible files setting. Users will be

transfer) denied complete access to the source files that are being
transferred.

We recommend you use this option when doing real-time bi-
dirrectional synchronization/collaboration between two hosts.
For collaboration between more then two machines we recom-
mend you use the Exclude open files (allow read access
to source file during transfer) option.

= Related Options
Managed Files
Global Settings

Note: In order to replicate locked files you will require the VSS add-on module. If you do not configure the Managed
Files setting to use VSS, locked files will be retried based on the retry open/ inaccessible files setting.
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1.1.10 Managed Files

Managed Files
Managed Files

Enable Managed File Access (Source Files Only)

Mote

Files that are synchronized via Managed Files will be processed after the “Scan
Job once at start™ option {if enabled) and on a specified Global interval for the

Profile.

The Global interval to process files is set to 120 minutes and can be modified by

dicking the link below.

Managed Files Options

(® Synchronize open/locked files via Managed Files

() synchronize ALL files via Managed Files {induding files that are not open/locked)

Related Global Settings

- To set Global Managed Files Options dick here Global Settings

=l Topics

Managed Files Options

Managed Files - Global Settings

Note: Features listed on this page require the VSS option.

Managed Files

The options listed on this page can be accessed from the Managed Files window.

Enable Managed File
Access (Source Files
Only)

Enabling this option will allow you to reliably backup open and
locked files while users continue to work on them. For this fea-
ture to be available you will require the Volume Shadow Copy
Service (VSS) add-on module. This technology has been in-
tegrated with PeerSync to allow synchronization of critical data
such as system files and databases. By default this feature is
enabled at the end of a manual synchronization and is run
every 2 hours during persistent (Real-Time or scheduled)
modes. This interval can be modified from the Global Seftings
screen via the Global Managed Files Options link to a min-
imum interval of 30 minutes. For more features on configuring

this option please view the Managed Files Arguments.

Synchronize open/
locked files via Man-
aged Files

Through the use of this feature PeerSync will enable pro-
cessing ofthe Open and Locked Files from the local machine,
through the use of the Volume Shadow Copy Service (VSS)
technology. Please note VSS will delay processing of files to
the specified interval. VSS is an add-on module.

Synchronize ALL files
via Managed Files
(including files that
are notopen/locked)

Through the use of this feature, you can force PeerSync to
send all the file processing through the Yolume Shadow Copy
Service (VSS) technology. Please note VSS will delay pro-
cessing offiles to the specified interval. VSS is an add-on mod-
ule.
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= Related Options
Global Settings

Notes:

1. These options require the YSS add-on module. Please visit http:// www.peersoftware.com or contact Sales for addi-
tional information.

1.1.11 Performance

Performance
File Read/Write Buffer Size
Improved Maximum
Load Balancing Performance
[
256 bytes 128 KB

Setto (4095 | bytes Reset to Default
Throtte bandwidth - Use %% of available bandwidth | Time & Day Options

[ ] Enable inteligent network load balandng (when applicable)

[ set maximum number of Copy Threads to |0 %

Related Global Settings
- To configure Global Performance Options dick here Options/Commands

=I Topics
Performance Overview
Options/Commands

Performance Options

The options listed on this page can be accessed from the Performance window.

File Read/Write Buffer | This feature allows you to change the read/write buffer sizes to
Size optimize performance/speed across various network environ-
ments oron the local machine. In most cases this will increase
performance dramatically but you will probably need to test this
feature in your environment to determine what advantages can
be gained from altering this size.

The minimum value is 256 bytes.

The defaultvalue is 64 KB.

The maximum value that can be set using the track bar is 128
KB.

The maximum value that can be set using the up arrow or by
manually typing in the spin editfield is 128 KB

Buffer Size Upper A higher upper limit of 1 MB is available with the Multi Thread-
Limit (* Multi Threading ing Option option. This value can be set using the up arrow or
Optionng Option) by manually typing a setvalue into the spin editfield.
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Throttle bandwidth -
Use x percent of
available bandwidth

This feature is designed to limit or slow down the pulse of
reads and writes performed by PeerSync, at the percentage
specified, in order to keep bandwidth available for other ap-
plications to use. This is done atthe file level and is performed
by each Copy Thread during the transfer of each file. As we
copy a file we track how long it takes to read and write data
from the source to the target. Every 100 milliseconds from the
start of a file transfer we calculate how much time to allot for pro-
cessing and sleeping based on the percentage set for the op-
tion.

Examples:

100% Always Process
90% Process for 90 milliseconds Sleep for 10 milliseconds
every 100 milliseconds
50% Process for 50 milliseconds Sleep for 50 milliseconds
every 100 milliseconds
10% Process for 10 milliseconds Sleep for 90 milliseconds
every 100 milliseconds

In summary, PeerSync determines bandwidth throttling by cal-
culating the amount of time required to send a packet of data
across your network and then applying a delay based on the
throttling percentage specified.

Time & Day Options

Limit Bandwidth Trottling between the hours and days defined
forthe selected Job. Using a W+ switch in the /Q8B argument
(i.e. /Q8BW+) will display/report bandwidth % used for file add
and update events as partof the remarks field.

Notes:

1. This methodology should dynamically allow for PeerSync to transfer data at
a fast pace when no other applications are using bandwidth and allow it to
back off when other applications are using bandwidth.

2. This methodology is more accurate when using smaller Read/ Write Buffer
settings.

3. This methodology does not include small files that take less than 100 milli-
seconds to process.

Enable intelligent net-
work load balancing
(when applicable)

The network load balancing option will automatically set a
read/write buffer size based on recommendation from NIC net-
work cards (Installed network cards must also support this fea-
ture).

Set maximum number
of copy threads to x (*

Multi Threading Option)

This feature will limit the number of copy threads to be
spawned and used for the selected Job during folder scans.
This thread limit does not apply to enhanced Real-Time
events. By using limits for scanning, it helps the Profile to better
process Enhanced Real-Time events during heavy scan oper-
ations.
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= Related Options
Options/Commands

Note: Some features described on this page require the Multi Threading Option. Please visit http:// www.peersoft-
ware.com or contact Sales for additional information.

1.1.12 Byte Replicator

ByteReplicator

Use block/byte level synchronization

On Failure: |Use Default File Copy for Synchronization W

Block Size Selection

Improved
Bandwidth Utilization

Smaller Block Size

Improved
Performance

Larger Block Size

Reset to Default

File Exdusions Exduded File Types: ON - Minimum File Size: 100 KB
Port Configuration | Port: 7333 - Time Qut: 120 seconds - Compression: OFF

Mote: This option requires our PSListener tool to be installed on the
remote computer with identical Encryption and Port configurations.

=l Topics
Byte Replicator Options

Note: Features listed on this page require the Byte Replicator options.

<%REPLICATOR%> Options

The Byte Replicator screen enables and configures Block/Byte level synchronization for
the selected Job. Through the use of this feature PeerSync will be able to transmit only the
bytes/blocks of a file that have changed instead of transferring the entire file.

Use block/byte level | Select this option to enable/disable block/byte level replica-
synchronization tion. If this is disabled, PeerSync will use the standard copy
method to synchronize the file. If the Byte Replicator fails to syn-
chronize a file, i.e. On Failure, PeerSync will either:

1. Log Messages & Use Recovery Intervals (if applicable)

2. Use DefaultFile Copy for Synchronization

Block Size Selection | This slider controls whether either Performance or Bandwidth
Utilization is most important. Files synchronized with the slider
set Low will take longer to complete than with the slider set
High.

File Exclusions Clicking on the Exclusions button in the Byte Replicator win-
dow opens theByte Replicator File Exclusions dialog. Files
that match types in the exclusion string (types by file extension)
or files that have a size lower than the Minimum File Size will
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use the defaultfile copy method instead of the Byte Replicator
feature.

Excluded File Types by Extension

Field containing a list of file types that will use the default file
copy method instead of the Byte Replicator. This feature can
be configured by clicking the button to the right of this field. For
example, to exclude files with the extension LOG you may add
either .log orlog to the exclusion list. Multiple entries need to
be semicolon (;) delimited.

Minimum File Size

Files with sizes lower than the value in this field will be copied
using the default file copy method instead of using the Byte
Replicator.

Port Configuration

Port Configuration tab for more information).

Clicking on the Port Configuration button in the Byte Replic-
atorwindow displays the Port Configuration dialog. This win-
dow allows fora common TCP and/or Byte Replicator configur-
ation option for both the Source and Targetpaths (see the TCP.

Note: The TCP WAN Connector (TCP) is an optional feature which may not
be included in your package. Please visit http:// www.peersoftware.com or
contact Sales for additional information.

Note: The Profiler will not support Well Known Port numbers 0 - 1023. You
must use port numbers that are greater than or equal to 1024.

Notes:

1. The Byte Replicator is an optional feature which may not be included in your package. Please visit http:// www.peer-

software.com or contact Sales for additional information.

2. When you use a local drive letter (either for the source or target path) you need to make sure the drive is assigned as

an administrative share (i.e. D$) in order for the Byte Replicator to work properly.

3. In order for Byte Replicator to be enabled, the following criteria must be present:
e The PS Listener Service has been installed on the remote machine
e The PeerSync license has the Byte Replicator add-on feature
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1.1.13 Revisioning

Revisioning

Revisioning - Keep backup files of overwritten target files

Number of backup files to keep:

(®) Keep files in Target Folder
() Keep files in Deletion Folder
() Keep files in Alternate Folder

C:'\Program Files (x88)\PeerSync\Target

= Topics
Revisioning Options

Revisioning

The options listed on this page can be accessed from the Revisioning window. Through
the use of this feature, you can use PeerSync to keep multiple versions of each file. This is
a greatfeature for recovering a previously saved version of a file.

Revisioning - Keep Selectthis option to enable/disable the use of Revisions.
backup files of over-
written Target Files

Number of backup Designates the number of revisions to keep for each file. Peer-

files to keep Sync revisions each file by adding a ".PSBAK1" extension to
the existing Target File before replacing it with the updated
Source File.

Example: "MyFile.txt" will become "MyFile .txt PSBAK1"

If more than one backup is selected, each file will be renamed
to the nextrevision when an update occurs:

Example: "MyFile txtPSBAK1" is renamed to
" MyFile .txt PSBAK2"

The newestrevisions (backup files) will bear the lowest number
while the oldest will have the higher number:

Example: Newer.. PSBAK1, PSBAK2, PSBAK3, PSBAKn
..Older

Note: If the "Delete Unmatched" option is selected and the Source File that
has comesponding PSBAK files deleted, all associated PSBAK files will also be
deleted.
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Keep files in Target
Folder

By default, revisions will be stored in the Target Folder where
the updated TargetFiles reside.

Keep files in Deletion
Folder

You also have the option of using the Deletion Folder for stor-
ing revisions. This is quite useful when used in conjunction with

the Delete unmatched Target Files older than x days option,
which is used for automatic cleanup ofold revisions.

Keep files in Alternate
Folder

You may specify the folder path where you would like the revi-
sions stored to. This option will give you the ability to specify a
separate revision folder per Job. We strongly recommend us-
ing a Revisions Folder that is located on the Target host com-
puter. Relocation to an alternate drive or host adds unneces-
sary processing and bandwidth overhead. For this reason
PeerSync uses the following Revisions Folder variables:

% TARGETROOT %

This variable resolves to the root directory of the target path.
For example if the target path is \\machine 1\c$\Target\Docs,
the revision path % TARGETROOT %\Revisions will resolve to
\\machine 1\c$\Revisions. This variable is used by default.

% TARGETPARENT %

This variable resolves to the parentdirectory of the target path.
For example if the target path is \\machine1\c$\Target\Docs,
the revisions path %TARGETPARENT %\Revisions will re-
solve to \\machine 1\c$\Target\Revisions.

1.1.14 Miscellaneous

Miscellaneous
Target File/Folder Alterations
Use intermediate file during copy

[ Trigger additional event after successful copy

[]Force target file attribute settings

Source File/Folder Alterations

[IMove Files - Delete source file after successful copy to target
[ITurn file archive attribute off after synchronization

Additional Event Options

[]indude attribute change as synchronization criteria

=I Topics
Temp Files

Source File/Folder Alterations

Additional Event Options
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Target File/Folder Alterations

These options can be found in the Miscellaneous window.

Use intermediate file
during copy

If this box is checked, a temporary file will be created in the Tar-
get Folder: the contents of the Source File will then be copied
into this temporary file. After a successful copy, the Target File
will be deleted and the temporary file will be renamed to bear
the Target File name. This feature ensures that the updated file
will only replace the TargetFile if copy is successful. If the copy
process should be interrupted because of some outside factor
(network down, power outage, etc), the original Target file will
still be preserved. This option is enabled/disabled automatic-
ally when the Bi-directional or Revisioning options are en-
abled/disabled.

Trigger additional
event after successful

copy

When this option is checked PeerSync will apply the time
stamp of the target file after successfully completing the file
transferin order to trigger an event on the target side. This ac-
tion will cause the PeerSync installed on the Target to take fur-
ther action with the file such as transferring it to another location
thatis notaccessible from the originating machine.

Force target file attrib-
ute settings

If this feature is selected, the File Attributes Options dialog
will be displayed. In this dialog, you may select to force any at-
tribute on or off for the Target files that are synchronized within
the selected Job(s).

File Attribute Options

This dialog provides the user the selection to ignore, force on,
or force off attribute settings on Target files that are synchron-
ized within the selected Job(s).

= Related Options
Global Settings

Source File/Folder Alterations

These options can be found in the Miscellaneous window.

Move Files - Delete
source file after suc-
cessful copy to target

This feature will delete the Source file after the file is copied to
its corresponding Targetfolder.

Note: This feature should not be used with the Delete Un-
matched Target Files option on the Eile Options screen be-
cause conjunct use of the two options will greatly increase the
chance ofdata loss.

Turn file archive at-
tribute off after syn-
chronization

This feature resets the archive flag on the Source and Target
file after synchronization. The Windows file system automatic-
ally sets the archive bit for every file that has changed; nor-
mally, this is used to indicate that a given file has been modi-
fied since the last time its archive bit was set. Most tape back-
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up programs use this flag to determine which files have
changed since the last backup. This option will alter Source
files. PeerSync uses this feature to reduce the number of files
that are checked on the Source drive.

Notes:

1. Source files that are not being synchronized to Target folders will NOT have their archive flags reset. This process
only occurs after successful synchronization of a changed file.

Hint: To reset all Source file archive flags, use the "Always Overwrite Target Files" feature.
This configures all files for synchronization and consequently qualifies them for the reset of
archive flags. This feature only needs to be selected once to be applied to existing sync op-

erations.

Additional Event Options

This option can be found in the Miscellaneous window.

Include attribute
change as synchron-
ization criteria

This feature allows for the synchronization of files that have dif-
ferent attributes. If this feature has been selected, a Source file
whose attributes do not match the Targetwill still be included in
the synchronization process.

Notes:

1. By default this option only works during scans. Use the /LA command line
argument if you wish to enable attribute detection in real-time.

1.1.15 Additional Features

Additional Features
Additional Cptions
[ ]Enable file recovery

[ Replace in-use files upon reboot

Validation Options

[]perform binary comparisen on all files {using CRC32)

[Jvalidate target file {using CRC32) Retry Options

File Time Change Options

|:| During comparison | subract

0 minute(s) from target

[Jcomvert file times to GMT for comparison between time zones

[ ] after synchronization |subtract

= Topics

0 minute(s) from target
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Additional Options
Validation Options

File Time Change Options

Note: Features listed on this page require the Enhanced Package.

Additional Options

The options on this page can be accessed from the "Additional Features" window, avail-
able only with the Enhanced Package.

Enable file recovery

This enables the file recovery option to continue a file copy
which may have been interrupted. If the Source and Target file
name and date match but the Target file is smaller, PeerSync
will startthe copy operation from the last byte that was sent the
nexttime a sync operation is executed on the folder.

Replace in-use files
upon reboot

If this feature is selected, once a file is open and locked on the
TargetFolder, itwill be setto be replaced the next time the ma-
chine is rebooted.

Note: This option is only applicable for Jobs with a local Tar-
getFolder.

Reboot Options But-
ton

This button opens the Reboot Options dialog box. The default
optionis "Do notreboot", you may also choose to "Display re-
bootdialog", orto "Automatically reboot".

Note: Features described on this page require the Enhanced Package.

Validation Options

These settings can be accessed from the "Additional Features" window, available only
with the Enhanced Package.

Perform binary com-
parison on all files
(using CRC32)

Option to check all Source and Target files for binary match
during folder scan/compare cycle (using CRC32). This check
ensures thatwhatis on the Target matches the Source at a bin-
ary level.

Validate target file
(using CRC32)

Option to validate file using CRC32 binary comparison after
successful file copy operation. Clicking on the Retry Options...
button opens the Validate File Copy Options dialog box. In this
window you may setPeerSync to continue re-validating a file a
setnumber oftimes.

Retry file copy until CRC of targetfiles is validated

Checking this option will enable the CRC Retry cycle, where, if
a file is not validated, PeerSync will retry the CRC32 validation
x times. The defaultretry value is 1.

Setmaximum number of tries to
Specify the number of times PeerSync will perform CRC32 val-
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idation on a file if the initial validation fails. The default retry
value is 1.

Note: Features described on this page require the Enhanced Package.

File Time Change Options

These settings can be accessed from the "Additional Features" window, available only
with the Enhanced Package.

During comparison sub-
tract/add x minute(s) from
target

Option to add ordelete time from Target file during folder com-
parison. This allows for synchronization of files betweendissim-
ilar time zones or to allow for some time difference between
Source and Target in case Target machine date is slightly dif-
ferentfrom Source.

Note: This feature may be ignored during Enhanced Real-
Time.

Convertfile times to GMT
for comparison between
time zones

Option to convert file times to GMT for comparison between
time zone differences of the Source and Target folders. This
feature is quite useful way of synchronizing data between ma-
chines located in different parts of the world.

After synchronization sub-
tract/add x minute(s) from
target

This option can add or delete time from Target file after syn-
chronization. This allows for synchronization of files between
dissimilar time zones, or to allow for some time difference
between Source and Target in case Target machine date is
slightly differentfrom Source.

Note: Features described on this page require the Enhanced Package.

1.1.16 Exceptions

Exceptions

Include Files

V]

Exclude Files

~® tmp;thumbs. db;

v

Exdude Folders

| \System Volume Information\;\SRECYCLE.BIM\;\.pc-trash_bin\;\.copy_offioad';\, snapshotl; \~snapshotl; | etcl; Yost+fc v ||:|

Selected File Dates
Usze all dates

Exdude File Sizes

[-]

Incude Attributes Exdude Attributes
Default |1| Default Iz‘
= Topics
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Exceptions Overview
Include Files

Exclude Files
Exclude Folders
Exclude File by Size

Exclude Files by Attributes

Exclude Selected File Dates

The Exceptions screenis used after you have selected a Job or Multiple Jobs from the Pro-
file Job Listand then created an associated Source and Target Folder on the Eolder Selec-
tion screen. Through Exception options, PeerSync allows you to selectively apply synchron-
ization to files contained within the Source Folder according to a wide range of explicit cri-

teria.

Include Files

The options on this page can be accessed from the Exceptions window.

Include Files

Use this field to determine which file types will be included as
partof synchronization. File Type Inclusions are specified by a
star command followed by the file extension (i.e. *.doc). You
can also specify specific file names and/or sub strings using
the * wildcard character.

The default setting * includes all files.

Multiple Inclusions can be used and are semicolon delimited
(i.e.*.doc;*.ixt*.exe).

Inclusions are notcase sensitive, (i.e."A" ="a").

Exampl*.doc -includes any file ending with the extension
es .doc
docs -includes any file that contains the string docs
copy* -includes any file starting with the string copy
file;dat - includes any file containing the strings file or
a; data

You may also use the ? wildcard character to further narrow
down yourinclusions. The ? wildcard character can be used to
substitute any single character in the file name including num-
bers.

Exampl????.* -includes files that have extensions and contain
es only 4 characters in the name
June??-includes files that have extensions, start with
??*  the word June, and are followed by 4 charac-

ters
7 -includes files that have the characters ne in the
ne????3rd and 4 th positions followed by atleast4
* characters
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Inclusions can be typed manually, or can be specified using
either the Include File Types button ordrop-down listlocated to
the right of the field.

Include Files Button Opens an "Exceptions" dialog box into which file extensions
may be entered. The "include all files" command * will be
shown by default.

To add an extension, click "New." Next, type the desired exten-
sioninto the field located atthe bottom of the dialog. Repeat
this process for each desired file type. Inclusions can be de-
leted by selecting them from the listand clicking the "Delete"
key atthe bottom of the dialog box. Once you have finished,
click the "OK" button. The dialog will close and all of the Inclu-
sions you have specified will automatically appear in the In-
clude File Types field in the proper format (separated by semi-
colons).

The drop-down listlocated to the right of this field will be dy-
namically populated with Inclusions as they are setthrough the
"Exceptions" dialog described above. They are also added to
the listwhen you exit the field after manually editing the Include
File Types field. Inclusions can then be specified by selecting
them from this list. This provides a way to store and/or retrieve
sets of Inclusions for later use with other Jobs.

Exclude Files

The options on this page can be accessed from the Exceptions window.

Exclude Files Through this field, files can be selectively excluded from syn-
chronization using sub strings or using wild cards. Exclusions
are setby specifying individual characters (i.e. 7), sets of char-
acters (i.e. copy®), or file extensions (i.e. *.tmp) which, if found
within a file name, will exclude that file from synchronization.

Multiple characters and strings can be used and are semicolon
delimited (i.e. ~;*.tmp;copy®)

These settings are notcase sensitive, (i.e."A" ="a")

Exampl™ - excludes any file containing the character ™
es
tmp - excludes any file that contains the string tmp
copy* -excludes any file starting with the string copy
*tmp -excludes any file ending with the extension

tmp
Imp;.b -excludes any file bearing the strings .tmp, .bak
ak;™ orthe character™

You may also use the ? wildcard character to further narrow
down your exclusions. The ? wildcard character can be used to
substitute any single character in the file name including num-
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bers.

Exampl*tmp? -excludes all files that contain the string tmp fol-
es . lowed by atleastone character before the ex-
tension

Exclusions can be typed manually, or can be specified using
either the Exclude Files Button or drop-down listlocated to the
right of the field.

Exclude Files Button

Opens a dialog box into which Exclusions may be entered.

To add an Exclusion click "New," then type the desired charac-
ter or string into the field located atthe bottom of the dialog.
Repeatthis process for each Exclusion. Entries can be deleted
by selecting them from the listand clicking the "Delete" key at
the bottom of the box. Once you have finished, click the "OK"
button. The box will close and all of the Exclusions you have
specified will automatically appearin the Exclude Files field.

The drop-down listlocated to the right of this field will be dy-
namically populated with Exclusions as they are setthrough the
dialog boxdescribed above. They are also added to the list
when you exit the field after manually editing the Exclude Files
field. Exclusions can then be specified by selecting them from
this list. This provides a way to store and/or retrieve sets of Ex-
clusions for later use with other Jobs.

Exclude Folders

The options on this page can be accessed from the Exceptions window.

Exclude Folders

Use this field to exclude folders from synchronization by spe-
cifying a folder name in file path format, (i.e. \TEMP\ or C:
\WINDOWS\). These examples will exclude any folder path
that contains these strings including sub-folders.

Ifyou wish to exclude only a specific or root folder such as "C:
\WINDOWS\" butinclude sub-folders you mustinclude a "#" in
front of the complete folder path (i.e. "#CAWINDOWS\"). This
example will exclude any files in this directory but include any
files in its sub-folders. A semicolon separates multiple folder
exclusions.

If you wish to exclude multiple folders that contain the same
string do notinclude the "\" at the end of the folder exclude (i.e.
\Docs).

These settings are notcase sensitive, (i.e."A" ="a")
Exampl\Docs -excludes files and sub-folderin folders starting

es with Docs (i.e. Docs, Docs1, DocsA, etc.)
\Docs\ - excludes files and sub-folderin folders named
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Docs
C: - excludes files and sub-folder in the folder C:
\Docs\ \Docs\
#C: - excludes files in the folder C\Docs\ but in-

\Docs\ cludes files in its sub-folders

Exclusions can be typed manually, or can be specified using
either the Exclude Folders Button or drop-down list located to
the right of the field.

Exclude Folders But-
ton

Opens a dialog box into which Folder Exclusions may be
entered.

To add an Exclusion, click "New," then type the desired folder
name into the field located at the bottom of the dialog. Repeat
this process for each Exclusion. Entries can be deleted by se-
lecting them from the list and clicking the "Delete" key at the
bottom of the box. Once you have finished, click the "OK" but-
ton. The boxwill close and all of the Exclusions you have spe-
cified will automatically appear in the Exclude Folders field.
The drop-down list located to the right of this field will be dy-
namically populated with Exclusions as they are added. Exclu-
sions can then be specified by selecting them from this list.
This provides a way to store and/or retrieve sets of Exclusions
for later use with other Jobs.

Exclude empty source
folders

This feature will exclude and will not sync empty Source
Folders to the Target.

Exclude File by Size

The options on this page can be accessed from the Exceptions window.

Exclude File Sizes

Use the "Less Than" or " Greater Than" fields to exclude files
based ontheir size in bytes. Zero, by default, includes all files.

Include Files by Date

The options on this page can be accessed from the Exceptions window.

Selected File Dates

Use this field to specify files set for synchronization according
to their date stamp. The default setting includes all file dates.
Clicking the button to the right of this field opens a "Select File
Dates" screen. This screen allows you to include all files, in-
clude files more than x days old, include files bearing the cur-
rentand pastxday's date, or specify a range of the dates. The
Set Today's Date button automatically updates the existing
range to reflectthe currentday.

Include Files by Attributes

The options on this page can be accessed from the Exceptions window.
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Current Attributes

This field displays "Default' or "Customized" to indicate
whether the default attributes have been changed. Clicking the
button to the right of this field opens a window from which file/
folder attributes may be included. All attributes are selected by
default. Uncheck the file/folder attributes you do not wish to be
used as criteria for synchronization.

Exclude Files by Attributes

The options on this page can be accessed from the Exceptions window.

Current Attributes

This field displays "Default' or "Customized" to indicate
whether the default attributes have been changed. Clicking the
button to the right of this field opens a window from which file/
folder attributes may be excluded. All attributes are unchecked
by default. Select the file/folder attributes you wish to be used
as criteria for exclusion.

1.1.17 Reporting

Reporting
Use log file

C:\Program Files (x86)PeerSynciLogs\Windows Log

ZalnstallPath %L ogs!%JobName 3. Log [¥] |

[ ] overwrite existing log file

Report File Content

Added files Updated files
File date File time

File size Transfer time

Log File Size/Content

Summary Messages
[]Folder names [ Exceptions
[w|Falder creation  [w] ACLs

Set maximum log file size to | 1000000 bytes

SNMP Options
[]Use SNMP reporting (errors anly)

= Topics
Reporting Overview
ReportFile Content
Log File Size/Content
SNMP Options

Reporting

The options listed on this page can be accessed from the Reporting window. PeerSync
automatically generates Log Files providing a detailed history of all synchronization
events. This screenis used to view Log Files and set their reporting characteristics.

Use Log File

This feature enables or disables Log file generation. The de-
fault file, PeerSync.Log, is located in the path in which Peer-
Sync has been installed. This field also supports Eile/Folder
Path Variables and when used the current path will be dis-
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played above the field.

Overwrite Existing Log

Use this feature to report only the mostrecent PeerSync activity

File in the Log File. If this feature is not selected, all PeerSync pro-
cesses will be reported in succession.

View Log File This button allows you to view Log reports by opening the file in
a texteditor.

Clear Log File This button allows you to clear Log reports.

Reporting File Content

The options listed on this page can be accessed from the Reporting window. Using the
check boxes provided in this section of the Reporting screen, you can specify what will be
reported in the Log File. The Default setting is to include all items except Folder Names.

Added Files This feature adds an entry for any file that has been added to
the Target.

File Date Includes date associated with each file contained in the Log.

File Size Includes size of each file contained in the Log.

Updated Files

This feature adds an entry for any file that has been updated in
the Target.

File Time

Includes time associated with each file contained in the Log.

Transfer Time

Includes time ittakes to transfer the file in milliseconds.

Summary

Appends a summary of activity to the end of the report.

Folder Names

Indicates the names of synchronized folders.

Folder Creation

This feature creates an entry for any folders that did not exist in
the Target and had to be created during the synchronization
process.

Messages This feature logs any messages or application errors found
during synchronization.

Exceptions This feature logs any file/folder exclusion found during syn-
chronization.

ACLs This feature logs any file/folder ACL updates during scans and

real-time.

Note: Application errors are additionally written to a file called "PS Enor.log," regardless of whether or not that op-

tion has been selected.

Log File Size/Content

The options listed on this page can be accessed from the Reporting window.

Set the maximum log
file size to x bytes

By entering an amountinto this field you can limit the size of Log
Files created by PeerSync. When this limit is reached, the next
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reporting session will first rename the existing file to
FILENAME.BAK1.Log and then create a new, blank Log File to
which subsequent data will be added. Two backups
FILENAME.BAK1.Log and FILENAME.BAK2.Log will be kept
for each unique Log file. To customize the number oflog files to
backup add the following entry in the PSDef.cfg file:

[Msc Options]
LogBackUpFi | eCount =3

Unicode content This option will enable the reporting of Unicode content.

SNMP Options
The options listed on this page can be accessed from the Reporting window, available
only with the Enhanced Package.

Use SNMP reporting | Use Simple Network Management Protocol error reporting.
(errors only)

SNMP Options Button | This button opens the SNMP Options dialog box. Once this box
has opened, itallows you to selectthe Destination IP and Trap
Prefix to be used for SNMP reporting. Please refer to your
SNMP management software for more defails.

Note: To properly use the installed mib file you need to rename
the psi_def.mib to psi.mib.

Note: Features described on this page require the Enhanced Package.

1.1.18 Admin Reporting

Admin Reporting
Create administrative report files

Report File Content Report File Name

|Summary;’|‘~"lessages only W | | Logged On User: Administrator Vl

Repart File Path
C:'Program Files (x86)\PeerSync\Logs\Admin2016-05-23}
|C: \Program Files (x86) \PeerSynciLogs\Admin| ey yyy Yo-Semm 3e-Sedd ¥ W |

Admin Report Cyde Options

|Create a report once a day v | Every day at (12:00 PM 2
Advanced Settings...

=I Topics
Admin Reporting Overview
ReportFile Content
ReportFile Name
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ReportFile Path
Admin Report Cycle Options
Advanced Settings

Admin Reporting

The options listed on this page can be accessed from the Admin Reporting window. T his
screen allows you to create a unique report for administration purposes. Admin Reports
generated during sync operations can be saved to a specific administrative folder (in a
local or network path). Admin Reports are made uniquely identifiable through a choice of
naming conventions, (i.e. Computer Name or User Name with date\time stamps).

Create administrative | This feature enables or disables the Administrative Reporting
reportfiles feature.

Note: Admin reporting files do not display Unicode characters.

Report File Content

The options listed on this page can be accessed from the Admin Reporting window.

Summary/Messages Appends a summary of activity to the end of the report. This op-
only tion will also log messages.

Standard report file This feature directs Report content to follow those conventions
content also utilized in PeerSync Log Files.

Messages only Only reports messages and application errors.

Note: When in enhanced Real-Time or when using Multiple Job Threads standard reporting will be used if summary
is selected.

Report File Name

The options listed on this page can be accessed from the Admin Reporting window.

Report file name Allows you to choose between a "Local Computer" or
"Logged-On User" Administrative Report. The reports will bear
the selected name as a prefix, followed by the created date
and time of the Report (ie. COMPUTER-
111507172625011_00001.RPT).

Report File Path

The options listed on this page can be accessed from the Admin Reporting window.

Report file path This field displays the location of Admin Report files. This field
also supports File/Folder Path Variables and when used the
current path will be displayed above the field.

Admin Report Cycle Options
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The options listed on this page can be accessed from the Admin Reporting window.

Create a report for
every event

This option allows for a report to be generated on every event
(Add/Update/Delete/Message).

Create a reporton an
interval

This option allows for a report to be generated at a specific in-
terval. You may specify the interval from the input field to the
right of this option.

Create a reportonce
a day

This option allows for a report to be generated once a day.
You may specify the time of the day from the input field to the
right of this option.

Create a reportonce
a week

This option allows for a report to be generated once a week.
You may specify the day of the week from the drop down list to
the right of this option.

Only use Advanced
Settings

This option allows for a report to be generated based on the
configuration of the Advanced Settings only.

Advanced Settings

The options listed on this page can be accessed on the "Advanced Settings" button from
the Admin Reporting window.

At the start of this Pro-
file

This option allows for a report to be created at the start of the
Profile.

At the stop of this Pro-
file

This option allows for a report to be created at the stop of the
Profile.

For each individual
error message as it
occurs

This option allows fora reportto be created for each error.

After each scan (log
all non-scan events
on the cycle spe-
cified)

This option allows for a reportto be created once a day. You
may specify the time of the day from the inputfield to the right of
this option.

After each scan/cycle
even if no events oc-
curred

This option allows for a report to be created after each scan
even when no events occurred.
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1.1.19 Email Reporting

Email Reporting

Create administrative email messages

Report File Content

Report File Name

|Summaryﬂ~1essages only W | | Logged On User: Administrator W

Email Configuration

Email to: monikac@peersoftware.com

Email Configuration. .. [ attach log files Delete after successful send

Email Report Cyde Options

|Send an email once a day W | Every day at (12:00 PM 2

Advanced Settings...

= Topics

Email Reporting Overview

ReportFile Content
ReportFile Name
Email Configuration

Email Report Cycle Options

Email Reporting

The options listed on this page can be accessed from the Email Reporting window. T his
screen allows you to create a unique report for administration purposes. Email Reports
generated during sync operations can be sent to an administrator, shared mailbox or a
specified user. Email notification of synchronization activity can be sent upon completion of
entire Profile or during persistent synchronization operations. Email Reports are made
uniquely identifiable through a choice of naming conventions, (i.e. Computer Name or User
Name with date\time stamps).

Create administrative
Email messages

This feature enables or disables the Email Reporting feature.

Note: Email reporting messages do not display Unicode characters.

Report File Content

The options listed on this page can be accessed from the Email Reporting window.

Summary/Messages
only

Appends a summary of activity to the end of the report. This op-
tion will also log messages.

Standard report file
content

This feature directs Report content to follow those conventions
also utilized in PeerSync Log Files.

Messages only

Only reports messages and application errors.
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Note: When in enhanced Real-Time or when using Multiple Job Threads standard reporting will be used if summary
is selected.

Report File Name

The options listed on this page can be accessed from the Email Reporting window.

Report file name Allows you to choose between a "Local Computer" or
"Logged-On User" Administrative Report. The emails will bear
the selected name as part of the Subject filed. For example:
"PeerSync Summary Report for COMPUTER (PeerSync Star-
ted)".

Email Configuration

The options listed on this page can be accessed by clicking on the "Email Configuration"
button from the Email Reporting window.

Attach log files Allows you to attach the reporting section log file to emails gen-
erated by this application.

Delete after successful | Deletes the log file after a successful email attached send.
send

Email Configuration But-| This button opens the Email Configuration dialog box: Once
ton this box has opened, it allows you to select the SMTP Host,
UserID, Port, who to send to, and who to send Carbon Copies
to and whatemail address to send from.

SMTP Host
The hostname or IP address of the SMTP mail server to send
alertemails to.

UserID
The username to authenticate with the SMTP mail server. This
is normally not needed. (Optional)

Port
TCP/IP connection port. Itis recommended that you leave the
default setting unless your email server requires otherwise.

To

The email address of the person who is to receive the email.
This user sometimes needs to be a valid user on the SMTP
mail server. You may add multiple email addresses in this
field. Use a semicolon (;) as a delimiter.

CcC

The email address of the person who is to receive a Carbon
Copy of the email. You may add multiple email addresses in
this field. Use a semicolon (;) as a delimiter.

From
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The email address that will appear in the From field of the
email. This email does not need to be a valid email. For ex-
ample it can be used to identify the Job that generated the
email by using the %JobName% variable (i.e. %6JobName%
@MyCompany.com).

Send Test Email

Clicking on the Test Connection button will send a test email to
the configured email address(es) and letyou know if PeerSync
was able to successfully connect and send an email via the
configured SMTP mail server. It is highly recommended that
you test the configuration before saving the options.

Email Report Cycle Options

The options listed on this page can be accessed from the Email Reporting window.

Create a report for
every event

This option allows foran Email to be senton every event (Add/
Update/Delete/Message)

Create a reporton an
interval

This option allows foran Email to be sent at a specific interval.
You may specify the interval from the input field to the right of
this option.

Create a reportonce
a day

This option allows for an Email to be sentonce a day. You may
specify the time of the day from the input field to the right of this
option.

Create a reportonce
a week

This option allows for an Email to be sent once a week. You
may specify the day of the week from the drop down list to the
right of this option.

Only use Advanced
Settings

This option allows foran Email to be sent based on the config-
uration of the Advanced Settings only.

Send Email Reports

The options listed on this page can be accessed by clicking on the "Advanced Settings"
button on the Email Reporting window.

At the start of this Pro-
file

This option allows foran Email to be senton every event (Add/
Update/Delete/Message).

At the stop of this Pro-
file

This option allows foran Email to be sent at a specific interval.
You may specify the interval from the input field to the right of
this option.

For each individual
error message as it
occurs

This option allows for an Email to be sent at a specific interval.
You may specify the interval from the input field to the right of
this option.

After each scan (send
all non-scan events
on the cycle spe-
cified)

This option allows foran Email to be sentonce a day. You may
specify the time ofthe day from the input field to the right of this
option.
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After each scan/cycle
even if no events oc-
curred

This option allows foran Email to be sentafter each scan even
when no events occurred.

Email Report Content

The options listed on this page can be accessed by clicking on the "Advanced Settings"
button on the Email Reporting window.

Send content in the
body of the Email

This option will write the content for the email report into the
body of the email.

Send content as an at-
tachment to the Email

This option will generate a file with the content of the email re-
portand attach the file to the email.

Place contentin a file
and send a link in the
Email

This option will generate a file with the content of the email re-
portand a link to the file will be sentwithin the body of the email.

1.1.20 Pre/Post Process

PrefPost Process

Select Application,/Script to Run Before/After Selected Job

Before

| v
After

|RUNJOB "PST Backup” v |

[ ]wait for application to end before continuing

Use a maximurm wait time of |50

=l Topics

Pre/Post Process Overview

Pre/Post Process

The options listed on this page can be accessed from the Pre/Post Process window. This
screen allows the user to choose external applications / scripts to be run before and after
the processing ofa given Job.

Before

Use this field to specify (by file path) which application or script
you would like to run before processing a Profile. File paths
can be manually entered, or the open folder icon can be used
to locate files. You may also use pre defined configuration
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commands. See our support page for a list of available op-
tions.

After Use this field to specify (by file path) which application or script
you would like to run after processing a Profile. File paths can
be manually entered, or the open folder icon can be used to
locate files. You may also use pre defined configuration com-
mands. See our support page for a listof available options.

Wait for application to | Check this feature if you want PeerSync to wait for the applica-
end before continuing | tions specified in the "Before" and "After" fields to close before
processing additional tasks.

Use maximum wait Selecting this feature sets a limit (in seconds) for how long
time of x seconds PeerSync will wait for the applications specified in the "Run Be-
fore" and "Run After" fields to close. In order to activate this
function, the "Wait for Application to Terminate" function must
be checked. The default, when this feature is not checked, is to
waitindefinitely.

1.2 Advanced Options

Advanced Options
Migrate Shares MetApp Settings
|.-5.|:I|:I Shares: Do Mot Update or Delete W | Source Configuration. .. |
Copy shares within the source folder to the relative target folder, where non-matching | Target Configurati |
shares within the target folder are left on the target. arget Lonmguration. ..

Global Migrate Shares Options (For All Jobs with Migrate Shares Enabled)
Process Migrate Shares after each scan

[l Process Migrate Shares every | 120 minute(s)

Global Advanced File Xfer Options (For All Jobs)

[] Admin Backup (.. Files that are denied access due to current Permission settings)
[ ] advanced Backup (j.e. Reparse Paints, Sparse, Offiine, Stub Files, etc.)

[ Alternate Data Stream (ADS) Backup

=l Advanced Options
Migrate Shares
NetApp Settings
Global Migrate Shares Options
Global Advanced File Xfer Options

1.2.1 Migrate Shares

Migrate Shares

The following settings can be accessed from the Advanced Options window.

Add Shares: Do Not Copy shares from the source folder to the relative target folder,
Update or Delete where non-matching shares within the target folder are left on
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the target.

Match Shares: Add,
Update and Delete

Copy shares from the source folder to the relative target folder,
where non-matching shares within the target folder are re-
moved.

Replace Shares: Add
and Overwrite

Copy shares from the source folder to the relative target folder,
where existing matching shares on the target system are over-
written.

Add Shares with the
selected Prefix

Copy shares from the source folder to the relative target folder,
with the selected prefix.

Add Shares with the
selected Suffix

Copy shares from the source folder to the relative target folder,
with the selected prefix.

1.2.2 NetApp Settings

NetApp Settings

The following settings can be accessed from the Advanced Options window.

Source Configuration

Provide the Username and Password log on settings for the
Source cDOT system. Optionally, the Management IP ad-
dress can also be provided. Click the Get Info button to validate
the source system information. These settings are necessary if
trying to Migrate Shares from a cDOT source system.

Target Configuration

Provide the Username and Password log on settings for the
Target cDOT system. Optionally, the Management IP ad-
dress can also be provided. Click the Get Info button to validate
the target system information. These settings are necessary if
trying to Migrate Shares to a cDOT target system.

Global Migrate Shares Options

Global Migrate Shares Options (For All Jobs with Migrate Shares Enabled)

The following settings can be accessed from the Advanced Options window.

Process Migrate
Shares after each
scan

If the Migrate Shares option is checked, this setting will pro-
cess the selected share migration setting after each scan.

Process Migrate
Shares every x
minute(s)

If the Migrate Shares option is checked, this setting will pro-
cess the selected share migration setting every x minutes.

Global Advanced File Xfer Options

Global Advanced File Xfer Options (For All Jobs)

The following settings can be accessed from the Advanced Options window.

Admin Backup

Provides the ability to replicate files and folders that are denied
access because of their current ACL settings.
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Advanced Backup

Select this option to replicate files such as Symantec Enter-
prise Vault stub files or files/folders which may be Reparse
Points, Sparse, Offline, Stub Files, etc.

Alternate Data Stream

(ADS) Backup

Replicate hidden Alternate Data Streams (ADS) which may be
stored behind a filename.

1.3 PeerSync Global Settings

PeerSync Global Settings

The Global Settings section contains features that apply
to the entire Profile (all selected Jobs).

Following is a list of Global Settings that can also be found on other screens:

Global Recovery/Offline Options

Global Performance Options

Global Permission Options

Global Bi-directional Options

Global Managed Files Options

Current Command Line Argument Selection

=I PeerSync Global Settings

Global Recovery/Offline Options
Global Performance Options

Global ACL Options

Global Bi-directional Options
Global Managed Files Options
Current Command Line Argument Selection

Options/Commands

1.3.1 Global Recovery/Offline Options

menu.

Retry Open and Inaccessible Files

The following settings can be accessed from the Global Settings window. Alternatively you
can access them from the Options >"Global Settings" > "Global Recovery/Offline Options"

Retry open/inaccess-
ible files every x
seconds

Use this feature to specify, in seconds, how often PeerSync will
attempt to synchronize Source Files that are in use. If the "In-
clude open files" option on the Eile Options screen has not
been checked and "Retry" is selected, PeerSync will continue
attempting to synchronize files thatare opened by other applic-
ations. "Retry" will also work when "Include open files" has
been checked and a file is read-locked by another application.
When the "Retry" option is on, PeerSync will synchronize the
open file within x seconds after the file has been closed.
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Set maximum number | This feature sets a limitindicating how many times to attempt to
of retries to x process open files. If the maximum number of retries gets ex-
ceeded for a particular file PeerSync will remove it from the
retry-list until another real-time event occurs on the file ora scan
detects that the file needs to be added/updated. Setting the
retry cycle to 0 will check the file indefinitely.

Failed Connection Options

The following settings can be accessed from the Global Settings window. Alternatively you
can access them from the Options >"Global Settings" > "Global Recovery/Offline Options"
menu.

Retry failed connec- PeerSync monitors persistent Jobs (Real-Time, scheduled, in-
tions every x minutes | terval) for connectivity, and suspends the Job until a connection
is resumed. This allows PeerSync to ensure that synchroniza-
tions are only attempted when a connection exists. This feature
is set by defaultto a 1 minute interval and can be modified or
disabled.

Run a scan onrecon- | This feature will initiate a full scan at reconnect to process any
nect (if needed) file/folder changes which may have occurred during the con-
nection failure. A scan will be performed only if a failure occurs
in the middle of scan orifa scan was missed when the connec-
tion was lost.

Store missed events | This feature pertains to any Job running in a Real-Time mode.
and process on re- Having this option enabled will store Real-Time events during
connect failed connections and will process these events at Reconnect,
eliminating the Source/TargetFolderscan.

Note: These settings are Global. Global Settings are global to the cumrent Profile. These settings and options pertain
to all of the Jobs in the cument Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/ Commands
screen.

1.3.2 Global Performance Options

Global Performance Options

The options listed on this page can be accessed by clicking on the "Global Performance
Options" link on the PeerSync Global Settings window as well as the Options/Commands
window and the Options menu. Please visit Global Performance Options for more informa-
tion on this topic.

Set Application Prior- | Ifthis feature is selected, anicon will appear on the system tray
ity when PeerSync is loaded. When you right/click on this icon a
menu will appear. Through this menu the Profiler can be shown,
the About PeerSync screen can be accessed, and PeerSync
can be terminated. Once this dialog has opened, it gives you
the ability to Set the Application Priority allowing PeerSync to
run ata higher orlower priority then other applications.
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Use Multiple Job
Threads / Set max-
imum number of Job
threads to x (Multi

Threading)

This option is accessible with the Multi-T hreading add-on mod-
ule available for the Server version of PeerSync only. Enable
this option to allow multiple Job threads to be used for parallel
processing of Jobs. Without this feature each Job will run se-
quentially in the order itis listed, scheduled to run, or in the or-
derthatevents are received.

Use Multiple Copy
Threads / Set max-
imum number of Copy
threads to x (Multi
Threading)

This option is accessible with the Multi-T hreading add-on mod-
ule available for the Server version of PeerSync only. Enable
this option to allow multiple Copy Threads to copy multiple files
in parallel processes (i.e. Simultaneous Distribution - Synchron-
izing from one server to multiple servers simultaneously in a
Web Farm type environment).

Use Enhanced Event
Processing

This option provides the ability to parallel process real-time,
retry or any other non-scan events. Enabling this feature will im-
prove the speed of synchronization during real-time or any
other non-scanning scenarios.

Exclude Common Job
Exceptions in Event
Processing

This option checks the global exclusions list before file hits
such as before event processing and before adding the event
to the visual list. The command line argument for this option is /
QR.

Notes:

1.

These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to
all of the Jobs in the cumrent Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/ Commands
screen.

Some features described on this page require the Multi Threading Option. Please visit http:// www.peersoft-

ware.com or contact Sales for additional information.

Using Multiple Job Threads will produce a different file output format for all modes of reporting and message log-
ging (Reporting, Admin Reporting and Email Reporting). The output will NOT contain a start and stop section or
a summary, each entry will also be initially marked with a date and time stamp. If use summary is selected for Ad-
min or Email reporting then the standard selection will be used. The reason this is done is due to the fact that
processes will be running in parallel.

We have exhaustively tested PeerSync operations using 50 Job threads and 10 Copy threads. Setting your
threads over this limit may lead to potential operational issues. We strongly discourage the use of more then 50
threads, however, you do have the option to exceed this limit by placing a greater than symbol ">" before your
desired thread value (maximum allowed is 200). We recommend you test your setting to ensure PeerSync con-
tinues to operate acceptably in your environment.

The Include open files (if possible) option should be used if you are using the Performance Options: Multiple Job
Threads and Multiple Copy Threads.

When setting the Application Priority to High, PeerSync will use more then average CPU, you may want to use
the Set Processor Affinity argument in this scenario.

1.3.3 Global ACL Options

Transfer Permissions Options

This screenis activated by clicking on the Global Settings link located to the right of the
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ACL Options button in the Permissions window as well as from the PeerSync Global Set-
tings window or the Options menu. T his window has the following features:

Monitor File Permis- This global feature will enable real-time monitoring to detect
sion changes during and process file permission changes.
real-time

Monitor Folder Per- This global feature will enable real-time monitoring to detect
mission changes dur- | and process folder permission changes.
ing real-time

Check for Permission | This global feature will validate and apply file and folder per-
changes during scans | mission during scans.

Notes:

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to
all of the Jobs in the cumrent Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/ Commands
screen.

2. The Monitor Folder Permission changes during real-time option tums on/ off the /LG1 command line
argument.

3. If you enable or disable Inheritance at the folder level, these changes will only get replicated during a scan.

1.3.4 Global Bi-directional Options

Global Bi-directional Options

This screen is activated by clicking on the Global Settings link located to the right of the
Bi-directional option in the File Options window as well as from the PeerSync Global Set-
tings window or the Options menu. This window has the following features:

Always create a su- This feature will alter the way the Enable bi-directional syn-
per-set during bi-dir- | chronization mode option functions by always creating a super-
ectional synchroniza- | setofthe data on the source and target. In this mode folders
tion and files will always be added and notdeleted.

Use enhanced bi-dir- | This feature will alter the way the Enable bi-directional syn-
ectional synchroniza- | chronization mode option functions by using enhanced features
tion mode options to track all file and folder adds, updates, deletions, renames
and moves between scan cycles. In this mode, PeerSync will
use a hidden system trigger file within each sub-folder to store
information about the last scan cycle for that sub-folder. Using
this trigger file, PeerSync can determine ifa Folder was added,
deleted, renamed or moved since the lastscan.

Note: This feature is not supported when using the Enhanced Scan-
ning option.

Notes:

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to
all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the
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PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/ Commands
screen.

2. Please refer to our White Papers page for step-by-step tutorials to achieve realtime or scheduled bi-directional
synchronization.

3. When the "Always create a super-set during bi-directional synchronization" option is NOT selected (i.e. doing
standard or enhanced bi-directional synchronization) we recommend you add /YO- and /QYD:0 to your list of
command line arguments. These options will ensure that during standard or enhanced bi-directional synchroniza-
tion, deleted files from one side are not re-added by the other side. These arguments should NOT be used if
there are more than two machines involved in a bi-directional synchronization.

1.3.5 Global Managed Files Options

File Manager Interval

By clicking on the Global Settings link from the Managed Files window you will be able to
configure the File Manager Interval option. Alternatively you can access this screen
from theGlobal Settings window or from the Options menu.

PeerSync uses the Volume Shadow Copy Service (VSS) in order to allow synchronization
of open/locked files. In order to enable this feature you will require the Managed Files add-
on module. Developed by Microsoft, VSS is a storage management framework designed
to create a point-in-ime copy/snapshot of a volume. This method works well with applica-
tions thatare VSS compliant. VSS does not support Novell NetWare systems.

Run Managed Files By defaultthe Managed Files is setto run on an interval of 120
List Manager every x | minutes. This interval may be changed by simply changing the
minutes interval time. By default, Managed Files will run atthe end of the
initial scan if Scan Job once at start is enabled. Subsequent
open and locked files detected in real-time or during scans will
be thrown into the Managed Files list to be processed based
on the Managed Files interval.

Notes:

1. These settings are Global. Global Settings are global to the current Profile. These settings and options pertain to
all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/ Commands
screen.

2. These options require the YSS add-on module. Please visit http:// www.peersoftware.com or contact Sales for addi-
tional information.

3. The minimum Managed Files interval is 30 minutes.
4. This feature only works for local Source folders.

1.3.6 Current Command Line Arguments

Global Command Line Arguments List

From the Options/Commands window, double-clicking on the "Command Line Arguments"
filed or selecting the button to the right of it will open the Command Line Arguments dialog.
The Command Line Arguments dialog can also be accessed from the PeerSync Global
Settings window as well as from the Options/Commands window or the Options menu.
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Command Line Argu- | In this dialog you can modify, add or delete arguments to be
ments used when launching PeerSync through any of the modes de-
scribed in the Startup/Service screen or via the Run/View Cur-
rent Profile Activity screen. This dialog displays the current ar-
guments selected for the Profiler and will also allow for the se-
lection and modification of additional Command Line Argu-
ments by double-clicking this field or selecting the Current Ar-
guments Button to the right of the field.

Note: These settings are Global. Global Settings are global to the cument Profile. These settings and options pertain
to all of the Jobs in the cument Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/ Commands
screen.

1.3.7 Options/Commands

OptionsCommands
Display /Reporting Options - All Jobs
Show tray icon | Set Access Password. .. |
Enable display options | Display Options... |
Enable reporting options | Reporting Options. .. |

Performance Options - All Jobs
IUse Multiple Job Threads - Set maximum number of threads to: EI

IJse Multiple Copy Threads - Set maximum number of threads to:
Ize Enhanced Event Processing
[ ]set Application Priority

Command Line Arguments

|,-M /TD /6L LM1:080:C30 YLP JOR MFT:5 MCT:10 /A /Q75 LZRA /Q7MS /GYV120 R JUDDSMCR ,."QI-"“Z'

=l Topics
Display/Reporting Options
Performance Options
Command Line Arguments

Profiler Options

Options located on this screen can be accessed from the Options/Commands > Display
Options window and the Options > Global Settings > Display Options menu.

Enable Basic Display | This feature will have PeerSync open the Profiler, if it is not
already open, and send status messages to be displayed on

the Run/View PeerSync screen.

Enable Advanced This option activates the Show Advanced Display link at
Display the bottom right cormer of the Run/View PeerSync screen.
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When this link is clicked, the PeerSync Advanced Display
panel will be shown. The advanced display contains a Jobs
Stats panel on the top and an Advanced Run/View Peer-
Sync panel atthe bottom. The command line argument to dis-
able this option is /QQ<<.

PeerSync Options (Application Runs Only)

Options located on this screen can be accessed from the Options/Commands > Display
Options window and the Options > Global Settings > Display Options menu.

Display status in
PeerSync

This feature will show the PeerSync Status Display dialog
box during synchronization to view activity, status and other in-
formation while PeerSync is running.

Display status in
PeerSync upon com-
pletion

This feature will have PeerSync pop-up the PeerSync Status
Display dialog at the end of synchronization (only in non-per-
sistent modes) to view activity, status and other information
upon completion.

Profiler/PeerSync Options

Options located on this screen can be accessed from the Options/Commands > Display
Options window and the Options > Global Settings > Display Options menu.

Job Stats This feature allows forthe Jobs Stats panel in the PeerSync
Advanced Display to getupdated. Use /QP to disable this
option via the command line.

Job Scans When enabled, this option adds a Job Scans tab to the Ad-

vanced Run/View PeerSync panel. This table lists Base/
Root, Enhanced/Expanded, and RT/Sub-folder scans with stat-
istics and progress for all the Jobs or only the selected Job.
The command line argument for this option is /Q8BJ+.

File Copy Progress

This feature will show the progress of a file transfer in the Peer-
Sync Status Display or the Advanced Run/View Peer-
Sync panel. This feature requires the Multi-Threading Option.
The command line argument for this option is /QQ.

Historical Data

When enabled, this option adds a Historical Data tab to the
Advanced Run/View PeerSync panel. This tab contains a
subset of data from the PeerSync Jobs Stats panel (Xfer
Rate, Bytes and Event Averages) and is broken down into
total, hourly, daily, and weekly statistics for all the Jobs or only
the selected Job. The command line argument for this option

is /Q8BH+.

Peer Administrator Options
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Options located on this screen can be accessed from the Options/Commands > Display
Options window and the Options > Global Settings > Display Options menu.

Send status informa- | This will send statistical information about the current Profile to
tion to Peer Adminis- | the Peer Administrator if it is installed/available. This utility al-

trator lows for the ability to monitor PeerSync activity across the LAN
for the centralized viewing of all PeerSync activity on the net-
work.

= Related Options
Performance Options
Command Line Arguments

Notes:

1. These settings are Global. Global Settings are global to the cumrent Profile. These settings and options pertain to
all of the Jobs in the current Profile and are used to define, configure and execute the launch of Profiles via the
PeerSync engine. Arguments to be sent to PeerSync can be selected and setup from the Options/ Commands
screen.

2. Some features described on this page require the Multi Threading Option. Please visit http:// www.peersoft-
ware.com or contact Sales for additional information.

2. PeerLock
2.1 PeerLock Job Settings

PeerLodk Job Settings
Job Settings
[ ]indude this Job in PeerLock

Append Default FilefFolder Exdusions from PeerLock

=l Topics
PeerlLock Job Settings Overview

2.1.1 PeerLock Job Settings Overview

PeerLock Job Settings
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Ifyou are running PeerLock v2.0.1 or newer on the same machine as PeerSync you will now
be able to configure PeerLock directly from the PeerSync Profiler. The following options al-
low youto link the selected Job to PeerLock as well as append the PeerSync exceptions
to PeerLock. The options in this window can be accessed from the PeerLock > Peerlock

Job Settings window.

Include this Job in Select this checkbox to automatically add the selected Job to
PeerLock PeerLock. This option can be enabled automatically when se-
lecting the Bi-directional setting. In general PeerlLock is used in
a collaboration environmentwhere PeerSync is configured for
real-time bi-directional synchronization.

Append Default File/ | This optionis enabled by default. When checked, the Peer-

Folder Exclusions Sync Exception settings (Include Files, Exclude Files, and Ex-
from PeerLock clude Folders) will be appended to the default/existing list of

Exceptions in PeerLock.

Note: PeerLock supports the usage of Windows System and Registry variables in the Source and Target fields (i.e.
Y%UserName%, %ComputerName%,). Custom PeerSync variables such as %JobName% are currently not supported
and will not work in PeerlLock.

2.2 PeerLock Global Settings

PeerLock Global Settings
Global Settings
[ Link this Profile to PeerLock

Disable J fi

D Jol red from this Profile

bs that are Mot Configurec

Related Global Settings

Show PeerLock - Version: Unknown (Mot Installed or Invalid Path)

=l Topics
Peerlock Global Settings Overview

2.2.1 PeerLock Global Settings Overview

PeerLock Global Settings

If you are running PeerLock v2.0.1 or newer on the same machine as PeerSync you will now
be able to configure PeerLock directly from the PeerSync Profiler. The following options al-
low you to add the selected PeerSync Jobs to PeerLock and launch the PeerLock applica-
tion or Global Options for configuration. The options in this window can be accessed from
the PeerLock > PeerlLock Global Settings window.
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Link this Profiler to If this global setting is enabled, all the Jobs that have the "In-
PeerLock clude this Job in PeerLock" option selected will be added to
PeerLock. These Jobs in PeerLock willbe managed by Peer-
Sync and cannotbe edited/removed directly from the Peer-
Lock interface. Un-checking this option will remove all Peer-
Sync managed Jobs from the PeerLock interface.

Disable Jobs that are | Selecting this option then saving the PeerSync Profiler or click-

Not Configured from ing on the "Save Changes in PeerLock" link will remove/delete

this Profiler any existing Jobs from the PeerlLock configuration. Only Jobs
thatare managed by PeerSync will be maintained.

Save Changes in Click on this link to commit your PeerSync Job/Profile updates

PeerLock to PeerLock. This link becomes available when you make Job

or Profile changes thatneed to be saved and applied to Peer-
Lock (i.e. Source/Target path update, Exceptions, ...). This can
be achieved also by clicking on the Save button from the Tool-
barorFile Menu. If there are no Profile updates to be saved,
this link will be unavailable.

Global Options Selecting this link will open the PeerLock Global Options dia-
log that contains the configuration settings for all the Jobs in
PeerLock. When the application is terminated/closed this link
will become available.

Show PeerLock You can run PeerLock as an application oras a service. Click-
ing on this link will launch the PeerLock interface where you can
start PeerLock to run as an application oras a service. You
can also start/stop the PeerLock service directly from the Peer-
Lock Run/View window in the PeerSync Profiler.

Through the PeerLock interface you will be able to view the
files thatare Locked or Released by PeerLock wheniitis run-
ning as an application. This status information is notavailable
when PeerlLock is running as a Service. The PeerLock Jobs
thatare managed by PeerSync will be un-editable. When the
application is terminated/closed this link will become avail-
able.

Note: You will need the Peer Administrator product In order to view the Peer-
Lock status while running as a service.

Notes:

1. These settings are Global. Global Settings are global to the cumrent Profile. These settings and options pertain to
all of the Jobs in the current Profile.

2. PeerlLock supports the usage of Windows System and Registry variables in the Source and Target fields (i.e. %
UserName%, %ComputerName%). Custom PeerSync variables such as %JobName% are currently not supported
and will not work in PeerLock.
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3. Startup/Service
3.1 PeerSync Startup/Service

Status |U|:u:|ated I Added I Deletions I Excuded I Messages | Job Scans | Failled Events | Historical Data | Job Control

Profile: HQ_Profile
Job: NJA - Multiple Job Threads Enabled
Mode: Automatic and Real-Time (Persistent)

Scanned Folders: 234 of 1085 ]
sameiries. w6 of v
Samedsyes sm® of bose I

Chedked: 5206 Updated: 200 Current Job Status: Mormal
Exduded: 13 Added: 0 Pending Event Status: No Pending Items
Messages: 0 Deleted: 0 Current Event Status: Running Items (Job Scans: 2) (Expanded Scans: 9) (Scan
Synchronizing folder: IMAGES Total Transferred: 23.43MB - 00:00:13
=l Topics

PeerSync Startup/Service Overview

3.1.1 PeerSync Startup/Service Overview

PeerSync Startup/Service Options

The options in this window can be accessed from the "Startup/Service" > PeerSync Star-
tup/Service window. T his screen allows the user to specify whether or not PeerSync will be
run upon startup of the active PC, while also defining its interaction with the network (if ap-
plicable). This screen provides shortcuts for installing PeerSync as a service, adding it to
the Windows StartUp list, or to the Windows registry for automatic loading upon startup.

Disable all Startup Check this feature to prevent PeerSync from automatically
Options loading at Windows startup/logon.

Create Shortcut on This button will place the current Profile into a shortcut on your
Desktop desktop (See "Scan at Start of Profile List," Options/Com-

mand). A Profile Shortcut will need to be created through this
feature in order to use PeerSync's Command Line Mode.

Add to Windows This button opens the Windows StartUp folder, showing links to
StartUp files and programs that open automatically upon user logon.
This button is only accessible when "Add to Windows Startup
Folder" is checked.

Add to Windows re- Check this feature if you want PeerSync to run automatically

gistry when Windows boots through specification in the Windows re-
gistry.

Run RegEdit This button opens the Windows Registry Editor. This button is
only accessible when "Add to Windows registry to run at boot"
is checked.

Install as an NT Ser- | Check this feature if you want PeerSync to run automatically as
vice a service under Windows NT. Click here for a Tutorial on how
to install PeerSync to runas an NT Service.
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To configure and run the service you mustgo to "Services" loc-
ated in the "Control Panel" and select"PeerSync Professional
Series Software." By defaultthe service is installed with the
"Local System account' selected for the service "Log on as:"
option.

Caution: If any of your Source or Target Folder Selections are not located on
the local machine, then you will have to configure the service to "Log on as:"
an altemate (Domain Admin) account on your domain so that the service has
the rights to access the remote machines and/ or devices. If you do not do this
the service may not run properly.

Notes:

1. If PeerSync is running as a Service it is advised to use UNC paths or Peer-
Sync's Dynamic Network Drive Mapping and Unmapping feature instead
of using mapped drives do to the fact that mapped drives are not under-
stood when a user is not logged on.

2. You can add the argument /LSE (Log Service Events to NT Application
Log) to the following entry in the registry (HKEY_LOCAL_MACHINE\ Soft-
ware\ PeerSoftware\ PeerSync\ Service\ Parameters). This will have Peer-
Sync log all changes to be reported to application log in addition to the
nomal logging of the start, stop, pause and continue of the service.

3. If PeerSync is running in Real-Time mode as a service, subsequent real-
time Profiles will interfere with service operation and should not be em-
ployed. Both Scheduled Operations and Manual (non-persistent) opera-
tions should perform without interference to a service installation of Peer-
Sync.

4. The service can run without any Jobs configured or selected.

Details This button is used to view the details of the currently installed
PeerSync service.
Remove This button is used to remove the currently installed PeerSync

service.

Create SNC extension
association for Pro-
filer

Checking this feature causes any file with the extension .SNC to
be associated with PeerSync: PeerSync Profiles bear this ex-
tension by default. Once this feature has been selected,
double/clicking on any SNC file will open Profiler and load that
particularfile.

Add Quick-Sync
Folder option to Ex-
plorer menu

Checking this feature adds or removes the Quick-Sync Folder
selection from Windows Explorer. This feature is a quick and
easy way to synchronize folder(s) on the fly to backup loca-
tion(s) with the option to modify your Job settings ata latertime.

PeerSync Application
Path

This field is used to specify the location of the PeerSync ex-
ecutable file. You can use the open folder icon to browse
drives in order to locate this executable file.

Starting Profiles

The following describes ways in which PeerSync can be launched or started.
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From the Profiler

Toolbar

By using the Launch Profile Menu ltem in the Run Menu
By using the Launch Current Profile button on the Tool Buttons

By using the Launch Current Profile button on the Run/View Cur-

rent Profile Activity screen

Profiler

Externally without the

Setup/run from a Shortcut on the Desktop
Setup/run from the Startup Folder
Setup/run atbootfrom the Registry
Setup/run as a NT Service
Setup/run using the Windows Task Scheduler

Notes:

1. Individual Jobs can be synchronized using the 'Synchronize Selected Jobs' feature, found in the Profile Job List
Popup Menu.

2. Another way of running PeerSync is by using the

Windows Explorer.

3.2 PeerlLock Startup/Service

Tldmo deo

£

Target File Path
\1192. 168.
\\192. 168.
11192 168.
11192, 168,
11192, 1568,
11192, 168,
11192, 165,
192, 153,
\\192. 168.
V1192 158.
\\192. 168.
\\192. 168.
11192, 168,

171,
171,
171,
171,
171,
171,
171.
171,
171,
171,
171,
171,
171,

A=rd

Locked Files: 21 | Released Files: 17

uick-Sync Folder feature by right-clicking on a folder from MS

142e5\BIM & CAD Projects\Civil3D\Sym. ..
142e5\BIM & CAD Projects\Civil3D\Map. ..
142\e8\BIM & CAD Projects\CADVArchit...
142'e2'\BIM & CAD Projects\Civil3DYMec. ..
142'e$\BIM & CAD Projects\CAD\Archit. ..
142'e$\BIM & CAD Projects\CAD\Archit...
142\e$\BIM & CAD Projects\CAD\Archit. ..
142'e5'\BIM & CAD Projects\Civil3D'\Mec. ..
142\e8\BIM & CAD Projects\CAD\CvilP. .
142\e$\BIM & CAD Projects\CAD\Archit...
142e5'\BIM & CAD Projects\Civil3D\Mec. ..
142\e8\BIM & CAD Projects\CADArchit...
142'22'BIM & CAD Projects\Civil3DYSym. ..

ANl ALCTEA B A e oL e

Locked

1/27/2015 10:54:34...
1/27/2015 10:54:34...
1/27/2015 10:54:34...
1/27/2015 10:54:34...
1/27/2015 10:54:34...
1/27/2015 10:54:34...
1/27/2015 10:54:35...
1/27/2015 10:54:35...
1/27/2015 10:54:35...
1/27/2015 10:54:35...
1/27/2015 10:54:35...
1/27/2015 10:54:35...
1/27/2015 10:54:35...

AfmTinmAr dm.raAar

Duration

00:00:
00:00:
00:00:
00:00:
00:00:
00:00:
00:00:
Qo:00:
00:00:
00e00:
00:00:
00:00:
00:00:

LY .Y

Accessed By
monikac
monikac
monikac
monikac
manikac
manikac
manikac
monikac
monikac
monikac
monikac
monikac
monikac

>

= Topics
Peerl ock Startup/Service Overview

3.2.1 PeerLock Startup/Service Overview

window.

PeerLock Startup/Services Options

If you are running PeerlLock v2.0.1 or newer on the same machine as PeerSync you will now
be able to configure PeerLock directly from the PeerSync Profiler. This window provides a
way in which you can install the PeerLock service directly from the PeerSync Profiler inter-
face. The options can be accessed from the "Startup/Service" > PeerlLock Startup/Service
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Install PeerLock Ser- | Check this feature if you want PeerLock to run automatically as
vice a service under Windows NT. To configure and run the service
you mustgo to the Services window by clicking on the "Details"
>"Show Services" button and select"PeerlLock Utility Soft-
ware" item. By defaultthe service is installed with the "Local
System account". If your Source or Targetfolderis notlocated
on the local machine, then you will have to configure the ser-
vice to "Log on as:" an alternate (Domain Admin) accounton
yourdomain so thatthe service has the rights to access the re-
mote machines and/or devices. Otherwise the service may not
run properly.

Note: It is advised to use UNC paths if you plan to run PeerSync or PeerLock
as a Service do to the fact that mapped drives are not understood when a user
is not logged on.

Details This button is used to view the details of the currently installed
PeerlLock service.

Remove This button is used to remove the currently installed PeerLock
service.

PeerLock Path This field is used to specify the location of the PeerSyncPeer-

Lock executable file. You can use the open folder icon to
browse drives in order to locate this executable file.

Note:
PeerLock supports the usage of Windows System and Registry variables in the Source and Target fields (i.e. %User-

Name%, %ComputerName%). Custom PeerSync variables such as %JobName% are currently not supported and will
not work in PeerlLock.

4. Run/View
4.1 PeerSync Run/View

Status |U|:|dated I Added I Deletions I Exduded I Messages | Job Scans | Failed Events | Historical Data | Job Control

Profile: HQ_Profile
Job: M/A - Multiple Job Threads Enabled
Mode: Automatic and Real-Time (Persistent)

Scanned Folders: 234 of 1085 _
SamedFies: w0 of vz
Somedbyes: 57968 of 003Ge

Chedked: 5206 Updated: 200 Current Job Status: Mormal
Exduded: 13 Added: 0 Pending Event Status: No Pending Items
Messages: 0 Deleted: 0 Current Event Status: Running Items (Job Scans: 2) (Expanded Scans: 9) (Scan
Synchronizing folder: IMAGES Total Transferred: 23.43MB - 00:00:13
= Topics
Basic Display

Advanced Display

Copyright © 1993-2016 Peer Software Inc. All Rights Reserved



PeerSync Help 116

4.1.1

Basic Display

Run/View PeerSync - Basic Display

PeerSync canbe run as an Applicationoras an NT Service, if available and installed from
the Startup/Service screen.

This screenis used to launch the current Profile and to view current Profile activity. Ifthe Dis-_
play Status in Profiler option is turned on from the Options/Commands screen this screen
will be shown upon execution of a Profile and will dynamically show the status of synchron-
ization of the current Profile as the process occurs. This screen will also be shown upon us-
ing the Synchronize Selected Jobs feature, found in the Profile Job List Popup Menu to dis-
play the Current Activity of the Jobs sentto PeerSync as a temporary Profile.

Profile Displays the name of the Profile actively being processed.
This label may not match the name of the Profile currently be-
ing configured through Profiler.

Job This indicator will dynamically display the name of whichever
Job is presently being processed for the Active Profile.

Mode This indicator will dynamically display the name of whichever

Job is presently being processed for the Active Profile.

Launch Current Pro-
file/Terminate Active
Profile

This button allows you to launch the current Profile. Once a
Profile has been launched, its processing may also be termin-
ated through this button (the label will change to read "Termin-
ate Active Profile"). This button offers one of three ways to initi-
ate an Automatic Operation.

View Active Profile

This button allows you to connect to and view the Active Pro-
file.

Run as a service

If PeerSync is installed as a Service you have the option of
running itas an Application or as a Service from this screen.

Start/View Service

This button allows you to start the current Profile as a Service
orview the Active Profile. Itis only visible if PeerSync was in-
stalled as a service.

Stop Service

This button allows you to stop the current Profile as a Service.
Itis only visible if PeerSync was installed as a service.

Pause Service

This button allows you to pause the current Profile as a Ser-
vice. ltis only visible if PeerSync was installed as a service.

Resume Service

This button allows you to resume the current Profile as a Ser-
vice. ltis only visible if PeerSync was installed as a service.

Scanned Folders

Displays the total number of folders that have been scanned
using a representation of X of Y, where X indicates the number
offolders thathave been scanned so farand Y represents the
total number of folders that need to be scanned. When the X
and Y values match, the scanis considered as complete. The
progress bar to the right of these values is a visual represent-
ation ofthe folders thathave been scanned. These values are
reset on subsequent scans if applicable and do not include
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excluded folders.

Scanned Files

Displays the total number of files that have been scanned us-
ing a representation of Xof Y, where Xindicates the number of
files thathave been scanned so far and Y represents the total
number of files that need to be scanned. When the X and Y
values match, the scan is considered as complete. The pro-
gress barto the right of these values is a visual representation
of the files that have been scanned. These values are reset
on subsequent scans if applicable and do not include ex-
cluded folders.

Scanned Bytes

Displays the total number of bytes thathave been scanned us-
ing a representation of Xof Y, where Xindicates the number of
bytes that have been scanned so far and Y represents the
total number of bytes that need to be scanned. When the X
and Y values match, the scanis considered as complete. The
progress bar to the right of these values is a visual represent-
ation of the bytes that have been scanned. These values are
reset on subsequent scans if applicable and do not include
excluded folders.

Large File or Com-
pression Status

This caption will be displayed to the right of the file name that
is currently synchronized for large files and during compres-
sion. The caption will show the size of the file that has been
copied to the Targetand/or compression status.

Checked This indicator displays the total number of files contained in
the selected Source Folders.

Excluded Indicates the number of files that were excluded from syn-
chronization (See Exceptions).

Messages Indicates the number of error messages generated during
Profile processing.

Updated Indicates the number of Target Files that were updated during
synchronization of Profile Jobs.

Added Indicates the number of new files added to TargetFolders dur-
ing synchronization of Profile Jobs.

Deleted Indicates the number of files deleted (or moved) during syn-

chronization of Profile Jobs.

Current Job Status

This indicator displays the status of the active Job. The indic-
ator may display one of the following: Blackout, Source/Tar-
get disconnected (Job name), Connecting to Target Folder
(Folder), or Normal.

Pending Event Status

This indicator displays the number of pending items.The indic-
atormay display one of the following: Pending ltems (Events:
n) (Managed Files: x) or No Pending ltems

Current Event Status

This indicator display the status of the events pertaining to
Job/Copy thread information or Job automation (such as next
scheduled interval, daily timer info etc.). The indicator may
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display one of the following: Running ltems (Job Scans: x)
(Copy Threads:y) (Failed Events: 2)

Total Transferred Indicates the the total amount of bytes transferred for the entire
running Profile.

Elapsed Time Indicates the amount of time that has elapsed during the cur-
rent Profile activity.

Show Advanced/ Click on this link to toggle between the Normal and Ad-

Normal Display vanced Run/View PeerSync panels.

Refresh Click on this link to force a manual reload of the Run/View

PeerSync panel and the statistics thatare being displayed.

4.1.2 Advanced Display

Jobs Stats

To see this panel, click on the Show Advanced Display link at the bottom right corner of the
Run/View PeerSync window. The Enable Advanced Display option must be checked in or-
der for this link to be active. The Jobs Stats display is the top panel and contains runtime
statistics for all the Jobs configured within the Profile. Clicking on a Job will update the bot-
tom Advanced Run/View PeerSync panel. Click on the All Jobs entry to display all the
Job statistics, cumulatively, in the bottom panel.

# Represents the automatically assigned Job number for
each Job. An icon represents the state of the Job (Green,
Yellow, or Red):

Green Running with no failed events
Yel- Warning state indicates the Job is running with
low failed events
Red Failed connection and/or offline/stopped
Job Name Lists the unique name for each Job.
Source Displays the path to the source folder.
Target Displays the target path.
Last Scan (Status: Displays the date and time of the last scan along
Duration) with a description of the scan state and duration.

For example: 11/17/2011 4:28:31 PM (Completed
Successfully: 00:06:05)

In Sync Displays whether each Job is in sync. In order for the In Sync
state to be set to Yes, the following criteria needs to be sat-
isfied:

1. There should be zero Failed Events

2. The status starts should be Normal (i.e. source/target not
disconnected and/or not in a Blackout etc.)

3. The Last Scan (Status: Duration) for the Job has Completed
Successfully and does not contain messages
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4. There are zero active events for the Job

5. The In Queue stats for the Job starts with [Processing: 0]
==> [Event File: DNE and contains [In Queue: 0

6. The Scan Needed column value is set to No

Examples of possible In Sync states:

e Yes

e Yes (As of Last Scan)

e Yes (Job Stopped - Manually)

e Yes (Job Stopped - Manually; As of Last Scan)
e No (Failed Events: 1)

e No (See Status for Details)

e No (Scan Running)

e No (Scan Pending)

e No (See Last Scan for Details)

e No (Last Scan has Messages)

e No (Active Events)

e No (Items In Queue)

e No (Scan Needed)

e No (Scan Running; Items In Queue)

Trending Displays information regarding the trending state of the In Sync
column (Up, Down, or Flat). If the number of events within a
cycle is 500 or less, the Trending status will be Flat. If the
number of events increased by 1,000 or more within a cycle,
then the Trending status will be Up. If the number of events de-
creased by 1,000 or more within a cycle, then the Trending
status will be Down.

Notes:

1. The column will show N/A if you have not reached the cycle yet and/or
there is no difference in events within the last cycle.

2. The TrendingUpValue and TrendingDnValue items are event differences
per second for Processing and In Queue event items from the In Queue
stats.

3. To adjust the default values based on desired results (i.e. you may be
stuck in the Flat state too often if you are looking for a difference in
changes), modify the TrendingDnValue and TrendingUpValue values in
the PSDEF.cfg file.

[Misc Options]

TrendingCycle=60
TrendingUpValue=10
TrendingDnValue=10
TrendingAlwaysShowUpDnValue=0

Next Scan (Run in) Count down to the next scan for scheduled or interval scans.

Xfer Rate Determines the transfer rate in megabits per second for each
Job. Takes into account the Event Averages rate and Total
Transferred and Total Saved bytes (bottom right corner of
Run/View PeerSync) to determine the transfer rate for each
Job. The more events and the larger the average file size calcu-
lated in the Event Averages the more accurate the transfer rate
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will be. This also shows a cumulative transfer rate for all Jobs.

Bytes Displays the total number of bytes that were transferred for the
specific Job or all the Jobs.

Events Shows the total number of events detected for the Job or all the
Jobs as well as number of active ewvents currently being pro-
cessed.

Event Averages Displays the average number of events that occurred per minute.

The average size of the events are also noted.

In Queue: Scan

The number of files in queue that are generated by a scan.

In Queue: RT The number of files in queue that are real-time events.

In Queue The total number of files in queue. The queue represents the
backlock of real-time ewvents for each job. When the queue is
empty the In Sync column is set to Yes.

Updated Counter indicating the total number of files that were updated
and their size in bytes.

Added Counter indicating the total number of files that were added and
their size in bytes.

Deleted Counter indicating the total number of files that were deleted and
their size in bytes.

Excluded Counter indicating the total number of files that were excluded
and their size in bytes.

Messages Counter indicating the total number of messages.

Failed Events

The number of failed events for each Job or all Jobs.

Real-Time

Displays the state of Real-Time detection (On or Off).

Interval Scans

Information when the next interval scan is to occur.

Daily Timer Scans

Information when the next scheduled scan is to occur.

Status

Shows the status of each Job or all Jobs.

Scan Needed

Lets you know if a scan is needed (Yes) or not (No) after a con-
nection failure.

Log File Path

Displays the location of the log file. Used in pop-up menu.

Jobs Stats (Right-Click Pop-Up Menu)

To see this menu, right-click on the Job Stats panel.

Select Columns....

Add or remove columns from the Jobs Stats display.

Scan Job: JobName

Issues a one-time scan of the selected Job.

Scan All Jobs

Issues a one-time scan of all the enabled Jobs in the Profile.
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Stop Job: JobName

Stop the selected Job without stopping or interrupting any other
potentially running Jobs in the Profile.

View Log File

View the log file for the selected Job.

Path

Open Source Folder:

Opens the source folder in a Windows Explorer window.

Open Target Folder:
Path

Opens the target folder in a Windows Explorer window.

Save As

Sawves the current Jobs Stats list into a CSV file format (i.e.
PSJobStats.csv).

Reprocess Failed
Events

If the Job is running in a Warning state (Yellow), the Job has
failed events. Selecting this option will notify PeerSync to re-pro-
cess any failed events. This option is also available in the Run
menu.

Advanced Run/View PeerSync

To see this panel, click on the Show Advanced Display link at the bottom right corner of the
Run/View PeerSync window. The Enable Advanced Display option must be checked in or-
der for this link to be active. The Advanced Run/View PeerSync display is the bottom
screen. In addition to containing the same information as the Basic Display, the Advanced
Display contains the following additional tabs:

Status

Containing the same information as the Basic Display view/
panel.

Updated

Lists the total number of files that were updated for the selected
Job or all the Jobs. Right-click and select Save As to export the
list into a CSV file format (PSUpdated.csv).

Added

Lists the total number of files that were added for the selected
Job or all the Jobs. Right-click and select Save As to export the
list into a CSV file format (PSAdded.csV).

Deletions

Lists the total number of files that were deleted for the selected
Job or all the Jobs. Right-click and select Save As to export the
list into a CSV file format (PSDeleted.csv).

Excluded

Lists the total number of files that were excluded for the selec-
ted Job or all the Jobs. Right-click and select Save As to export
the list into a CSV file format (PSExcluded.csv).

Messages

Lists the total number of messages for the selected Job or all
the Jobs. Right-click and select Save As to export the list into a
CSV file format (PSMessages.csv).

Job Scans

Lists how many scans are running at a Job level either for the
selected Job or for all the Jobs. Right-click and select Save As
to export the list into a CSV file format (PSJobScans.csv).

Managed Files List

Lists the total number of files that are in the Managed Files
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List for the selected Job or all the Jobs. Right-click and select
Save As to export the list into a CSV file format (PSMan-
agedFilesList.csv).

Failed Events

Lists all the failed files for the selected Job or all the Jobs. You
can right-click the list and select Reprocess Failed Events to
notify PeerSync to re-process them for all the Jobs (not Job
specific). To reprocess only a specific file, you can click the Re-
process Selected button from the Failed Events tab within the
PeerSync Status Display (when running as an application
only). Right-click and select Save As to export the list into a
CSV file format (PSFaileEvents.csv).

File Copy Progress

Visually displays the file copy progress for each file for the se-
lected Job or all the Jobs. Right-click and select Save As to ex-
port the list into a CSV file format (PSFileCopyProgress.csv).

Historical Data

This panel displays a subset of the Job Stats table (Xfer Rate,
Bytes and Event Averages) in an hourly, daily, weekly, and total
format for all the Jobs or only the selected Job. Furthermore, it
displays a Running Event Count, a Running Event Awerage and
Peak Count, and a Running Job Count. Right-click and select
Save As to export the list into a CSV file format (PSHistoric-
alData.csvV).

Job Control

This tab is available from the Advanced Run/View PeerSync
panel. It shows the Job Control Bar which allows every Job to
be stopped, started, or restarted individually. In addition, this
tab displays all Pending Jobs in a grid from where they can be
individually selected and started. This tab can also be seenin
the PeerSync Status Display panel under the Job Stats and
Control tab.

Notes:

For efficiency purposes, only when you click on the screens/ tabs within the Advanced Run/View PeerSync
panel will the values get updated. A Cache folder within the PeerSync installation folder maintains the necessary
event files that will be loaded into the advanced display screens/ tabs.
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4.2 PeerLock Run/View

Locked Files: 21 | Released Files: 17

Target File Path Locked Duration Accessed By | ~
\W192. 168, 171, 142e8'\BIM & CAD Projects\Civil3D\sym... 1/27/2015 10:54:34... 00:00:19 monikac
\\192.168. 171. 142\e$\BIM & CAD Projects\Civil3D\Map...  1/27/2015 10:54:34... 00:00:18  monikac
\\192.168. 171. 142\e$\BIM & CAD Projects\CADVArchit...  1/27/2015 10:54:34... 00:00:18  monikac
\\192.168. 171, 142\e$\BIM & CAD Projects\Civil3D\Mec...  1/27/2015 10:54:34... 00:00:18  monikac =
\\192.168. 171, 142\e$\BIM & CAD Projects\CADVArchit...  1/27/2015 10:54:34... 00:00:18  monikac

\\192. 168, 171, 142'e5'\BIM & CAD Projects\CADVArchit...  1/27/2015 10:54:34... 00:00:19  monikac

\\192. 158,171, 142'e5'\BIM & CAD Projects\CADVArchit...  1/27/2015 10:54:35... 00:00:13  monikac

\\192. 168, 171, 142\eS\BIM & CAD Projects\Civil3D\Mec..,  1/27/2015 10:54:35... 00:00:18  monikac

\\192. 168. 171. 142\eS\BIM & CAD Projects\CAD\CivilP...  1/27/2015 10:54:35... 00:00:18  monikac

192, 168, 171, 142\28'\BIM & CAD Projects\CADVArchit... 1/27/2015 10:54:35... 00:00:15 monikac
\\192.168. 171. 142\e$\BIM & CAD Projects\Civil3D\Mec...  1/27/2015 10:54:35... 00:00:18  monikac
\\192.168. 171, 142\e$\BIM & CAD Projects\CADVArchit...  1/27/2015 10:54:35... 00:00:18  monikac
\\192.168. 171, 142\e$\BIM & CAD Projects\Civil3D\Sym...  1/27/2015 10:54:35... 00:00:18  monikac >
I<I1ﬁ'| E Wl T e I | 1i|'||||i-|n'rl.l O AN Mems e ek L LT e A MMTimmAr An.rAa.ar Fa T P aTa it Fal RSP | P }

=l Topics
Basic Display
Advanced Display

4.2.1 Basic Display

Run/View PeerLock - Basic Display

If you are running Peerl.ock v2.0.1 or newer on the same machine as PeerSync you will now
be able to configure PeerlLock directly from the PeerSync Profiler. This window will allow
you to start/stop/pause/resume the PeerlLock service. Click here for information on how to
install the PeerLock service or run PeerLock as an application. The following options can
be found in the Startup/Service window.

Launch PeerLock This button allows you to launch the PeerLock application and
monitor the files that are Locked or Released by PeerlLock.
When the application is terminated this button will become

available.

Run as a service This option is available only ifthe PeerLock service has been
installed and the Run as a Service option is enabled. Check
this option to run PeerLock as a Service. When checked, you
will have the options to Start, Stop, Pause and Resume the
Service. Uncheck the "Run as a service" option run PeerLock
as an Application. When this option is uncheck you will have a

"Launch PeerLock" button available.

Start Service This button allows you to start PeerLock as a Service. Thisop-
tion is available if the PeerLock service has been installed,
the Run as a Service option is enabled, and the PeerlLock

service is stopped or not running.

Stop Service This button allows you to stop the PeerLock Service. This op-

tion is available if the PeerLock service has been installed,
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the Run as a Service option is enabled, and the PeerlLock
service is running.

Pause Service

This button allows you to pause the PeerLock Service. This
option is available ifthe PeerLock service has been installed,
the Run as a Service option is enabled, and the PeerLock
service is running.

Resume Service

This button allows you to resume the PeerLock Service. This
option is available ifthe PeerLock service has been installed,
the Run as a Service option is enabled, and the PeerlLock
service is paused.

Show Advanced/
Normal Display

Click on this link to toggle between the Normal and Ad-
vanced Run/View PeerLock panels.

Refresh

Click on this link to force a manual reload of the Run/View
PeerLock panel and the statistics thatare being displayed.

4.2.2 Advanced Display

Jobs Stats

To see this panel, click on the Show Advanced Display link at the bottom right corner of
the Run/View PeerLock window. The Enable Advanced Display option must be checked
in order for this link to be active. The Jobs Stats display is the top panel and contains
runtime statistics for all the Jobs configured within the Profile. Clicking on a Job will update
the bottom Advanced Run/View PeerLock panel. Click on the All Jobs entry to display all
the Job statistics, cumulatively, in the bottom panel.

# Represents the automatically assigned Job number for each
Job. An icon represents the state of the Job (Green, Yellow, or
Red):
Green Running with no failed locks
Yel- Warning state indicates the Job is running with
low failed locks
Red Failed connection and/or offline/stopped

Job Name Lists the unique name for each Job.

Locks (Active)

Represents the total number of locks created by the specific
Job. The total number of locks that are actively being held are
also shown.

Releases

Shows the total number of releases created by the specific
Job.

Lock Average

Represents the number of locks that are created on awerage
ever minute for the specific Job.

Release Average

Represents the number of locks that are released on average
ever minute for the specific Job.

Failed Locks

Shows the total number of locks that failed to be created for the
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specific Job.

Status Displays the status of the Job (i.e. Stopped, Starting and
Normal).

Source The folder which is monitored for open activity.

Target The folder which is contains the files for PeerLock to lock.

Jobs Stats (Right-Click Pop-Up Menu)

Select Columns.... Add or remove columns from the Jobs Stats display.

View Log File: Path Open the log file in the default editor for the selected Job.
Open Source Folder: Opens the source folder in a Windows Explorer window.

Path

Open Target Folder: Opens the target folder in a Windows Explorer window.

Path

Save As Sawes the current Jobs Stats list into a CSV file format (i.e.

PLSelectionList.csv).

Advanced Run/View PeerLock

To see this panel, click on the Show Advanced Display link at the bottom right corner of
the Run/View PeerLock window. The Enable Advanced Display option must be checked
in order for this link to be active. The Advanced Run/View PeerLock display is the bot-
tom screen. In addition to containing the same information as the Basic Display, the Ad-
vanced Display contains the following additional tabs:

Target File Path Shows the file name complete with folder path for a target file
that is locked, if the file exists and/or can be locked.

Locked Display the date/time when the target file was locked.

Duration Displays the amount of time that the source file has been
opened.

Accessed By The name of the user who has opened the file or accessed the
resource.

Target Access Al- Displays the permissions that are allowed on the opened target

lowed file which are applied by PeerlLock.

Source File Path Displays the file name complete with folder path for the source
file that has been detected as an open file.

Job Number Represents the automatically assigned Job number for each
Job.

# Locks Displays the number of locks on the source.

Application Displays the application that has been detected as opening the
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source file.

Detection Type

This column represents the PeerLock detection mode used to
detect what source files are locked/opened. This will either be
File Server Mode Detection or Local Detection.

Note: Starting with version 3.0, PeerLock supports File Server
Mode Detection only.

Idle Time

Shows the amount of time the target file will remain locked
once the source file has been released. When the source file is
closed PeerLock will wait the number of Idle Time seconds
specified before releasing the target file. During the Idle Time
period the file entry in the Locked list will be highlighted Yellow.
The Idle Time value can be set in the Release Options dialog.
This feature is intended to protect the releasing of files during
file opens and saves. Certain applications may temporary re-
lease files during these procedures. With this feature enabled
PeerLock will wait the set period of time to make sure the file
is fully released before unlocking the corresponding target files

Lock File Handle

Displays the handle value created that is being used to lock the
temporary Lock File created by PeerLock to Interact with other
Peer Software Products. If the Interact features are disabled
then this will display ‘None'.

Release Detected

Shows the date and time when PeerLock detected the source
file was closed. This value will be cleared if the file is reopened

within the Idle period and the target file handle is not released.

Source Access Al-
lowed

Displays the permissions that are allowed on the opened
source file.

Source Attributes

Shows the attributes of the source file.

Source Handle

Displays the handle value created when the source file was
opened.

Source Modified

Shows the modified date/time of the source file when it was de-
tected as being open.

Source Open Mode

Displays the permissions that were used to open the source
file.

Target Handle

Display the handle value created that is being used to lock the
target file by PeerLock.

Target Open Mode

Displays the permissions that were granted when the target file
was locked by PeerlLock.

Temporary Releases

Shows the number of times the source file was closed during
the Idle period.

Notes:

For efficiency purposes, only when you click on the screens/ tabs within the Advanced Run/View PeerLock
panel will the values get updated. A Cache folder within the PeerSync installation folder maintains the necessary
event files that will be loaded into the advanced display screens/ tabs.
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Command Line Arguments

PeerSync's Command Line Mode offers users the ability to configure a truly "hands-off" in-
stallation, where operation and distribution occurs from within an easily manageable, admin-
istrative environment. This mode allows Profiles to be executed from logon scripts, system
batch (BAT) or command (CMD) files, detailed shortcuts, and shell commands -- while also
providing full access to the Profiler features through command line arguments.

Profiles will need to be created through the Profiler first in order to be further modified through
the arguments described in this topic (See Profiler Overview and related Help Topics).

Command Line Arguments are entered into a Profile shortcut, created during build through the
"Add to Desktop" button found on Profiler's Startup/Service screen.

Notes:

1. Forthe command line arguments described in this topic, note that attention is paid to punctuation, to the order in
which arguments are entered, and that appropriate spaces are used to separate these arguments. Follow the
format outlined in the examples provided.

2. Profile .SNC file names are the only command line variables associated with operation of the Profiler. All other ar-
guments described in this topic are used to configure operation of the PeerSync and its execution of Profiles.

Profiler Command Line Arguments

As noted above, Profile ((SNC) file names are the only variables associated with operation
of Profiler. To change an .SNC file name through the command line:

1. Rightclick the Profile shortcutyou created during build (see StartUp/Service, "Add to
Desktop" button).

2. Selectthe "Properties" item from the pop-up menu.

3. Selectthe "Shortcut' tab. As shown in the following sample, the "Target" field will contain

a command line for the Profile, where "Profile One" represents a sample Profile name:
"C:\ Program Files\ PeerSync\ PeerSync.exe" " C:\ Program Files\ PeerSync\ Profile One.SNC" /
USEPROFILEARG

4. Manually change the Profile Name to reflect that of the new .SNC file
5. Click the "OK" button

PeerSync Command Line Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e./A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M).

=l Topics
Configuration Arguments
Performance Arguments
Reporting and Display Arguments
Automation Arguments
Synchronization Arguments
Real-time Arguments
Managed Files Arguments
Bi-directional Arguments
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Notes:

1. Any arguments containing spaces must be enclosed by quotes.

2. Some features described on this page may require the Enhanced Package.

3. Command line arguments can also be identified through hints displayed on the Profiler.

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will dis-

play both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:// www.peersoftware.conv support/ submit-a-case.html.

1. Configuration Arguments

Configuration Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e./A). A space and forward slash are also used to separate
each additional argument (i.e./A /M).

[0:Profile
Set SNC File to Load (Profile = File): Ifthe /0 argumentis used in a shortcutor from the
command line, PeerSync will load the Job information specified in the file.

Examples:

/0:"C:\My SNC\ MyBackups.snc" Full path to file

/0:MyBackups.snc Will use install directory

MyBackups.snc Will use install directory (Must be first argument)
[1:source

Set Source Path (source = Folder): Ifthe /1 argumentis used in a shortcut or from the
command line, PeerSync will use it in conjunction with /2 to define a Source and Target
path fora Job.

Example:
/1:c:\source /2:c:\target c:\source to c:\target

Set Target Path (target = Folder): Ifthe /1 argumentis used in a shortcut or from the
command line, PeerSync will use it in conjunction with /2 to define a Source and Target
pathfora Job.

Example:
/1:c:\source / 2:c:\target c:\'source to c:\target

[C:cfile

Load Alternate Configuration File (cfile = File): If the /C argumentis enabled, Peer-
Sync will use the values specified in cfile for synchronization information instead of using
the default configuration file: PSDef.cfg which is located in the install directory.

Example:
/ C:C:\ PeerSync\ configs\ altcon- Use altemate configuration file
fig.cfg
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[USEPROFILEARG

Use Arguments from Profile: Ifthe /USEPROFILEARG argumentis used in conjunc-
tion with a /0:Profile, PeerSync will use the arguments specified in Profile, forsynchroniz-
ation. By default, when you create a shortcut on the desktop or in the startup folder from the
StartUp Options screen this argumentis used.

Notes:

1. Any arguments containing spaces must be enclosed by quotes.

2. Some features described on this page require the Enhanced Package.

3. Command line arguments can also be identified through hints displayed on the Profiler.

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will dis-

play both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:// www.peersoftware.conm/ support/ submit-a-case.html.

2. Performance Arguments

Performance Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e./A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M).

/GE:x

Set Shared Process Delay: The /GE argument is used to set the shared process
delay to allow more/less CPU utilization. This value ranges from 0 -10 where 0 (less CPU)
will use the mostdelay and 10 (more CPU).will use the leastamountofdelay.

[GKix
Copy Thread Utilization: If the /GK argument is enabled, PeerSync will allow up to x
threads to watch the queue that manages changes allowing forincreased Copy Thread util-
ization.

I1GP:x
Set Email Threads: Ifthe /GP argumentis enabled, PeerSync will allow up to x threads
to be used for email tasks.

/LK

Set Multitasking Delay: The /LK argumentis used to adjust the delay during multitask-
ing. This value may be setbetween 1 and 10 where 10 is the highestamount of delay and 1
is the leastamountof delay. The defaultvalue is 4.

/LN:x

Set Processor Affinity: If the /LN argumentis enabled, PeerSync will allow you to limit
which CPUs to use in a multi-processor environment, where each CPU is represented by 2
to the x value:

/LN:1 =Use CPU 1 /LN:16 =Use CPU 5
/LN:2 =Use CPU 2 /LN:32 =Use CPU 6
/LN:4 =Use CPU 3 /LN:64 =Use CPU 7
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/LN:8 =Use CPU 4 /LN:128 =Use CPU 8

Examples:

/LN:1 Use CPU 1

/LN:3 Use CPU 1,CPU 2 (/LN:1+/LN:2 =/LN:3)

/LN:4 Use CPU 3

/LN:5 Use CPU 1,CPU 3 (/LN:1+/LN:4 =/LN:5)

/LN:15 Use CPU 1,CPU 2,CPU 3, (/LN:1+/LN:2+/LN:4 +/LN:8=/
CPU4 LN:15)

Note: By default all CPUs will be used.

/MCT :x

Set Copy Threads: Ifthe /MCT argumentis enabled, PeerSync will allow up to x file
copy threads to be spawned for file copy tasks. These copy threads will be shared by one
or more Jobs during the synchronization process.

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

IMET :x
Set Job Threads: If the /MFT argumentis enabled, PeerSync will allow up to x Job
threads to be spawned for managing Job tasks.

Note: Thisitemis selectable from the Profiler via the Options/ Commands Screen.

[OPTIMIZE

Optimize Performance: Ifthe /OPTIMIZE argumentis enabled, PeerSync will disable
status screen windows used for outputting status information. This will minimize memory al-
location for the User Interface.

/PERFORMANCE :x
Set Application Priority: Ifthe/PERFORMANCE argumentis enabled, PeerSync will
setthe application's priority based on the following value ofx

0: Lowest Priority
1: Below Average Priority
2: High Priority.

Notes:
1. This item is selectable from the Profiler via the Options/ Commands Screen.
2. If the / PERFORMANCE argument is not used, PeerSync will use a default priority.

3. When setting the Application Priority to High, PeerSync will use more then average CPU, you may want to use
the Set Processor Affinity argument in this scenario.

l l K‘.n

Set Real-time Copy Thread Pool: Used to set the percentage of Copy Threads to re-
serve for Real-Time events, where n can be set between the values of 1 and 99. The de-
fault value is 10.

l lX‘.n

Set File Read/Write Buffer Delay: Used to set a delay in n milliseconds between
each file read/write cycle to allow the limiting of CPU usage and system resources during
file transfers. The higher the delay value, the less CPU used but the slower the performance
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orspeed of PeerSync.

[QR

Exclude Common Job Exceptions in Event Processing: Checks the global exclu-
sions before file hits such as before event processing and before adding the event to the
visual list. This option creates a global file exclude listbased on the file exclude list from all
the Jobs. The filter applies to real-ime add and update events. Since they are applied
early in event processing there are no log entries for these exclusions. Remove the /QR
option to achieve logging.

Q70

Exclude Common Job Exceptions in Event Processing for FPolicy Jobs Only:
This argument is the equivalent of the /QR option but applies to FPolicy Jobs only. In the
userinterface, setthe Exclude Extensions listto % AUT O% to achieve the same result.

[Q70:s

Exclude Extensions: Provide a list of comma (,) delimited file extensions to exclude
when using NetApp FPolicy detection during scans or in real-time. This can be done in the
user interface or via the command line. Use use /Q70:s, where s represents the comma (,)
delimited list of extensions to exclude (i.e./Q70:tmp,dwl,dwli2).

[Q7-s

Exclude Volumes: Provide a list of comma (,) delimited volumes to exclude when using
NetApp FPolicy detection during scans or in real-time. This can be done in the user inter-
face orvia the command line. Use /Q7-s, where s represents the comma (,) delimited list of
volumes to exclude (i.e./Q7-vol3,vol4).

[Q7+s

Include Volumes: Provide a list of comma (,) delimited volumes to include when using
NetApp FPolicy detection during scans or in real-time. This can be done in the user inter-
face orvia the command line. Use /Q7+s, where s represents the comma (,) delimited list
of volumes to include (i.e./Q7+vol1,vol2).

Notes:
1. Any arguments containing spaces must be enclosed by quotes.

2. Some features described on this page may require the Enhanced Package or Multi Threading Option. Please
visit http:/ / www.peersoftware.com or contact Sales for additional information.

3. Command line arguments can also be identified through hints displayed on the Profiler.

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will dis-
play both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:// www.peersoftware.con/ support/ submit-a-case.html.

3. Reporting and Display Arguments

Reporting and Display Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e. /A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M).
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(AP

Run Pre-Sync Report: Ifthe /AP argumentis used a Pre-Sync Report will be gener-
ated and files/folders will notbe synchronized. If you add an O to the /AP then the previous
Pre-Sync reportwill be Over written, if you exclude the O then the file will be appended to an
existing Pre-Sync report. Ifyouadd an S to the /AP then the Pre-Sync report will be Shown
atthe end ofthe run (i.e../AP, IAPO, /APOS or /APS).

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

/GL[S]

Display status in Profiler: Ifthe /GL argument is used, PeerSync will open the Profiler,
ifitis not already open, and send status messages to be displayed on the Run/View Cur-
rent Profile Activity screen using mail slot messaging to communicate with the Profiler. By
adding an S you can suppress the initial connection of PeerSync to the Profiler upon activ-
ation of PeerSync.

Note: This item is selectable from the Profiler via the Options/ Commands Screen.

/GM:x
Enable MSMQ messaging: [fthe /GM argumentis used, PeerSync will use x as the
location to manage messages in the queue.

Example: /GM:DIRECT=TCP:209.51.171.142\ PRIVATE$\ MYQUEUE

/1 GOIF:y][C:group]

Enable Peer Administrator Broadcasts: If the /GO argumentis used, PeerSync will
use mail slots to broadcast activity across the LAN to the Peer Administrator utility for the
centralized viewing of all PeerSync activity on the network. You can launch the Peer Admin-
istrator utility, ifitis installed/available from the View Menu.

y: Identifies the number of seconds between each broadcast. The defaultis 3 seconds.
group: Identifies a group for the current Profile. The defaultis the Profile Name.

Example: / GOF:5C:MyProfiles Enabled and broadcasted every 5 seconds with a group name of

1GQ:[file][ maxsize]
Create and Append Summaries into One Report: If the /GQ argument is used,
PeerSync will append summaries into one log file.

/IGR
Report Non Standard Events: Ifthe /GR argumentis used, PeerSync will report non -
add,update, and delete actions.

/1GS:x
Enable Summary Statistics Collection: If the /GS argument is used, PeerSync will
use x as the file location to save summary statistics.

/H

Hide Splash Screen: Available through all registered versions of PeerSync, this argu-
ment will suppress and hide the splash screen from the Taskbar for both the PeerSync and
Profiler applications.

[H-

Only Hide the about screen: Available through all registered versions of PeerSync,
this argument will suppress and hide the About screen for both the PeerSync and Profiler
applications.
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[H+

Skip setting of main form visible: Available through all registered versions of Peer-
Sync, this argument will no setthe main form visible and always hide the application from
the Taskbar for both the PeerSync and Profiler applications.

/ILSE_
Log Service Events to the Event Viewer: If the /LSE argument is used, PeerSync
will log events to the Event Viewer. The following options are available for this argument:

/LSEE Log messages as errors

[LSEEW Log messages as warnings

/[LSEEM Only log messages and log them as errors
[LSEEWM Only log messages and log them as warnings
M

Show Tray Icon: Ifthe /M argumentis used, PeerSync will display an icon in the system
tray for PeerSync.

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

/PROGRESS

Display status in PeerSync: This feature will show the PeerSync Status Display dialog
box during synchronization so the user can see activity, status and other information while
PeerSync is running.

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

/ISNMP
Enable SNMP Error Reporting: If the /SNMP argument is used, PeerSync will use
SNMP reporting to reportany errors that occur during the synchronization process.

/ID

Display status in PeerSync upon completion: This feature will have PeerSync show
the PeerSync Status Display dialog box at the end of synchronization (only in non-persist-
entmodes) so the usercan see activity, status and other information upon completion.

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

YL

Log Messages Only to a Log File by Filter and/or by Profile: If the /YL argument
is used, PeerSync will log messages only to a log file based on the Filter and/or Profile.
The following options are available for this argument;

/YL Log messages for Both
IYLF Log messages by Filter Only
IYLP Log messages by Profile Only

When logging by Filter (/YL or/YLF), the Filter message log file will reside in the same dir-
ectory as the primary log file, with the same file name as the primary log file but with a
"fit.log" file extension.

When logging by Profile (/YL or /YLP), the log file will reside in the same directory as the
Profile, with the same file name as the Profile butwith a "snc.log" file extension.

[QP
Don't Display Job Stats: Ifthe /QP argumentis used, PeerSync will notdisplay any Job
statistics in the Status Display window. Disabling this option reduces the amount of over-
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head work PeerSync is doing.

QY7

XML File Creation Interval: By default PeerSync stores Profile and Job related statist-
ics into an easily readable XML files on aninterval of every 60 seconds (ifapplicable) as
well as during the completion of a Job scan. This interval can be adjusted using the /
QY7:n command line argument where n represents the interval in seconds of how often
you want PeerSync to update the Profile related XML statistics.

1QY7:(T-)(C-)(A-))(n)

(Interval to write out statistics (60 is the default))
(Suppress .totfile creation)

1 o 3

(@)

(Suppress .curfile creation)

(Suppress all XML file creation and new logic for tracking file extensions)

.

[YB:x

Disable Tray Icon Menu Items: Ifthe /'YB argumentis enabled, PeerSync will allow
you to limitwhich Tray lcon menu items to be disabled, where each menuitem is repres-
ented by 2 to the X value.

YALUES Disable Menu ltem

Wigw Log File » | YBA Wiew Log File
Yiews Message Log file k fB:2 Yiew Message Log file
Wiews Admin Folder Y IYBA Yiew Admin Folder
Cipen Source Falder » | frB8 Open Source Folder
Open Target Falder * | /BB Open Target Folder
Show Status Display fYB:32 Show Status Display
v Connect/Launch PeerSync Profiler frB:64 ConnectiLaunch PeerSync Profiler
Re-Load Prafile FrB:128 Fe-Load Profile
About PeerSync fYB:2bb About PeerSync
Exit PeerSync frB:h12 Exit PeerSwnc

Note: To disable multiple menu items simply add the /YB values together for the items
you wish to disable.

EXAMPLES

/YB:512 Disables the Exit PeerSync menu option

/YB:24 Disables the Open Source Folderand Open Target Folder
options
8+16=24

/1YB:767 Disables All Menu Options exceptAbout PeerSync

142+4+8+16+32+64+128+512=767
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QP

Disable Job Stats: Ifthe /QP argumentis enabled, the Job Stats option will be un-
checked, resulting in no Job statistics being shown in the PeerSync Advanced Display
panel.

[Q8BJ+

Enable Job Scans Tab:Ifthe /Q8BJ+ argumentis set,a Job Scans tab will be cre-
ated in the Advanced Run/View PeerSync panel showing Base/Root, Enhanced/Expan-
ded, and RT/Sub-folder scans with statistics and progress for all the Jobs or the selected
Job.

QQ

Enable the File Copy Progress Tab: Ifthe /QQ argumentis setthe File Copy Pro-
gress tab will be created in the Advanced Run/View PeerSync panel to show the progress
of a file transfer. This feature requires the Multi-T hreading Option.

[Q8BH+

Enable the Historical Data Tab: Ifthe /Q8BH+ argumentis set, the Historical Data tab
will be shown in the Advanced Run/View PeerSync panel. This tab contains a subset of
data from the PeerSync Jobs Stats panel (Xfer Rate, Bytes and Event Averages) and is
broken down into total, hourly, daily, and weekly statistics for all the Jobs or only the selec-
ted Job.

[QQ<<
Disable the Show Advanced Display link atthe bottom right corner of the Run/View
PeerSync screen.

[Q70
Share Migration reporting levels: The default behavior with no arguments is to report
Share Errors, Share Totals, Share Actions and Share Permission Errors.

/Q70R- Report Share Errors and Share Totals only

/Q70R Report Share Errors, Share Totals, Share Actions, Share Permission Er-
rors and Extended Share Information

/Q70R+ Report Share Errors, Share Totals, Share Actions, Share Permission Er-

rors, Extended Share Information, Get and Set of Shares, Share Permis-
sion Matches and Share Permission Skips

/Q70R++ Share Errors, Share Totals, Share Actions, Share Permission Errors, Ex-
tended Share Information, Getand Set Share Information, Share Permis-
sion Matches, Share Permission Skips and Share Permission Actions

/1Q70V Reportsource and target system information

/Q70- Use previous Share Migration Logic from v9.0

/Q70R- - Same as /Q70R- and disables share migration starting information
/Q70I- Disable share migration starting information

/Q70E Reportall activity atthe end of share migration, instead of during
[Q8B:

In Queue Display Options: Track pending events atthe Job level and help determine if
a Jobisinsync.

Q+ Enable real-time stats (including RT Scans: x/y where xis RT Scans Pending and y is
RT Scans Running)

Q- Disable collection of RT Scan stats

Q++ Get the file size for RT Stats and display Bytes. This option may decrease perform-
ance. Ifthis is disabled (i.e. no Q++ switch in /Q8B) then bytes will show as N/A
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Q> Enable scan stats. This option may slightly decrease performance

R+ Track and display In Queue Retries

M+ Track and display In Queue Managed Files

>> Enable all Scan, RT, Retry and Manged Files stats, as well as other debug stats
or

>>>

Notes:

1. Any arguments containing spaces must be enclosed by quotes.

2. Some features described on this page require the Enhanced Package.

3. Command line arguments can also be identified through hints displayed on the Profiler.

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will dis-
play both a description of the feature as well as its related command line argument (if any). For more information
on the latest features and how to implement specific scenarios please goto our support page at: http://

www.peersoftware.con/ support/ submit-a-case.html

4. Automation Arguments

Automation Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e./A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M).

/A

Scan at Start: Ifthe /A argumentis appended to the command line, the Profile can be run
through its associated shortcut. As non-persistent processes, Automatic Operations are run
a single time upon manual initiation by the user.

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

/D(H):x

Delay Start of Profiler: Ifthis argumentis used, PeerSync will delay the load/start of
PeerSync by x seconds. With this option enabled synchronization can be canceled via a
dialog box if done within the designated interval. For example, /D5 would provide you with
a 5 second delay during which the operation can be canceled. Ifthe /D argumentincludes
anH,i.e./DH60, then the delay timer dialog will be hidden. This argumentis useful for al-
lowing PeerSync to begin after other applications have beenloaded if you are running
PeerSync atWindows startup.

/R[OyCz]

Real-time Monitoring Argument: The /R argumentactivates Real-Time Mode.

The Oy and Cz arguments are optional and specify the following retry values during Real-
Time Mode:

y = The retry countif the file is open or network is unavailable
z = The retry count maximum

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

/S
Run Scheduled Operation: The /S argument enables or disables Scheduled Opera-
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tion Mode for the entire Profile. This feature must be selected in order for all Scheduled
Operations set for individual Jobs to be recognized. Scheduled Mode does not apply a
global schedule to the entire Profile: rather, itenables those schedules set for all individual
Jobs onto run attheir specified intervals.

All Scheduled Operations setforindividual Jobs will be ignored if this mode is notselected.
If none of the Jobs within a Profile are set for Scheduled Operation and this mode is selec-
ted, all active Jobs within the Profile will be assigned a default synchronization schedule of
five minutes.

/1Sx

Synchronization Timer Argument: The /Sx option is used to run PeerSync automatic-
ally atregular intervals. This argument sets PeerSync to synchronize the selected Profile
every X minutes. Through this feature PeerSync remains persistent and will not terminate
upon completion.

Examples: /S10 Synchronization will be performed every 10 minutes

/TIME

Daily Timer: This argumentwill allow for scheduling of PeerSync for specific times of the
day down to the minute for selected days of the week and selected Jobs within a Profile. If
you use a /ITIMEF argumentall selections atthe Job level from the Automation screen will
be used. You can also specify Global Daily Timer selections for the entire Profile from the
Options/Commands Screen or by using the following format:

1. Select the time of day (by default all Jobs will be run all days)

/TIME:HH:MM
Where HH is replaced with the value of 00-23 in military time and MM is replaced with 00-59 in minutes

Examples:

EveryDayat  /TIME:00:00
12:00 am: / TIME:01:00
EveryDayat  /TIME:08:00
1:00 am: / TIME:12:00
EveryDayat  /TIME:20:00
8:00 am:

Every Day at

12:00 pm:

Every Day at

8:00 pm:

2. (Optional) - To select the days of week to run append the following:

D:SMTWTFS where the days are substituted with 1 (On) and 0 (Off)

Sunday: D:1000000

Monday: D:0100000

Tuesday: D:0010000

Wednesday: D:0001000

Thursday: D:0000100

Friday: D:0000010

Saturday: D:0000001

Examples:

M, W &F at 8:00/ TIME:08:00D:0101010
am /TIME:17:15D:1000001

Sat&Sunat  /TIME:03:30D:0111110
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5:15 pm:
Mon - Fri at 3:30
am:

3. (Optional) - To select the Jobs to run append F:f1;f2;f3
Where f1-fn are the Job numbers.

Examples:

Job 1 Every day / TIME:06:00F:1

at 6:00 am: /TIME:20:25F:1;2;3;4;5

Jobs 1 -5 Every / TIME:03:30D:0111110F:1:3:5
day at 8:25 pm:

Jobs 1,3 &5

Mon - Fri at 3:30

am:

Note: Will accept multiple command lines.

Example:
Job 1 Every day at 8:00 am, Jobs 1 -5 Every day at 8:25 pmand Jobs 1, 3 &5 Mon - Fri at 3:30 am
/TIME:08:00F:1 / TIME:20:25F:1;2;3;4;5 / TIME:03:30D:0111110F:1;3;5

Sample:

Complete command line to run PeerSync with Test.snc, all Jobs, at 3:00 am Mon -Fri, (M)inimized on the tray.
"C:\Program Files\ PeerSync\PeerSync.exe" "C:\Program Files\PeerSync\test.snc" /
TIME:3:00D:0111110 /M

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

/UDD

Use Device Driver method: This argumentuses of the Windows NT device driver for
real-time detection. When using this argument PeerSync can detect changes made to re-
mote Source folders butonly when the changes are made by the machine where PeerSync
is installed.

/<

Applications to Ignore: If using the Device Driver method for Real-Time detection you
can select applications to ignore by appending application names (semicolon delimited)
to the /<argument.

Example: / <Ex- Will ignore any Real-Time changes made by Explorer.exe and Word.exe.
plorer.exe;Word.exe

Note: When using this option and monitoring a remote Source folder, the Transfer NT security descriptions
(ACLs) is ignored in Real-Time.

X
Disable Initial Synchronization During Startup: The /X command line argument dis-
ables initial synchronization during /A /M /R operations at PeerSync startup.

Notes:
1. Any arguments containing spaces must be enclosed by quotes.
2. Some features described on this page require the Enhanced Package.

3. Command line arguments can also be identified through hints displayed on the Profiler.
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4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will dis-
play both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:// www.peersoftware.conv support/ submit-a-case.html.

5. Synchronization Arguments

Synchronization Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e./A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M).

/1GC:x
Set File Comparison Value: Ifthe /GC argumentis used, PeerSync will add x seconds
to the Target File date and time stamp to use during comparison.

/GD:n.z:n.z

Set Job Comparison Delta: Ifthe /GD argument is used, PeerSync will add or sub-
tractz seconds from the TargetFile date and time stamp during a comparison for Job num-
bern.

Example: /GD:1,+30:2,-60:

IGE
Use Alternate Copy File Methods: The following copy file methods may be invoked:

IGFC Use CopyFile APl method

IGFS Use File Stream method

IGFE Use CopyFileEXmethod

IGFA Transfer Alternate Data Streams - The same functionality can be used ata Job
level by using the SETVAR INCLUDEALTFILESTREAMS switch in the Pre/Post
paths.

/GI(S)(D)

Ignore File Size and/or Date Comparison: If the /Gl or /GIS argument is used,
PeerSync will ignore file size during folder scans (if date matches then skip file). If the /GID
argument is used, PeerSync will ignore file date comparison during folder scan (if size
matches then skip file).f the /GISD argument is used, PeerSync will ignore file date and
size comparison during folder scan (always replace Targetfile evenifthey are identical).

IGT

Get Remote PC Time: If the /GT argument is used, PeerSync will atempt to get the
time from the Target PC as well as the local PC and automatically compensate for time dif-
ferences.

Note: /GT is only applicable in an NT/ 2K Environment

1GX
Use Delete Path for Revisions: Ifthe /GXargumentis used, PeerSync will use the de-
letions path for all PSBAK revision files.

1
Ignore Target Space During File Copy: The /I argument sets PeerSync to ignore
Targetspace available during file copy.
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14
Move Files: Ifthe /J argumentis used, PeerSync will move files - deleting them from the
Source after they have been successfully transferred.

TKA:X
Active Connection Interval: Ifthe /KA argumentis used, PeerSync will attempt to con-
nectevery x minutes to Target machine(s).

/LH:x

Set Deletion Move To Folder Cleanup Interval: Ifthe /LH argumentis used, Peer-
Sync will check the Move To Folder (the folder where deleted files are move t0), every x
minutes to see if files needed to be deleted on the cycle specified by the Delete un-

matched Target Files olderthan xdays option.
/ILIIR|T|A]

Targetin-Use Replacement: Ifthe /LI argumentis used, PeerSync will perform the fol-
lowing operation if Target File is unavailable:

R Force rename of open Target File

T Force terminate of open Target File application
A Force terminate of all open Targetapplications
/LM:xOyCz

Set Failed Connection Timer: Ifthe /LM argumentis used, PeerSync will use the fol-
lowing variables to determine retry frequency:

X Approximate time, in minutes, for retry of failed connection (time may vary as much
as a few minutes).

y Frequency to retry files

z Maximum Retry Count

Example: /LM5025C100 Checks failed connections every 5 minutes, retries files every 25

seconds, to a maximum retry count of 100.

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

/LMD
Disable Failed Connection Timer: Ifthe /LMD argument is used, PeerSync will not
check for failed connections:

Example: /LMD Does not check for failed connections.

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

ILR:file
Run application at start of PeerSync: Ifthe /LR argumentis used, PeerSync will ex-
ecute an application or shell script specified by file at the initialization of PeerSync.

Example: /LR:C:\\WINNT\notepad.exe

LW
Enable Last Access Compare: The /LW argument allows you to use the last access
date/time instead of the modified date/time for comparisons to determine file updates.

/NODELFLDR
Do notdelete folders: Ifthe/ NODELFLDR argumentis used, PeerSync will notdelete
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folders during synchronization.

0
Set Target File Overwrite: The /O argumentsets Target File overwrite on all Jobs.

/QB
Use Full Access File Copy: I[fthe /QB argumentis used, PeerSync will only copy files
itcan gain full access to during synchronization.

/QFn

Shadow Time Range: This argument will use an n second time range for file time
stamps during comparison. If the Source and corresponding Target File time stamps fall in
the range then the file time stamps will be seen as equal.

n = Time in seconds

Note: /QF:1 is equivalent to a value between 1 to 3 seconds depending on the file systems being used.

[QF[+][++][+++]

Precision Comparison: Use this argumentto remove minutes, seconds, or milliseconds
from files during comparison.

/QF+ Removes/ignores the milliseconds from both the source and targetfile time
stamps during comparison

/QF++ Removes/ignores the milliseconds and seconds from both the source and target
file ime stamps during comparison

/QF++ Removes/ignores the milliseconds, seconds, and minutes from both the source

+ and targetfile time stamps during comparison

QG

Always use the local machine time for the Last Run Time: [fthis argumentis used,
PeerSync will always uses the local machine time for the Last Run Time, instead of using
the minimum time of the Source and Target machines involved in the synchronization.

/QH:n
Force Flush File Buffers: Forces the file data that has been written across the network
to be fully committed to disk before continuing. The Interval n is the number of buffers worth
of data to write before forcing a disk write of the data, if n is not used the default is 100
cycles.

Note: This is expected to naturally occur without this argument, but on some systems across slower networks it
is necessary to force the commit of data to cormectly gauge process of writing the file.

/QHD

Direct Disk Write: Forces the file data that has been written across the network to be
fully committed to disk before continuing. This will occur for each buffer worth of data that is
transferred.

Note: You may use this argument or the / GFC option to resolve Windows "Delayed Write Failed..." messages.

/1Ql:ext
Ignore Matching/Locked File Extensions: This argument will ignore an add/update
of a file, ifa matching file with the same base name and the specified extension ext exists.

Example: /Ql:dwl
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Note: One instance of this example is if a file called MyFile.dwg is updated it will be excluded from synchroniza-
tion while MyFile.dwl exists.

1QJ:str

Ignore Matching/Locked File Postfix Replacement: This argument will ignore an
add/update of a file, if a matching file with the same base name with the specified postfix re-
placementstr exists.

Example: /QJ:"$

Note: One instance of this example is if a file called MyDocument.doc is updated, it will be excluded from syn-
chronization while ~$Document.doc exists.

/T
Terminate All Instances of PeerSync: The /T argument terminates all running in-
stances of PeerSync, including itself.

/YRBn
Verify User-Name: |If the /V argument is used, PeerSync will verify logged on User-
Name defined in the local userfile list, specified by the following options:

R Require user to be in the userfile list

B Bypass the requestto add to listdialog
n Maximum number of user allowed
IW:x

Set Queue Directory Change Count: Ifthe /W argumentis used, PeerSync will set
queue directory change count, events to waitforaction x.

/WPFEIX

Disable application associated with active file synchronization: When a file is
being synchronized, this option searches all active windows on the desktop for a caption
that contains the path/filename ofthe active file. PeerSync then disables the active applica-
tion in one oftwo ways. The command lines "/WPFIX or/WPFIX2" disables the entire ap-
plication and" /WPFIX1" disables the save toolbar and file menu save item. (This option
also verifies that the word "WordPerfect' is in the caption before disabling). Both options
will append "(Synchronizing)" to the existing caption and when the file is synchronized, the
caption will be restored.

/YC:x
Folder Queue Watch Interval: Change the defaulttimer interval for checking the folder
gueue to x seconds (the defaultis .5 seconds).

Example: /YC:3

YD

Allow Replication During Dynamically Created Jobs: This argument will allow dy-
namically created Jobs (i.e. Job scans triggered by Folder Additions) to use the replicate
option.

/YF:extl;ext2:extn

Partial Locked File Extensions List: This argumentis used for file types that are par-
tial locked when open by other applications (i.e. Outiook PST files). If the /YF argument is
used, and Volume Shadow Copy Service (VSS) is enabled PeerSync will always process
files with the specified extensions as though they are open and locked files. If VSS is not
enabled, then PeerSync will pre-scan the files to ensure complete access before file copy.
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PST files are included in this listby defaultand can be changed via this command line.

Example: /YF:.pst;.dba:

YN
Use Network Password Dialog: Ifthe /YN argumentis used, PeerSync will display a
network password dialog ifyou do nothave rightto access the Source or Target Folder.

YR
Delete Empty Source Folders After Move: This argument will delete all empty
Source Folders after a synchronization scan when using the Move Files - Delete Source

File after successful copy to Targetoption.

IAAA

Do Not Validate Connections Before Profile is Loaded: This argument will not try
to validate Source and TargetFolder connections during the load ofa Profile. It will assume
thatthe connections will be available upon start of each Job. This option is useful if you are
running a Pre Process that will establish a connection and/or create a Source or Target
Folder. This argument should be used when using the /LJP (Always Run Post Process) ar-
gumentorwhen needing to dynamically create the source and ortarget paths.

/Z:ext1:ext2:extn

Ignore Open File Extensions: Ifthe /Z argumentis used, PeerSync will ignore files with
the specified extensions that are currently opened where the full name of the file is dis-
played in the caption of another window. This argument may be ignored if Multiple Job or
multiple copy threads are enabled.

Example: /Z:.wpd;.txt;

/LJU:x

Exclude Folders that have a Reparse Point: By default PeerSync will exclude
folders thathave a Reparse Pointobject, which are common in Windows Vista. Use this ar-
gumentto alter this behaviour:

/LJU:0 Don'texclude folders thathave a Reparse Pointobject

/LJU:1 Exclude folders thathave a Reparse Pointobjectrecursively pointing back to itself
(Default)

/LJU:2 Exclude all folders thathave a Reparse Pointobject

[LJP

Always Run Post Process: Ifthe /[LJP argument is used, PeerSync allows for the abil-
ity to process Postcommands even ifthe Job fails. This argument is useful for non persist-
ent Profiles that need to execute or start other processes regardless whether or notits Job
was able to run. This argument should be used in conjunction with the /YV command which
allows for the Profile to be loaded before the source and targetfolder(s) are validated.

[LXR

Listener Alternate Route Path: Adding this option will create an Edit: Listener Al-
ternate Route Path option when right-clicking on either the Source or Targetfolder selec-
tion paths. This creates and opens a file called %PROFILENAME%.psl in the Profiles dir-
ectory used to configure alternate route(s) for the PSListener. Here is an example of what
the content of the %PROFILENAME % .psl file should look like:

[ LI STENER]
Net AppA=W n2008A
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Net AppB=W n2008B

The firstcolumn contains the name or IP address of the remote non-Windows server.
The second column lists the name or IP address of the Windows server where the
PSListener is running.

ILZS|A|S|I-|I+|T-|T+|WN
Compare and Set File Attributes from Windows to NetApp: Arguments to support
the comparing and setting of file attributes from Windows to NetApp.

A Includes fixes to check for the | attribute to see if the setting of attributes was suc-
cessful and logging of failed setting of attributes.

S Suppresses the logging of failed setting of attributes due to the above additions
(i.e./LZAS will run all the new logic but will notlog failures).

I- Force offthe | attribute when setting target files.

I+ Will force on the | attribute when setting targetfiles.

T- Will force offthe T attribute when setting targetfiles.

T+ Will force onthe T attribute when setting target files.
WN WN will use A, I- and T - for a potential fix for Windows to NetApp systems. This is
the recommended workaround for this scenario for now especially for TCP routing.

Fora Windows to NetApp Fixuse:/LZS:WN

Possible alternatives are to use: /LZSA or/LZSAS

When routing via TCP and notusing the WN (or|-and T-) switches you may require the fol-
lowing entry inthe PSListener93.CFG file:

[Application Settings]
Reval i dateSetFi | eAttri butes=1

[LJFK
Convert Well-Known SIDs: Set this option to convert well-known SIDs (WNS) when us-

ing ACLs over TCP to actsimilarto Normal (non-TCP) Jobs.

/LJFK Enable this feature.

/LJFK+ Will Reportfailures to PSError.log

/LJFK+ Will Reportconverted items to PSError.log

+

/LJFK+ Will Reportskipped items to PSError.log

++

/LJFK+ Will Reportconverted WNS parts to PSError.log
+++

/LJFl Use alternate method.

/ILJFIK Uses defaultand alternate method.

Q70
Share Migration support for cDOT 8.3: Add this option to enable Share Migration sup-

portforcDOT 8.3.

/ Revertto incrementing message countfor the Job for successful share migration
Q70M messages.
<
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/ ReportShare Errors and Share Totals only
Q70R-

/Q70R ReportShare Errors, Share Totals, Share Actions, Share Permission Errors and
Extended Share Information

/Q70R ReportShare Errors, Share Totals, Share Actions, Share Permission Errors, Exten-

+ ded Share Information, Getand Set of Shares, Share Permission Matches and
Share Permission Skips

/Q70R Share Errors, Share Totals, Share Actions, Share Permission Errors, Extended

++ Share Information, Get and Set Share Information, Share Permission Matches,
Share Permission Skips and Share Permission Actions

/Q70V Reportsource and target system information.

/Q70- Use previous Share Migration Logic from v9.0.

/ Same as /Q70R- and disables share migration starting information.

Q70R-

/Q70I- Disable share migration starting information.

/Q70E Reportall activity atthe end of share migration, instead of during

/ PeerSync will use the cDOT 8.2 method which requires user/pass (and optional
Q70C ManagementIP) for source and targetcDOT 8.3 systems.

Cc

/ PeerSync will use the cDOT 8.2 method which requires user/pass (and optional
Q70C ManagementIP) for source cDOT 8.3 systems

w

/ PeerSync will use the cDOT 8.2 method which requires user/pass (and optional
Q70W Management IP) fortargetcDOT 8.3 systems

Cc

/ PeerSync will use the cDOT 8.2 method which requires user/pass (and optional

Q70C ManagementIP) for source cDOT 8.3 systems and force on unsupported scen-
W+ arios.

/ PeerSync will use the Windows and/or 7-Mode method for source and target
Q70W cDOT 8.3 systems even for the current scenario that seems to fail for Windows to
w cDOT 8.3.

[ILZR:A|V+

NFS Replication: Use these options to enable NFS FPolicy real-ime detection, scan-
ning, and the ability to transfer/compare UNIX permissions between NetApp 7-Mode and
cDOT systems.

A Base argumentfor using rsync for scanning (turned on via the interface)
V+ Tum on debug verbose logging to reportwhy files are excluded
LZTX

Remove Failed Events If Successfully Re-Processed: Removes Failed Events
from the Failed Eventlist after they were successfully processed.

Q7L

c¢DOT Optimizations: This command line argument provides cDOT detection with the
ability to connectto specific nodes, exclude specific shares, and automatically create and
exclude the recommended $ admin share to achieve optimal bi-directional synchroniza-
tion.

Example:

/Q7L:"nodesToConnect=NODE1;NODE3|nodesToRequire=NODES3;"
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/Q7L:"adminOverrideShare=PeerSync$|validateAdminOverrideShare=true|autoCreateAd-
minOverrideShare=true|sharesToExclude=share1;share2"”

Notes:

1.Use "[" for delimiter between items and ";" for delimiter between sub items
2.Quotes are required for strings with "[* in them

3.RegisterForEvents and UnRegisterForEvents are used if / Q7L string is not set

4. RegisterForEventsExtended and UnRegisterForEventsExtended are used if / Q7L string is set

[LZF:
Transfer Folder Information: Transfer additional folder information such as modified,
created, accessed time and attributes. This option can diminish performance.

A+ Enable comparing of Date accessed time (off by default)

U- Disable reporting of Updates

M- Disable reporting of Messages

M+ Enable reporting of Compare Matches to the Updated tab for debugging/analysis

D- Skip processing after each Directory scan

F- Skip processing after each File Copy (the parentfolderis checked)

I- Skip processing after each SetFolder Info call (used for Enhanced Bi-Sync) and is
done afterreal-time / eventfolder adds (on by default)

E- Skip processing after Folder Renames (on by default)

G- Skip processing parentfolder after File/Folder Deletes (on by default)

I+ Force processing after each SetFolder Info call (used for Enhanced Bi-Sync)

P+ Enable processing after each Security Permission check (off by default)

C+ Enable processing after certain Create Folder calls

R- Notinclude the Rootwatch folder

Notes:

1. Any arguments containing spaces must be enclosed by quotes.

2. Some features described on this page require the Enhanced Package.

3. Command line arguments can also be identified through hints displayed on the Profiler.

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will dis-

play both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:// www.peersoftware.conv support/ submit-a-case.html.

6. Real-Time Arguments

Real-Time Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e./A). A space and forward slash are also used to separate
each additional argument (i.e./A /M).

1GA:x
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Set Empty File Delay: Ifthe /GA argumentis used, PeerSync will delay x milliseconds
before synchronizing empty (zero size) files thatare detected in Real-Time.

/GB:x
Set Shadow Detection: If the /GB argument is used, PeerSync will delay x milli-
seconds to synchronize subsequentupdates of the same file during Real-Time.

/LA
Real-time Attribute Change: Ifthe /LA argumentis used, PeerSync will monitor attrib-
ute changes to files in Real-Time and use these changes as triggers for file synchroniza-
tion.

/ILE
Use Update Sensitivity: Ifthe /LF argumentis used, PeerSync will use the update sec-
tion of PSChangeNotify to detectfile changes during real-time.

Note: This feature is generally too sensitive, and will create multiple detections.

ILG

Folder Change Detection: If the /LG argument is used, PeerSync will detect folder
changes, and in Enhanced Real-Time will force the security description to be validated.
Any change to the folder will trigger a scan of the folder including its sub folders, so that
more CPU will be required. This option is notrecommended for non-enhanced Real-Time.

/ILG1

Folder ACL Detection: Ifthe /LG1 argumentis used PeerSync will detectfolder
changes, and in Enhanced Real-Time will force only the ACLs and attributes to be valid-
ated. Any change to the folder (i.e. file/folder adds or deletes) will force a comparison of
security descriptors and attributes. This argumentis more efficientthen the /LG option
above because itwill notperform a scan of the folder. Use this argumentif you wish to de-
tectand replicate ACLs in real-time for empty folders orfolders that contain files for which in-
heritances has been disabled. Without the /LG1 argument PeerSync would need to perform
a scaninorderto replicate the permissions for such folders.

/LL
Disable Real-time Security Change: Ifthe /LL argument is used, PeerSync will not
triggerupdates in Real-Time when a file's security has changed.

/ILPC:x

Set Maximum Number of Events to Process within each Enhanced Real-Time
Queue Check: Ifthe /[LPC argumentis used, PeerSync will set the maximum number of
events to process within each Enhanced Real-Time queue check to x events. The default
is 25 events and the minimum is 5 events.

/LPC:x+

Set Maximum Number of Events to Process within each Enhanced Real-Time
Queue Check: Adding the + argument PeerSync will process the events currently in the
listatthe time of queue checking setby LPQ.

Example: To queue events for 30 minutes (1800 seconds) and process them on that interval use the following
arguments: / LPQS1800 / LPC+

/LPD:x
Set Delay between Enhanced Real-Time Deletions: Ifthe /LPD argumentis used,
PeerSync will delay the deletion offiles x milliseconds during Enhanced Real-Time.

/LPE:x
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Set Delay between Enhanced Real-Time Event Processing: If the /LPE argu-
mentis used, PeerSync will delay the processing of each event x milliseconds.

/LPM:x

Set Enhanced Real-Time Event Upper Limit: Ifthe /LPM argumentis used, Peer-
Sync will setthe maximum number of items x to allow in the Enhanced Real-Time event
queue before reverting to non-enhanced Real-Time. If this value is setto 0 then the option
is disabled (the defaultis 20000 events). If and when the Upper Limit is reached PeerSync
will clear all Enhanced Real-Time events that have not been processed and scan the dir-
ectories for changes.

/LPW:x:y

Set Enhanced Real-Time Event Queue Delay: Ifthe /LPW argumentis used, Peer-
Sync will setthe number ofitems x in the enhanced real-time event queue to wait for before
processing, as well as, the maximum time to wait for to y milliseconds.

/LPQ:x

Set Delay between Enhanced Real-Time Queue Checking: If the /LPQ argument
is used, PeerSyncwill delay x milliseconds before checking the Enhanced Real-Time
queue for new events.

/ILPX:x

Set Process Delay for Enhanced Real-time Changes: The /LPX argument allows
you to set the delay time for Enhanced Real-Time changes to be processed to x milli-
seconds. This value will be applied directly foradds and updates and will be multiplied by
3 for deletions. The defaultis 1000 milliseconds for adds/updates and 3000 milliseconds
fordeletions

IYK:n

Set Real-time Copy Thread Pool: Used to setthe percentage of copy threads to re-
serve for Real-Time events, where n can be set between the values of 1 and 99. The de-
faultvalue is 10 percent.

[QR

Real-Time Global Exclusions: Use this argumentwhen you wantto exclude real-time
events earlierin the process and throw the events away. This argument will notlog/report
the exclusions. Improves performance when a high amount of events need to be excluded.

Notes:

1. Any arguments containing spaces must be enclosed by quotes.

2. Some features described on this page require the Enhanced Package.

3. Command line arguments can also be identified through hints displayed on the Profiler.

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will dis-
play both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:/ / www.peersoftware.cony support/ submit-a-case.html.
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7. Managed Files Arguments

Managed Files Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e./A). A space and forward slash are also used to separate
each additional argument (i.e./A /M).

/QD

Always Use Partial Locked File Extensions List for VSS: Ifthe /QD argument is
used, any file thatis in the Partial Locked File Extension List (default: .pst files) will always
be synchronized using VSS without scanning the file for partial locks.

Note: Please refer to the [ YF argument for more detail on the Partial Locked File Extensions List.

IGY:x
VSS Interval: The /GY argumentis used to set the interval to try open and locked files
via E The Defaultis every 2 hours and the minimum value is every 30 minutes.

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

/Xx-n
Set VSS Try Count: This argument is used to set the amount of imes n to try and lock
down a drive for full access via VSS during each cycle. The defaultis 5 times.

Notes:

1. Any arguments containing spaces must be enclosed by quotes.

2. Allfeatures described on this page require the VSS add-on module.

3. Command line arguments can also be identified through hints displayed on the Profiler.

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will dis-
play both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:// www.peersoftware.con/ support/ submit-a-case.html.

8. Bi-directional Arguments

Bi-Directional Arguments

The following arguments are appended to the end of the command line followed by a
space and forward slash (i.e./A). A space and forward slash are also used to separate
each additional argument (i.e. /A /M).

IGV
Always Create Superset during Bi-directional Synchronization: Ifthe /GV argu-
mentis used, PeerSync will notuse the TLR value, and therefore always create a superset

of data during a bi-directional synchronization.

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.
IGW
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Enable Temp Files: Ifthe /GW argumentis used, PeerSync will enable the use of tem-
porary files during file/folder renames and deletes. This is useful during 'Real-time Bi-Direc-
tional Synchronization' in order to prevent oscillation.

/LB
Bi-directional Folder Deletion: If the /LB argument is used, PeerSync will delete
folders thathave been deleted from Targetor Source during bi-directional scans.

/ILC
Use Last Access File Time: Ifthe /LC argumentis used, PeerSync will always use last

access file time for bi-directional synchronization.

/
Set Trigger Folder File Name: |If the /LD argument is used, PeerSync will set en-
hanced bi-directional synchronization trigger folder filename extension to:

M Use machine name as extension

A Use LastAccessTime for TLR comparison
T Use ""FLDR" extensionin place of TLR

R Reset/Delete all trigger folder-files

/ILE

Use Enhanced bi-directional synchronization mode: The /LE argument is equi-
valent to /LDMAT mode. This will alter the way the bi-directional synchronization option
functions by using enhanced features to track all file and folder adds, updates, deletions,
renames and moves between scan cycles. In this mode PeerSync will use a hidden sys-
tem trigger file within each sub-folder to store information about the last scan cycle for that
sub-folder. Using this trigger file PeerSync can determine if a Folder was added, deleted,
renamed or moved since the lastscan.

Note: This itemis selectable from the Profiler via the Options/ Commands Screen.

/IYO-

Retain Last Access Time for Two Machine bi-directional synchronization:
The /YO- argument will store the original Last Access time of the Source File before syn-
chronization and then it will set the Source and Target files' Last Access Times with the
stored time after a file add or update. This will allow bi-directional scans between two ma-
chines to properly track file adds then subsequentfile deletes within the nextscan cycle.

Notes:

1. When using standard or enhanced bi-directional synchronization we recommend adding / YO- as well
as /QYD:0 to your list of command line arguments to ensure deleted files from one side are not re-added
by the other side.

2. The /YO- argument should NOT be used if there are more than two machines involved in a bi-direc-
tional synchronization due to the need of the Last Access Time to be used by the third, fourth etc. ma-
chine during comparison with either of the other two machines.

/QYD:n

Set Safety Value for Last Run Time: By default PeerSync uses /QYD:5 during stand-
ard or enhanced bi-directional synchronization. With this option enabled deletion events
are programmatically delayed by approximately 10 seconds to account for any time differ-
ences between machines. This can be problematic when performing standard or en-
hanced bi-directional synchronization where a deleted file from one side can be re-added
by the other. In this scenario we recommend using /QYD:0 which represents a safety value
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of 0 seconds fordeletions.

n=0 safety value =0 seconds

n=1 safety value =approximately 2 seconds
n=2 safety value =approximately 4 seconds
n=5 safety value =approximately 10 seconds

Note: When using standard or enhanced bi-directional synchronization we recommend adding /QYD:0 as
well as LYO- to your list of command line arguments to ensure deleted files from one side are not re-added
by the other side.

Notes:

1. Any arguments containing spaces must be enclosed by quotes.

2. Some features described on this page require the Enhanced Package.

3. Command line arguments can also be identified through hints displayed on the Profiler.

4. If you have selected to display hints through the View Menu (either on the application interface or in its Status
Bar), a hint will be displayed for Profiler features upon passing the mouse cursor over them. These hints will dis-
play both a description of the feature as well as its related command line argument (if any).

5. For more information on the latest features and how to implement specific scenarios please go to our support
page at: http:// www.peersoftware.conv support/ submit-a-case.html.

Other Components

1. PeerSync Status Display

Status Display Screen

This screenis used to view Current Profile Activity within the PeerSync application. The

Status Display window can only be viewed when PeerSync is running as an Application

and notas a Service. Enable the "Display status in PeerSync" option available in the Op-

tions/Commands > Display Options... dialog to have the Status Display show automatically
atthe start/launch of PeerSync orright-click on the Tray Icon and select"Show Status Dis-
play".

Profile Displays the name of the Profile actively being processed.
This label may not match the name of the Profile currently be-
ing configured through Profiler.

Job This indicator will dynamically display the name of whichever
Job is presently being processed for the Active Profile.

Mode Displays the Operation Mode (Real-time Mode, Scheduled
Operation, etc.) applied to synchronization of the Active Profile.

Source Displays a file path for the Source Folder presently being syn-
chronized.

Target Displays a file path for the Target Folder presently being syn-
chronized from the Source indicated above.
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Folders

This indicator provides a count of all unsynchronized folders
contained within the Source, and will decrease as each folder
is synchronized. An additional "thermometer" indicator will also
track the progress of folder synchronization.

Files

This indicator displays the total number of files contained within
the Source while also providing a count of synchronized files. In
addition, a "thermometer" indicator will show file synchroniza-
tion progress by increasing according to the size of the current
folder, with 100% representing the cumulative size of files con-
tained within the Source Job set.

File

Indicates the name of the file currently being synchronized.

Large File or Com-
pression Status

This caption will be displayed to the right of the file name thatis
currently synchronized for large files and during compression.
The caption will show the size of the file that has been copied to
the Targetand/orcompression status.

Skip File

This button will appear once the active Profile has been
launched. T his feature allows you to skip synchronization of the
file currently displayed in the indicator described below. Skip
Files enables you to avoid delays caused by large files on
slow network or dial-up connections.

Size

Indicates the size (in bytes) of the file currently being synchron-
ized. A related "thermometer" indicator tracks the progress of
synchronization for thatfile.

Checked

This indicator displays the total number offiles contained in the
selected Source Folders.

Excluded

Indicates the number of files that were excluded from synchron-
ization (See Exceptions).

Messages

Indicates the number of error messages generated during Pro-
file processing.

Updated

Indicates the number of TargetFiles that were updated during
synchronization of Profile Jobs.

Added

Indicates the number of new files added to TargetFolders dur-
ing synchronization of Profile Jobs.

Deleted

Indicates the number of files deleted (or moved) during syn-
chronization of Profile Jobs.

Target Space

Indicates the Target Folder space remaining during synchron-
ization of Profile Jobs.

Elapsed Time

Indicates the amount of time thathas elapsed during the current
Profile activity.

Hide

Icon Men.

Will hide this display, which can be re-accessed via the Tray

Quit

Allows you to close/exit the current session of PeerSync.
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Other Screen Features

Processed Lists

The Updated, Added, Deletions and Excluded screens will
display statistical information in the above format. Each screen
will have statistical information (File Name, Size, Modified
Date/Time, Path, Duration, etc.) about the changes thathave
occurred during the current PeerSync session.

Item Count

Display ofthe amount of changes thathave occurred for the
currentscreen.

Maximum List Size

Allows you to selectthe maximum amount of changes thatyou
wish to store for the current screen. ltis recommended to keep
this value low because each entry requires memory to be used
by PeerSync.

Status Display Popup Menu

Activated by right clicking on the PeerSync Status Display. The Status Display window can
only be viewed when PeerSync is running as an Application and notas a Service. Enable
the "Display status in PeerSync" option available in the Options/Commands > Display Op-
tions... dialog to have the Status Display show automatically at the start/launch of PeerSync
orrightclick on the Tray Icon and select"Show Status Display".

View Log File

Allows you to access, launch and view Log files in the default
texteditor for the current Profile.

View Admin Folder

Allows you to access, launch and view Admin log file Folders in
Explorer for the current Profile.

Open Source Folder

Allows you to access, launch and view Source Folders in Ex-
plorer for the current Profile.

View Target Folder

Allows you to access, launch and view Target Folders in Ex-
plorer for the current Profile.

Print Allows you to print the current screen information.
Save As Allows you to save the current screen information to file.
Clear List Allows you to clear/resetthe current screen information.

Re-Load Profile

Allows you to re-load the current Profile ifany changes have
occurred.

About PeerSync Will display an about screen, that contains information about
the current PeerSync you are running.
Quit Allows you to close/exit the current session of PeerSync.

2. PeerSync Remote Control

PeerSync Remote Control Screen Features
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chine.

This feature allows you to connect to and monitor any PeerSync currently running on your
LAN. Including PeerSync running as an application or a service on the local machine and/
or any instances of PeerSync running on any machine thatis accessible from the local ma-

Profile Selection

The field located to the left of the Add Button. This field is used
to add a Profile to the Profile Selection List. The formatfora
Profile selectionis: MACHINENAME:PROFILENAME (i.e.
DELLSERVER:Profile.snc).

Profile Selection List

The listlocated below the Profile Selection, which contains Pro-
file Selections thatcan be connected to and monitored by se-
lecting the item and using the Connect button.

Add This button will add the current Profile Selection to the Profile
Selection List.

Connect This button will connectto the current Profile Selection and dis-
play its activity on the screen.

Disconnect This button will disconnect the current Profile Selection and
stop the display of activity.

Refresh This button will refresh the current Profile Selection activity.

Pause/Resume This button will pause/resume the current Profile thatis selec-
ted.

Query This button will search for and add all Profiles that can be found
to the Profile Selection List.

Clear List This button will clear out all entries from the Profile Selection

List.

Remote Connection
Information

Displays the computer, user and lastresponse for the current
connection.

Close

This button will close this dialog.

Note: The features described on this page require the Enhanced Package.

3. Quick-Sync

This feature is a quick and easy way to synchronize folder(s) on the fly to backup location(s)
with the option to modify your Job settings ata latertime.

Simply right click on any folder you wish to sync and select "Quick-Sync Folder...". This will
launch the Wizard, which will ask you to select a Target Folder to sync to...and your ready to
run the Quick-Sync. You also have the options to editand/oradd the current sync Job to your
Quick-Sync Profile or any other selected Profile. Then the next time you select a folder if it
matches any Source or Target selection in the Quick-Sync Profile the Jobs will be listed to
pick from oryou have the option to add a new Job.
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Deletions) 146

/LPE (Set Delay between Enhanced Real-Time Event

Processing) 146

/LPM (Set Enhanced Real-Time Event Upper Limit)

146

/LPQ (Set Delay between Enhanced Real-Time Queue

Checking) 146

/LPW (Set Enhanced Real-Time Event Queue Delay)
146

/LPX (Set Process Delay for Enhanced Real-time

Changes) 146

/LR (Run application at start of PeerSync) 139

/LSE (Log Senice Events to the Event Viewer)

133

/LW (Enable Last Access Compare) 139

/LZR (NFS Replication) 139

/LZS (Compare and Set File Attributes from Windows

to NetApp) 139

131,
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/LZTX (Remowe Failed Events If Successfully
Re-Processed) 139

IM (Show Tray Icon) 131

IMCT (Set Copy Threads) 129

IMFT (Set Job Threads) 129

/NODELFLDR (No not delete folders) 139

/O (Set Target File Overwrite) 139

/OPTIMIZE (Optimize Performance) 129
/PERFORMANCE (Set Application Priority) 129
/PROGRESS (Display status in PeerSync) 131
/1Q7+s (Include Volumes for NetApp FPolicy
Detection) 131

/Q70 (Exclude Common Job Exceptions in Event
Processing for FPolicy Jobs) 131

/Q70s (Exclude Extensions for NetApp FPolicy
Detection) 131

/Q7L (cDOT Optimizations) 139

/Q70 (Share Migration Reporting levels) 131
/Q70 (Share Migration support for cDOT 8.3) 139
/Q7-s (Exclude Volumes from NetApp FPolicy
Detection) 131

/Q8B (In Queue Display Options) 131

/Q8BH+ (Enable the Historical Data Tab) 135
/Q8BJ+ (Enable Job Scans Tab) 135

/QB (Use Full Access File Copy) 139

/QD (Always Use Partial Locked File Extensions List
For VSS) 149

/QF (Shadow Time Range) 139

/QG (Always use the local machine time for the Last
Run Time) 139

/QH (Force Flush File Buffers) 139

/QHD (Direct Disk Write) 139

/QI (Ignore Matching/Locked File Extensions) 139
/QJ (Ignore Matching/Locked File Postfix
Replacement) 139

/QP (Disable Job Stats) 135

/QP (Don't Display Job Stats) 131

/QQ (Enable the File Copy Progress Tab) 135
/1QQ<< (/QQ<< (Disable the Show Advanced Display
link) 135

/QR (Exclude Common Job Exceptions in Event
Processing) 131

/QY7 (XML File Creation Intenal) 131

/QYD (Set Safety Value for Last Run Time) 105,
149, 150

/R (Real time Monitoring Argument) 136

/IS 6

/S (Run Scheduled Operation) 136

/SNMP (Enable SNMP Error Reporting) 131
/Sx (Synchronization Timer Argument) 136

/SxKz (Synchronization Timer Argument with
Keyboard Activity) 136
/T (Terminate All Instances of PeerSync 139

/TD (Display status in PeerSync upon completion)
131

/TIME (Daily Timer) 136

/UDD (Use Device Driver method) 136
/USEPROFILEARG 128

IVRB (Verify User-Name) 139

/W (Set Queue Directory Change Count) 139

/WPFIX (Disable application associated with sync)
139

/WPMOD (WordPerfect Fixes for synchronization)
139
/X (Disable Initial Synchronization During Startup)
136

/YC (Folder Queue Watch Interval) 139

/YD (Allow Replication During Dynamically Created
Jobs) 139

/YF (Partial Locked File Extensions List) 139, 142
/YK (Set Real-time Copy Thread Pool) 146

/YK:n (Set Real-time Copy Thread Pool) 129

/YL (Log Messages Only to a Log File by Filter and/or
by Profile) 131

/YN (Use Network Password Dialog) 139

/YO (Retain Last Access Time for Two Machine
bi-directional synchronization) 105

/YO- (Retain Last Access Time) 149, 150
/YR (Delete Empty Source Folders After Mowe) 139

/YV (Do Not Validate Connections Before Profile is
Loaded) 139

IYX:n (Set File Read/Write Buffer Delay) 129
IYY (Set VSS Try Count) 149
/Z (Ignore Open File Extensions) 139

-1 -

127.0.0.1

_A -

About PeerSync 151

Accessing Open Files 66, 106, 107, 107
ACL Options (Global) 104

Activate real-time monitoring 60

Active Connection Internval 139

Active Job 151

Active Profile List 151

34, 49
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Add Jobs with Wizard 13
Add - synchronize new files to target 66
Add Jobs 13
Add Quick-Sync Folder option to Explorer menu
112
Add Shares with the selected Prefix 100
Add Shares with the selected Suffix 100
Add Shares: Do Not Update or Delete 100
Add to Windows registry 112
Add to Windows StartUp 112
Add/Delete/Modify Jobs: Tool Buttons
Added Files Reporting Feature 92
Added Indicator 151
Additional Configuration Entries 6
Additional Event Options 82, 84
Additional Features 31, 84
Additional Features List 84
Additional Features Screen: 84, 85, 85

Additional Options 84, 85

Enable file recovery 84, 85

Perform binary comparison on all files (using
CRC32) 85

13, 26

Replace in-use files upon reboot 79, 85
Validation Options 85

Additional File Includes 74

Additional Folder Selection Features 56, 84

Additional Options 84
Additional/Alternate Target Paths 55
Admin Backup 101
Admin Report Cycle Options 94
Admin Reporting 31, 93
Admin Reporting Features 94
Admin Reporting Screen: 93, 94
Admin Reporting Overview 93
Report file name 94
Report File Path 94
Use error information only 94
Use standard report file content 94
Use Summary Information Only 94
Administrative report file storage manipulation and
organization 56
Advanced Backup 101
Advanced Options 31, 100, 100, 101, 101
Advanced View 29
Affinity 129
After each scan 98

After each scan (log all non-scan events on the cycle
specified) 95

After each scan/cycle even if no events occurred
95, 98

After synchronization subtract/add x minute(s) from
target 86

Allow for remote real-time configuration - NetApp
fPolicy 41

Allow Replication During Dynamically Created Jobs
139

Alternate Configuration File 128

Alternate Data Stream (ADS) Backup 101
Alternate Target Path Selection Dialog 55
Alternate/Additional Target Paths 55

Always create a super-set during bi-directional
synchronization 105

Always Create Superset during Bi-directional Sync
149

Always owverwrite 66

Always Run Post Process 139

Always Use Partial Locked File Extensions List For
VSS 149

Always use the local machine time for the Last Run
Time 139

Append Default File/Folder Exclusions from PeerLock
109

Application Priority 129
Applications to Ignore 136
Argument Selection 106

Argument Selection from the Interface
Arguments 106

Asynchronous Mode - cDOT Options 44

At the start of this Profile 95

At the stop of this Profile 95

Attach log file to messages 97

Attribute Exceptions 90, 91

Automatically detect and use recommended NetApp
configuration 43

Automatically use recommended settings based on
Detection Method 41

Automation 31, 60
Automation Command Line Arguments: 136
Applications to Ignore 136
Daily Timer 136
Delay Scan at Start 136
Device Driver method 136

Disable Initial Synchronization During Startup
136

Interval 136

Keyboard Activity 136

Real time Monitoring Argument 136
Run Scheduled Operation 136

107, 107
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Automation Command Line Arguments: 136
Scan at Start 136
Synchronization Timer Argument 136
Synchronization Timer Argument with Keyboard
Activity 136
Timer Argument 136
Use Device Driver method 136

Automation Features 60

Automation Screen: 60, 60
Activate real-time monitoring 60
Automation Screen Overview 60
Daily Timer Options 60
Run at specific times and selected days 60
Run on an intenal every x minute(s) 60
Use enhanced real-time monitoring 60

_B -

Back Button 13

Back-Up 3

Bandwidth throttling 77

Basic View 29

Bi-directional Command Line Arguments: 149
Always Create Superset during Bi-directional
Sync 149
Bi-directional Folder Deletion 149
Enable Temp Files 149
Retain Last Access Time 149
Set Safety Value for Last Run Time 149
Set Trigger Folder File Name 149

Use Enhanced bi-directional synchronization
mode 149

Use Last Access File Time 149
Bi-directional Folder Deletion 149
bi-directional synchronization 66
bi-directional synchronziation 83
Binary Comparison 85
Bi-Sync Options Button 106
blackout 64
Blackout Settings 31, 64, 64
Block Size Selection 79
Buffer Size - File Read/Write 77
Buffer Size Upper Limit 77
Buttons 13
Byte Replicator 31
ByteReplicator 79, 79

Block Size Selection 79

Excluded File Types 79

Exclusions 79
Minimum File Size 79
Port 79

Time Out 79

_C-

Carbon Copies - Email Reporting 97
cDOT Options - Global: 44
Asynchronous Mode 44
Disable Alternate Share Lookup 44
Changing Profile Job List Window 26
Check for ACL changes during scans 104
Checked Indicator 151
Choose external applications/scripts to be run before
and after the processing of a given Job 99
CIFS - Permissions 45
CIFS - Scan Method 45
CIFS/NFS Security Style 74
Clear List 151
Clear Log File 91
collect real-time events 64
Command Line Argument Selection 106

Command Line Argument Selection from the Interface
107, 107

Command Line Arguments 107, 107, 127

Compare and Set File Attributes from Windows to
NetApp 139

Compare Time Change 86
Compression - TCP Target 52
Compression Status 151
Computer Name Variable 56
Configuration Command Line Arguments: 128
Alternate Configuration File 128
Load Alternate Configuration File 128
Set SNC Fileto Load 128
Set Source Path 128
SNC File 128
Use Arguments from Profile 128
Configuration Entries 6
Configure - NFS Settings 71
Configure Normal Source Folder 48
Configure Normal Target Folder 54
Configure TCP Source Folder 48
Configure TCP Target Folder 55
Connect As - Network Logon Setting 42

Connect to and monitor any PeerSync currently
running on your LAN 153
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Connection Manager
Only include connections that are set for real-time
monitoring 41
Scan real-time Jobs on reconnect if "Scan Job
once at start" is enabled 41
Connection Manger for Failed Connections - Source
Folder: 41
Disabled 41
Enabled for Source and Target Connections 41
Enabled for Source Connections Only 41
Enabled for Target Connections Only 41
Conwert to GMT for comparison purposes 86
Copy File Method - Global: 45
Admin Backup 45
Advanced Backup 45
Advanced Backup with Permissions 45
CIFS - CopyFile API - /GFC Argument 45
CIFS - CopyFileEx API - /GFE Argument 45
CIFS - Default 45
CIFS - File Stream Method - /GFS Argument
45
NFS - Unix/Linux cp command 45
NFS - Unix/Linux rsync command 45
Copy Jobs 13
Copy Thread Utilization 129
Copy Threads 103, 129
Copyright 3
CRC32 85
Create a report for every event 94
Create a report on an interval 94
Create areport once aday 94
Create a report once aweek 94
Create administrative Email messages 96
Create administrative report files 94

Create and Append Summaries into One Report
131

Create Email messages 96

Create Normal Souce Auto Job Name 48
Create Normal Target Auto Job Name 54
Create Pre Sync Report 26

Create Shortcut on Desktop 112

Create SNC extension association for Profiler 112
Create Source Folder 34

Create Target Folder 49

Create Target TCP Auto Job Name 55
Create TCP Source Auto Job Name 48
Current Arguments 106

Current Arguments Button 106

Current Attributes 90, 91

Current Command Line Argument Selection 102,
106

Customize Selection Tree 29

Customized View 29

D -

Daily Timer 136

Daily Timer Options 60

Date variables for Folder Paths 56

Date/Time Variable 56

Dates Exceptions 90

Day variables for Folder Paths 56

Days of the week scheduling 60

Default inclusion 87

Default Read/Write Buffer Size 77

Delay between Enhanced Real-Time Deletions 146

Delay between Enhanced Real-Time Event Processing
146

Delay between Enhanced Real-Time Queue Checking
146

Delay Scan at Start 136
Delayed Write Failed 139
Delete 7-Mode FPolicy 47
Delete Empty Source Folders After Move 139
Delete fPolicy on Close - NetApp Settings 43
Delete Jobs 13
Delete log file after successful send 97
Delete Unmatched Target Files 68, 68
Delete unmatched target files older than x days 68
Deleted file storage manipulation and organization
56
Deleted Indicator 151
Deletion Folder 68
Deletion Options 67, 68, 68
Deletion Options Button 68, 68
Destination IP 93
Detection Method Options: 40
Allow for remote real-time configuration 40
Exclude Users 40
Detection Method: 40
Default 40
EMC CEE Celerra/VNX 40
EMC CEE Isilon 40
NetApp FPolicy 7-Mode 40
NetApp FPolicy cDOT 40
Device Driver method 136
Disable all Startup Options 112
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Disable Alternate Share Lookup - cDOT Options 44
Disable application associated with sync 139
Disable cDOT FPolicy 47

Disable Failed Connection Timer 139

Disable Initial Synchronization During Startup 136

Disable Install Reboot 6

Disable Jobs that are Not Configured from this Profiler
110

Disable Real-time Security Change

Disabled - Connection Manager 41

Display status in PeerSync 131

Display status in PeerSync upon completion

Dissimilar time zone synchronization 86

Distribution 3

Do Not Validate Connections Before Profile is Loaded
139

Drag and Drop Source Folder Selection

Drag and Drop Target Folder Selection

Drive Mapping 59

During comparison subtract/add x minute(s) from

target 86

Dynamic Network Drive Mapping and Un-mapping

59

Dynamic archives 56

Dynamic synchronization based on date 56

Dynamic synchronization based on logged on user or
machine name 56

Dynamic synchronization based on personal folders or
other variables read in from the registry 56

_E -

Easy way to synchronize folders on the fly
Edit Job Groups Dialog 28
Edit Menu 17
Edit Normal Source Variable File
Edit Normal Target Variable File
Elapsed Time Indicator 151
Email Report Cycle Options
Email reporting 96
E-mail Reporting 31
Email Reporting Features
Email Reporting Ovenview
Email Reporting Screen: 96, 96, 97
Attach log file to messages 97
Create administrative Email messages
Delete log file after successful send 97
Report file name - Email Reporting 97

146

131

34
49

154

48

54

98

96
96

96

160

Use error information only 96
Use standard report file content 96
Use summary information only 96

Email Threads 129
Embedded Open File Manager
Enable CIFS Screening 41
Enable file recovery 84, 85
Enable intelligent network load balancing 77
Enable intelligent network load balancing (when
applicable) 77

Enable Last Access Compare 139

Enable NFS Extended Reporting and Display -
Permissions 45

66

Enable NFSV3 Screening 41

Enable NFSv Screening 41

Enable PSObserver Broadcasts 131
Enable SNMP Error Reporting 131

Enable Summary Statistics Collection 131
Enable Temp Files 149
Enabled for Source and Target Connections -

Connection Manager 41

Enabled for Source Connections Only - Connection

Manager 41

Enabled for Target Connections Only - Connection

Manager 41

Encryption - TCP Target 52

Enhanced real-time 60
Enhanced Real-Time Event Queue Delay 146
Enhanced Real-Time Event Upper Limit 146

Enhanced Scan Processing 61
Error Reporting 131
Evaluating a new version of PeerSync 11
Evaluation Menu 24
Event Options 67
Exception Screen Features
Exceptions 31, 86
Exceptions Screen:
Exceptions Screen Owveniew 86
Exclude Files by Character/String/Extension
Exclude Files from Sync by Size 90
Exclude Files in Sync by Attribute 91
Excluding Folders from Sync 89

86

Include File Types (using wild cards) 87

Include Files in Sync by Attribute 90

Include Files in Sync by Date 90
Exclude all open files until closed 74
Exclude Extensions - NetApp Settings 43

Exclude File Sizes 90

Exclude Files 88

88
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Exclude Files Button 88

Exclude Folders 89

Exclude Folders Button 89

Exclude Folders drop down list 89

Exclude Folders that have a Reparse Point 139
Exclude IP Address - NetApp Settings 43
Exclude open files 74

Exclude open files (allow read access to source file
during transfer) 74

Exclude open files (deny all access to source file
during transfer) 74

Exclude root folders 89

Exclude specific folders only 89
Exclude Users - NetApp fPolicy 41
Exclude Volumes - NetApp Settings 43
Excluded Indicator 151

Exclusion drop down list 88
Exclusive Remedy 3

Executable Path (PeerLock) 114
Executable Path (PeerSync) 112
Explore Source Folder 34

Explore Target Folder 49

_E -

Failed connection 102
Failed Registration 8
Features 84
File Date Reporting Feature 92
File Dates 90
File Deletion Options
File Exclusions 79
File Folder Path Variables 56
File Indicator 151
File Menu 16
File Options 31, 66
File Options Features 66
File Options Screen: 66, 66, 68
Add - synchronize new files to target 66

68, 68

Awoiding Permanent Deletion 68, 68
Delete Unmatched Target Files 68, 68
Delete Unmatched: Options 68, 68
Deletion Warning Message 68, 68

Mode Selection 66
Replicate - Delete unmatched files/folders 66
Update - synchronize existing files in target 66
Use Windows Recycle Bin 68, 68

File Path Variables 56

File Path Variables: Folder Selection 56
File Read/Write Buffer Size 77, 77
File Recowery 84, 85
File Size Reporting Feature 92
File Sizes 90
File Time Change Options 84
File Time Reporting Feature 92
File Versions 81
File/Folder Permission Options: 73
Global Settings 73
NTFS Options 73
Transfer File and Folder Permissions 73
Files Indicator 151
Folder ACL Detection 146
Folder Change Detection 146
Folder Creation Reporting Feature 92
Folder Names Reporting Feature 92
Folder Queue Watch Internval 139
Folder Restoration feature in real-time 60
Folder Selection 31
Folder Selection Features 34
Folder Selection Screen: 34
File Path Variables 56
Folder Selection Screen Oveniew 34
Source Folder Selection 34
Target Folder Selection 49
Folders Indicator 151
For each individual error message as it occurs 95
for each message/error as it occurs 98
Force Flush File Buffers 139
Force Source Folder Root as Target TCP Folder Root
55
fPolicy Name - NetApp Settings 43
FPolicy Utility Features: 47
Delete 7-Mode FPolicy 47
Disable cDOT FPolicy 47

_G -

General 3

Get Info - cDOT Options 44

Get Info - System Information for Source Host 42
Get Remote PC Time 139

Global ACL Options 104

Global Advanced File Xfer Options 100, 101
Global bi-directional Options 102, 105

Global Display Options - Profiler Options 107
Global Managed Files Options 102
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Global Migrate Shares Options 100, 101 Include Shares - cDOT Options 44
Global Options 110 Include Sub foldersFolder Selection Screen:
Global Recovery/Offline Options 102 Include Source Sub-Folders 34
Global Settings - Permission Options 73 Include this Job in PeerLock 109
Global Settings (PeerLock): 110 Include Volumes - NetApp Settings 43
Disable Jobs that are Not Configured from this Inclusion drop down list 87
Profiler 110 Information Required to Register software 8
Global Options 110 initiate scan on trigger file change 65
Link this Profiler to PeerLock 110 Initiate Synchronization on Source or Target
Sawve Changes in PeerLock 110 File/Folder Change 60
Show PeerLock 110 Install Options 6
Global Settings (PeerSync): 102, 102, 103, 104, Install Senice (PeerLock) 114
105, 106, 106, 107 Install Senice (PeerSync) 112
Global VSS Options 102 INSTALL.LOG 6
Greater Than File Size Exclusion 90 Installation (Silent Install) 6
Installation Configuration Options 6
_ H _ Installing PeerSync 6
Intelligent Network Load Balancing 77
H+ (Skip setting of main form visible) 131 Intermediate View 29
Help Button 13 Intenval 136
Help Menu 21 Intervals Button 102
Hide 151 IP Address - NFS Settings 71
Hide Splash Screen 131 ltem Count 151
Host Name 51
Host Server Name - NetApp Settings 43 - J -

Hour variables for Folder Paths 56
job data import 59
_ I _ Job Indicator 151
Job Menu 20
Job Scan Method - Global: 45
CIFS - Default 45
NFS - Unix/Linux rsync command 45

Ignore File Size and/or Date Comparison 139
Ignore Matching/Locked File Extensions 139
Ignore Matching/Locked File Postfix Replacement

139 Job Settings (PeerSync): 31, 34, 60, 64, 65, 66, 74,
Ignore Open File Extensions 139 76, 71, ?91 81, 82, 84, 86, 91, 93, 96, 99

Ignore Target Space During File Copy 139 Job Settings PeerLock: 109

Improve Load Balancing 77 Append Default File/Folder Exclusions from

PeerLock 109

Include all open files 74 . i
Include this Job in PeerLock 109

Include attribute change as synchronization criteria

84 Job Threads 103, 129
Include Files 87 Jobs 12,153

Include Files Button 87

Include open files 74 - K -

Include open files (allow read & write access to source
file during transfer) 74

Include open files (allow read access to source file
during transfer) 74

Include open files (if possible) 74
Include partially open files 74

Keep backup files of overwritten Target Files 81
Keep files in Alternate Folder 81

Keep files in Deletion Folder 81

Keep files in Target Folder 81

Keep multiple versions of files 81
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Keyboard Activity 136 Set VSS Base Timeout 149
Set VSS Try Count 149
L VSS Interval 149

Management IP - cDOT Options 44

Match Shares: Add, Update and Delete 100
Maximize Speed 77

maximum duration of scans 65

Maximum List Size 151

Maximum Log File Size 92

Maximum Number of Events to Process 146
Menu (PeerSync):

Large File or Compression Status 151
Last Run On 56

Last Run On - Reset 26

Last Run On Feature 26

Last Save 56

Last Scan 56

Launch (PeerLock) 123, 124

Launch (PeerSync) 116, 118 Edltl t'17 24
Launch Current Profile 13 F'\Ila ua I106n
Left side Panel - Selection Tree 29 HI T 21
Less Than File Size Exclusion 90 €p
. Job 20
License 3 Onti 18
License File 6 Pp |cg1s - | PooUp M o5
Limit CPU usage during file transfers 129 eersync fray icon Foptip Menu
. Run 19
Limit number of processors to use 129 .
View 17

Limit system resources during file transfers 129
Limitations of Liability 3

Limited Warranty 3

Link this Profiler to PeerLock 110

List of Exclude Files (using sub strings) 26, 88
List of Exclude Folders 89

List of Include File Types (using wild cards) 87
List of Job Selections - Daily Timer 60

Load Alternate Configuration File 128

Load Balancing 77

Log File - Clear 26

Log File - View 26

Log file storage/manipulation/organization 56
Log Files: Administrative 93

Log Messages by Filter 131

Log Messages by Profile 131

Log Messages Only to a Log File by Filter 131
Log Messages Only to a Log File by Filter and/or by

View Popup Menu 25
Messages Indicator 151
Messages Reporting Feature 92
Migrate Shares 100, 100
Minute variables for Folder Paths 56
Miscellaneous 31, 82
Mode Indicator 151
Mode Selection 66
Modify NFS Default Options: 72
NFS mount Options 72
NFS rsync Options 72
Monitor ACL changes during real-time 104
Monitor PeerSync activity across the LAN 153
Monitor Remote Instances of PeerSync 153
Month variables for Folder Paths 56
Mount Folders - NFS Settings 71
Mowe Files 83, 139

Profile 131 Mowve Job Down 13
Log Messages Only to a Log File by Profile 131 Move Job Up 13
Log Senice Events to the Event Viewer 131 MS Windows Explorer Add On - Quick-Sync 154
loopback 34, 49 MSMQ messaging 131
Multiple Copy Threads 103

M Multiple Job Threads 103
Managed Files 31, 76 - N -
Managed Files Arguments: 149

Always Use Partial Locked File Extensions List Naming and Renaming Jobs 26

For VSS 149
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NetApp FPolicy - Source Folder NetApp Settings
43
NetApp FPolicy 7Mode 40
NetApp FPolicy Additional Settings: 43
Exclude Extensions 43
Exclude IP Address 43
Exclude Volumes 43
Include Volumes 43
NetApp FPolicy cDOT 40
NetApp FPolicy cDOT Additional Settings: 44
Include Shares 44
Management IP 44
Primary Sener 44
NetApp FPolicy cDOT SVM Logon Settings: 44
Password 44
Username 44
NetApp FPolicy Screening Options: 40
Enable CIFS Screening 40
Enable NFSV3 Screening 40
Enable NFSwv Screening 40
NetApp Settings :
Delete fPolicy on Close 43
fPolicy Name 43
Host Sernver Name 43
Root Path Prefix 43
Use Asynchronous Mode 43
Use cDOT Detection 43
NetApp Settings: 43
Network Constant - TCP Target 52
Network Drive Mapping 59
Network License 3
Network Load Balancing 77
Network Logon Settings: 42
Connect As 42
Password 42
New Profile 13
Next Button 13
NFS - Permissions 45
NFS - Scan Method 45
NFS mount Options 72
NFS Replication 139
NFS rsync Options 72
NFS Settings 31
NFS Settings Screen: 71
Configure 71
IP Address 71
Mount Folders 71
Password 71

164

Unmount Folders 71
User Name 71
No not delete folders 139
Non Persistent Processes 26
Normal 40
Normal Source 34
Normal Source Mode Selection 39
Normal Source PopUp 48
Normal Target 49
Normal Target Mode Selection 51
Normal Target PopUp 54
NTFS Options 73
Number of backup files to keep 81

-0 -

Only Hide the about screen 131
Only use Advanced Settings 94, 98
Open File Manger Options 66
Open File Options 66

Open Files 31, 74, 74, 107, 107
Open Profile 13

Open Source Folder 34, 151
Open Target Folder 49
Open/Locked Files 74
Optimize Performance 129
Optimize speed 77

Options Menu 18

Options/Commands 31, 107, 107, 151

Options/Commands Features 107, 107
Options/Commands Oweniew 107, 107
Options/Commands Screen: 106, 107, 107

Current Arguments 106
Current Arguments Button 106

Oweniew 107, 107
Set Access Password 107, 107
Show tray icon 107, 107

Other Global Options/Command 102
Oweniew 12, 153

Owverwrite Existing Log File 91

Owerwrite existing Pre-Sync report file 106

- P-

Parameter Selection from Profiler 106
Partial Locked File Extensions List 139
Password - Network Logon Setting 42
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Password - NFS Settings 71
Password - Registration 8
Password - TCP Target 52
Password for Tray Icon 107, 107
Passwords - cDOT Options 44
Path (PeerLock) 114
Path (PeerSync) 112
Path to Host 51
Path to Host - TCP Target 52
pause scan during specific times 64
Pause Senice (PeerLock) 123, 124
Pause Senice (PeerSync) 116, 118
PeerLock Selection Tree Category 29
PeerLock Senice: 123, 124
Launch PeerLock 123, 124
Pause Senice 123, 124
Resume Senice 123, 124
Run as a senice 123, 124
Start Senice/Application 123, 124
Stop Senice/Application 123, 124
PeerSync Command Line Arguments 127
PeerSync Global Settings 31
PeerSync Installation 6
PeerSync Remote Control 153
PeerSync Selection Tree Category 29
PeerSync Senice: 116, 118
In Sync 118
Launch PeerSync 116, 118
Pause Senice 116, 118
Resume Senice 116, 118
Run as a senice 116, 118
Start Senice/Application 116, 118
Stop Senice/Application 116, 118
Trending 118
PeerSync Status Display 151
PeerSync Status Display Popup Menu 151
PeerSync Temp Folder 6
peersync93.exe 6
PeerSync93.lic file 6
Perform binary comparison on all files (using CRC32)
85
Performance 31, 77, 77
Performance - Threads 103
Performance Command Line Options: 129
Affinity 129
Application Priority 129
Copy Thread Utilization 129
Copy Threads 129

Email Threads 129

Job Threads 129

Limit CPU usage during file transfers 129
Limit number of processors to use 129
Limit system resources during file transfers 129
Optimize Performance 129

Priority 129

Processor Affinity 129

Set Application Priority 129

Set Copy Threads 129

Set Email Threads 129

Set File Read/Write Buffer Delay 129
Set Multitasking Delay 129

Set Processor Affinity 129

Set Real-time Copy Thread Pool 129
Set Shared Process Delay 129

Set the percentage of copy threads to reserve for
real-time events 129

Shared Process Delay 129

Thread Utilization 129

Threads 129

Performance Features 77

Performance Options All Jobs 107, 107
Performance Package 103, 107, 107
Performance Priority Selection 103
Performance Screen: 77

Enable intelligent network load balancing (when
applicable) 77

File Read/Write Buffer Size 77

Set maximum number of copy threads tox 77
Throttle bandwidth - Use x percent of available
bandwidth 77

Permissions 31
Permissions (Security style) - Global: 45

CIFS - Default (NTFS) 45

Enable NFS Extended Reporting and Display
45

NFS - Unix/Linux down and chmod commands
(UNIX) 45

Pop Up Menu: Profile Job List 26, 29
Pop Up Menu: Selection Tree 29

Port - Email Reporting 97

Port - TCP Target 52

Port Configuration 79

Post Installation Configuration Options 6
Post process application 99

Pre Installation Configuration Options 6
Pre process application 99

Pre/Post Features 99
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Pre/Post Owverview 99
Pre/Post Process 31, 99
Pre/Post Process Oveniew 99, 99
Pre/Post Process Screen: 99
Select Application/Script to Run After 99
Select Application/Script to Run Before 99
Use maximum wait time of x seconds 99
Wait for application to end before continuing 99
Presene Paths 68, 68
Pre-Sync Report Options 106
pricing information 8
Primary Server - cDOT Options 44
Print 151
Priority 129
Priority Selection 103
Process Delay for Enhanced Real-time Changes
146
Process Migrate Shares after each scan 101
Process Migrate Shares every x minute(s) 101
Processed Lists 151
Processor Affinity 129
Product Definitions 12, 153
Product Support 12, 153
Product Updates 8
Profile Description: 16
Default Description 16
Hiding Profile Description Toolbar 16
Moving Profile Description Toolbar 16
Profile Indicator 151
Profile Job List Pop Up Menu 26
Profile Job List: 26
Add/Delete/Modify Jobs 26
Changing Size of Window 26
Naming and Renaming Jobs 26
Selecting Jobs and Multiple Jobs 26
Profile Options: Customize 29
Profile Options: Show All 29
Profile Selection 153
Profile Selection List 153
Profiler 12, 153
Profiler Command Line Arguments 127
Profiles 12, 153
PSDef.CFG 6
PSErrorlog 92, 92
PSObsener Broadcasts 131

Quantity Discounts 8
Quick-Sync 154
Quick-Sync Folder 154

Quick-Sync Profile 154
Quit 151

"R -

Real time File Folder Change Detection 60
Real Time Mode 12, 153
Real time Monitoring Argument 136
Real Time Options 62
Real-time Attribute Change 146
Real-Time Command Line Arguments: 146
Disable Real-time Security Change 146
Folder ACL Detection 146
Folder Change Detection 146
NFS Replication 146
Real-time Attribute Change 146
Set Delay between Enhanced Real-Time Deletions
146
Set Delay between Enhanced Real-Time Event
Processing 146

Set Delay between Enhanced Real-Time Queue
Checking 146

Set Empty File Delay 146

Set Enhanced Real-Time Event Queue Delay

146

Set Enhanced Real-Time Event Upper Limit 146

Set Maximum Number of Events to Process
146

Set Process Delay for Enhanced Real-time
Changes 146

Set Real-time Copy Thread Pool 146

Set Shadow Detection 146

Use Update Sensitivity 146
Real-time Copy Thread Pool 146
Real-Time Event Detection Options 60
Real-time Monitoring 60
Real-time Options Button 60
Reboot Options Button 85
receive an e-mail at start of profile 98
receive an e-mail at stop of profile 98
Recowery Intenvals Button 102
Register by FAX 8
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Register by mail 8
Register by phone 8
Register online 8
Registering Evaluation Copy of PeerSync 9
Registering Unregistered Copy of PeerSync 10
Registration and Passwords: 8
Entering User ID/Password (Evaluation Copy) 8
Register By Mail 8
Registry variables to use in Folder Paths 56
Related Global Settings 74
Relative Paths 68
Re-load Profile 151
Remote Connection Information 153
Remote Connection Licenses 153
Remote Control 153
Removwe Failed Events If Successfully Re-Processed
139
Remowe Senvice (PeerLock) 114
Remowe Senice (PeerSync) 112
Rename Job 13
Replace In use Files Options 85
Replace in use files upon reboot 84, 85
Replace Shares: Add and Overwrite 100
Replicate - Delete unmatched files/folders
Replication 12, 153
Report file name 94, 97
Report file path 94
Report Non Standard Events 131
Reporting 31, 91
Reporting Command Line Arguments: 131
Create and Append Summaries into One Report
131
Display status in PeerSync 131

Display status in PeerSync upon completion
131

Enable PSObsener Broadcasts 131

Enable SNMP Error Reporting 131

Enable Summary Statistics Collection 131
Error Reporting 131

Hide Splash Screen 131

Log Messages by Filter 131

Log Messages by Profile 131

Log Messages Only to a Log File by Filter 131
Log Messages Only to a Log File by Filter and/or
by Profile 131

Log Messages Only to a Log File by Profile 131
Log Senice Events to the Event Viewer 131
MSMQ messaging 131

Only Hide the about screen 131

68, 68

PSObsener Broadcasts 131
Report Non Standard Events 131
Run Pre-Sync Report 131
Show Tray Icon 131
Skip setting of main form visible 131
SNMP Error Reporting 131
Summary Report 131
Summary Statistics Collection 131
Suppress connection of PeerSync to the Profiler
131
Tray Icon 131
Reporting Features 91
Reporting Screen: 91
Clear Log File 91
Include Options 92
Maximum Log File Size 92
Owveniew 91
Owerwrite Existing Log File 91
Use Log File 91
View Log File 91
Reporting Standard report file content
Reporting Summary Information Only
Reset Last Run On Value 26
Resume Senice (PeerLock) 123, 124
Resume Senice (PeerSync) 116, 118
Retain Last Access Time 149
Retry failed connections every x minutes 102
Retry open files every x seconds 102
retry open inaccessible files 102
Retry Options Button 85
Revisioning 31, 81, 81
Revisions 81
Root Path - TCP Target 52
Root Path Prefix - NetApp Settings 43

Run a Pre-Sync Report (do not sync files/folders)
106

run a scan on reconnect 102

Run application at start of PeerSync 139

Run as a senice (PeerLock) 123, 124

Run as a senice (PeerSync) 116, 118

Run at specific times and selected days 60

Run External applications/scripts before and after the
processing of a given Job 99

Run Menu 19

Run Pre-Sync Report 131

Run RegEdit 112

Run Scheduled Operation 136

Run selected Jobs at a specific time of day 60

94, 96
94, 96
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Run VSS ewery x minutes 106 Scan limitations 31, 65
Run/View 29 Scanning Options 60
Run/View (PeerLock): 123, 124 Scheduled Mode 12, 153

Launch PeerLock 123, 124 Scheduling Options 60

Pause Senice 123, 124 Security style 74

Resume Senice 123, 124 Select a folder for deleted files to be placed 68

Run as a senice 123, 124 Select Application/Script to Run After 99, 99

Start Senice/Application 123, 124 Select Application/Script to Run Before 99, 99

Stop Senice/Application 123, 124 Select days of the week to run Jobs 60
Run/View (PeerSync): 116, 118 Select Source Folder 34

In Sync 118 Select Source Folder Button 34, 47

Launch PeerSync 116, 118 Select Target Folder 49

Pause Senice 116, 118 Select Target Folder Button 49

Resume Senice 116, 118 Selected File Dates 90

Run as a senice 116, 118 Selecting Jobs 26

Start Senice/Application 116, 118 Selecting Multiple Jobs 26

Stop Senice/Application 116, 118 Selecting Source Folders 34

Trending 118 Selecting Target Folders 49
Run/View Current Profile Activity Screen: 151 Selection Tree 29

Added Indicator 151 Selection Tree: Customize Options 29

Checked Indicator 151 Send an email for every event 98

Deleted Indicator 151 Send an email on an interval 98

Elapsed Time Indicator 151 Send an email once aday 98

Excluded Indicator 151 Send an email once a week 98

File Indicator 151 Senice (PeerLock) 123, 124

Files Indicator 151 Senice (PeerSync) 116, 118

Folders Indicator 151 Senice Details (PeerLock) 114

Job Indicator 151 Senice Details (PeerSync) 112

Messages Indicator 151 Set Access Password 107, 107

Mode 151 Set Alternate/Additional Normal Targets 54

Profile Indicator 151 Set Application Priority 129

Size Indicator 151 Set CIFS Defaults Button 45

Skip Files Button 151 Set Copy Threads 129

Source Indicator 151 Set Deletion Mowve To Folder Cleanup Interval 139

Target Indicator 151 Set Email Threads 129

Target Space Indicator 151 Set Empty File Delay 146

Updated Indicator 151 Set Failed Connection Timer 139
Running Jobs vs. Running Profiles (Run a Quick Sync) Set File Comparison Value 139

26 Set File Read/Write Buffer Delay 129

Set Job Comparison Delta 139
- S - Set maximum number of copy threads tox 77, 77
Set maximum number of retries to x 102

Sample Exclusions 88 Set Multitasking Delay 129
Sawe As 151 Set NFS Defaults Button 45
Save Changes in PeerLock 110 Set Processor Affinity 129
Sawe Profile 13 Set Queue Directory Change Count 139
Saving Profiles 13 Set Real-time Copy Thread Pool 129
Scan at Start 136 Set Safety Value for Last Run Time 149
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Set Shadow Detection 146
Set Shared Process Delay 129
Set SNC File to Load 128
Set Source Path 128
Set Target File Overwrite 139
Set the maximum log file size to x bytes 92
Set the percentage of copy threads to reserve for
real-time events 129
Set Today's Date Button 90
Set Trigger Folder File Name 149
Set VSS Try Count 149
Shadow Time Range 139
Share Migration support for cDOT 8.3 139
Shared Process Delay 129
Show Advanced/Normal Display 118
Show Advanced/Normal Display PeerLock 124
Show All Profile Options 29
Show PeerLock 110
Show Pre-Sync report file at end of run 106
Show Tray Icon 107, 107, 131
Show/hide Selection Tree 13
Show/hide the Selection Tree 29
Silent Installation 6, 6
Simple Network Management Protocol reporting 93
Size Indicator 151
Skip File Button 151
Skip setting of main form visible 131
SMTP Host - Email Reporting 97
SNC File 128
SNMP Error Reporting 131
SNMP Options Button 93
SNMP reporting 93
Source and Target Selections 34
Source Configuration 101
Source File/Folder Alterations 82, 83
Source Folder Connection Manager 41
Source Folder Field 34
Source Folder NetApp Settings 43
Source Folder Popup Menu 48
Source Folder Selection 34
Using Normal Mode 34
Using TCP Mode 34
Source Folder Selection Button: 47
Create Source Button 47
Explore Source Button 47
Open Source Button 47
Source Indicator 151
Specific time scheduling 60

Standard synchronization 66

Start Senice/Application (PeerLock) 123, 124
Start Senice/Application (PeerSync) 116, 118
Startup/Senice 29
Startup/Senice (PeerLock): 114

Executable Path (PeerLock) 114

Install Senice (PeerLock) 114

Path (PeerLock) 114

Remowe Senvice (PeerLock) 114

Senvice Details (PeerLock) 114
Startup/Senice (PeerSync): 112

Add to Windows registry 112

Add to Windows StartUp 112

Create Shortcut on Desktop 112

Create SNC extension 112

Disable all Startup Options 112

Executable Path 112

Install Senice 112

Quick-Sync Folder Option 112

Remowe Senice 112

Run RegEdit 112

Senvice Details 112
Status Display 151
Status Screen 151
Stop Senice/Application (PeerLock) 123, 124
Stop Senice/Application (PeerSync) 116, 118

store events while connection is down 102

store missed events and process on reconnect 102

Summary Report 131

Summary Reporting Feature 92

Summary Statistics Collection 131

Suppress connection of PeerSync to the Profiler

131

Suppress Reboot during Install 6

suspend file transfer 64

Swap Source and Target Folders 56

Sync Selected Jobs 26

Synchronization 12, 153

Synchronization Command Line Arguments: 139
Active Connection Interval 139

Allow Replication During Dynamically Created
Jobs 139

Always Run Post Process 139

Always use the local machine time for the Last
Run Time 139

Compare and Set File Attributes from Windows to
NetApp 139

Delete Empty Source Folders After Move 139
Disable application associated with sync 139
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Synchronization Command Line Arguments: 139

Disable Failed Connection Timer 139 T
Do Not Validate Connections Before Profile is
Loaded 139

Target Configuration 101

Target File Time Change Option 86
Target File/Folder Alterations 82
Target Folder Field 49

Target Folder Popup Menu 54
Target Folder Selection 49

Target Indicator 151

Target In-Use Replacement 139

Enable Last Access Compare 139

Exclude Folders that have a Reparse Point 139
Folder Queue Watch Interval 139

Force Flush File Buffers 139

Get Remote PC Time 139

Ignore File Size and/or Date Comparison 139
Ignore Matching/Locked File Extensions 139
Ignore Matching/Locked File Postfix Replacement

139 Target Space Indicator 151
Ignore Open File Extensions 139 TCP Source 36
Ignore Target Space During File Copy 139 TCP Source Mode Selection 37
Mowe Files 139 TCP Source PopUp 48
No not delete folders 139 TCP Target 50
Partial Locked File Extensions List 139 TCP Target Configuration Tab 51
Run application at start of PeerSync 139 TCP Target Mode Selection 51
Set Deletion Move To Folder Cleanup Intenal TCP Target PopUp 55
139 TCP Target Port Configuration Tab 52
Set Failed Connection Timer 139 TCP Wan Connector Option 36, 37, 50, 51
Set File Comparison Value 139 Temp Files 82, 83
Set Job Comparison Delta 139 Temp Folder Selection 6
Set Queue Directory Change Count 139 Term and Trial Period 3
Set Target File Overwrite 139 Terminate Active Profile 13
Shadow Time Range 139 Terminate All Instances of PeerSync 139
Share Migration support for cDOT 8.3 139 Thread Utilization 129
Target In-Use Replacement 139 Threads 103, 129
Terminate All Instances of PeerSync 139 Throttle bandwidth 77
Use Alternate Copy File Methods 139 Throttle bandwidth - Use x percent of available
Use Delete Path for Revisions 139 bandwidth 77
Use Full Access File Copy 139 Time Change After Sync 86
Use Network Password Dialog 139 Time Delta Selection 86
Verify User-Name 139 Time Out - TCP Target 52

Time variables for Folder Paths 56

WordPerfect Fixes for synchronization =~ 139 )
Time Zone Option 86

Synchronization of files between dissimilar time zones

86 Timer Argument 136
Synchronization Timer Argument 136 Tool Buttons 13
Synchronization Timer Argument with Keyboard Tool Buttons: 13
Activity 136 Add Job 13
Synchronize ALL files via Managed Files 76 Back 13
Synchronize open/locked files via Managed Files 76 Copy Job 13
Synchronize Selected Jobs Option 26 Delete Job 13
System Information for Source Host - cDOT: 44 Help 13

GetInfo 44 Hiding/Moving Toolbar 13
System Information for Source Host: 42 Launch Current Profile 13
Get Info 42 Mowe Job Down 13

Mowe Job Up 13

Copyright © 1993-2016 Peer Software Inc. All Rights Reserved



171

PeerSync Help

Tool Buttons: 13

New Profile 13

Next 13

Open Profile 13

Oweniew 13

Rename Job 13

Sawe Profile 13

Settings Screens Drop-Down List 13

Show Selection Tree 13

Terminate Active Profile 13
Toolbars: Profile Description 16
Transfer File and Folder Permissions 73
Transfer Time Reporting Feature 92
Trap Prefix 93

Tray Icon 107, 107, 131
Tray Icon Popup Menu 25
Tree 29

trigger file 65
Turn file archive attribute off after synchronization 83

U -

Uninstall 6

Uninstall previous versions of PeerSync 11
Unmount Folders - NFS Settings 71

Update - synchronize existing files in target 66
Updated Files Reporting Feature 92

Updated Indicator 151

Updates: Product 8

Upgrade 11

Upgrade Information 11
Upgrade PSListener 11

Use Alternate Copy File Methods
Use Arguments from Profile 128
Use Asynchronous Mode - NetApp Settings 43
Use Block Byte Lewel Synchronization 79

Use block/byte level synchronization 79

Use cDOT Detection - NetApp Settings 43
Use daily timer scheduling 60
Use Delete Path for Revisions
Use Device Driver method 136
Use Enhanced bi-directional synchronization mode
149

Use enhanced bi-directional synchronization mode
options 105

Use enhanced real-time monitoring 60
Use error information only 94, 96
Use Full Access File Copy 139

139

139

Use intermediate file during copy: 83
Use Last Access File Time 149
Use Log File 91

Use maximum wait time of x seconds
Use Network Password Dialog 139
Use Optional Target Unix Linux Settings 72

Use SNMP reporting 93

Use standard report file content 94, 96

Use summary information only 94, 96

Use Unix/Linux system for Job Scans, Copy File
and/or setting Permissions 71

Use Update Sensitivity 146

Use Variables for folder paths stored in registry 56
Use VSS 66

User ID - Email Reporting 97

User Name - NFS Settings 71

User Name - TCP Target 52

User Name and Password 9

User Name variable 56

Usernames - cDOT Options 44

Using # in Excluding Folders 89

Using Variable Paths 56

Using Wild Cards for files to Include 87

_V -

Validate target file (using CRC32) 85
Validation Options 84, 85

variable data import 58

Variables 56

Variables: File Path 56

99, 99

Verify User-Name 139
version of files 81
View Admin Folder 151

View Alternate Target Path Selection 55
View Log File 26, 91, 151

View Menu 17

View PeerSync activity across the LAN
View Popup Menu 25

View Target Folder 151

Volume Shadow Copy Senice (VSS)
149

VSS 66, 76, 76, 106, 149
VSS Interval 106, 149

W -

Wait for application to end before continuing

153

76, 76, 106,

99, 99
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Web Farms 107, 107

What email address to send from 97

Who to send emails to 97

Window: Changing Height of Profile Job List 26
Windows Explorer Add On - Quick-Sync 154
Windows Platforms 12

Windows Variables for Folder Paths 56
WordPerfect Fixes for synchronization 139
Working With Jobs 12, 153

Working with Profiles 12, 153

_Y -

Year variables for Folder Paths 56
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